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1 Einführung

Erstellen eines Web-Server basierten MMI's

Vielen Dank, dass Sie Saia®S-Web Editor gewählt haben.
Dieser Abschnitt erklärt die Funktionen und das Arbeiten des Saia®S-Web Editors. Mit
dem Saia®S-Web Editor ist es sehr einfach möglich, dynamische Webseiten für den
Saia®PCD.Web-Server zu erstellen.
Ununterbrochene Integration und Gebrauch der Saia®PCD.Web Technologie ändert
die Automatisierungsumwelt in den Bereichen der Inbetriebnahme, des Services, der
Steuerung und der Überwachung.

Web Browser als Inbetriebnahme- und Service Tool

Obgleich die meisten Systeme, Installationen und Ausstattungen noch immer mit
spezifischen oder eigenen Software-Tools in Auftrag gegeben werden, ermöglicht der
Gebrauch von Web-Technologien jetzt, durch Standardwerkzeuge wie Internet
Explorer ersetzt zu werden. Es wird dadurch kein Spezialisten Know-how angefordert,
um einen Browser laufen zu lassen, und die Benutzerakzeptanz ist ebenfalls hoch.
Vordefinierte HTML Seiten erlauben ein optimales Geräte und System Management.
Spezifische HTML Seiten für verschiedene Benutzergruppen erhöhen ebenfalls
erheblich die Bequemlichkeit und Sicherheit und verringern gleichzeitig Kosten.

Steuerung und Überwachung mit Web Technologie

Sogar für einfache Steuerung und Überwachungsfunktionen wurden bisher teure und
häufig komplizierte "Scada Systeme" benutzt worden. Diese Aufgaben entsprechen
ideal zum Gebrauch eines Web Servers mit Browser. Ein weiterer Vorteil der Web
Technologie ist die unabhängige Standartschnittstelle zwischen dem Kontrollsystem
und der Führungsebene.

Java basierende Webseite einfach erstellen, mit dem Saia®S-Web Editor

Saia®S-Web ist die fortschrittlichste Technologie für webbasierte grafische
Benutzerschnittstellen (MMIs), mit einem in der Praxis ausgereiftem
Entwicklungswerkzeug.  S-Web Editor basiert auf offenen Java-Applet Standards.
Webbasierte grafische Benutzerschnittstellen (MMIs) sind von überall her erreichbar.
Ein normaler Web-Browser mit Java VM Unterstützung wie z.B.: MS Internet Explorer,
Mozilla, Opera,... genügt zur Visualisierung. Dadurch kann auf eine Vielfalt von Panels
oder PCs zugegriffen werden.

Zugriff via bevorzugter Schnittstelle und Netzwerk

Der Browser kommuniziert mit dem Webserver via TCP/IP - Protokoll. Dieses kann
über verschiedene Medien wie Ethernet, Modem, Wireless LAN, etc gerouted werden.
Zudem kann der Zugriff über eine Serielle Schnittstelle (RS232, RS485) oder Profibus
erfolgen. All dies erfolgt kontinuierlich in den verschiedenen Netzebenen.

Saia®PCD.Web-Server Ist In Allen Produkten Integriert

Seit 2000 ist der Web-Server in allen neuen Saia Kontroller wie PCS1, PCD2, 3, 4 und
PCD3.RIO enthalten, ohne Aufpreis.
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Basis Prinzip Saia®S-Web

Web-Server

Der Web-Server ist das Herz des Saia®S-Web Konzept. Der Web-Server in allen
neuen Saia Produkten wie PCS1, PCD2, 3, 4 und PCD3.RIO enthalten. Ein Web-
Panel ist ein Panel mit integrierter Browserfunktionalität  für den Markt der industriellen
Automatisierung. HTML Seiten, Teq-View Dateien, Java Applet, Bilder oder alle
anderen Dateien sind im Speicher des Benutzerprogramms gespeichert. Sie werden
durch PG5 herunter geladen.

Web-Connect

Das Web-Connect PC Programm organisiert die Kommunikation zwischen dem PC
oder Web-Panel und dem PCD/PCS System. Der Zugriff auf den Web-Server in der
Saia®PCD ist nicht nur via Ethernet TCP/IP sondern auch über eine Serielle
Schnittstelle (RS232, RS485, modem ...) oder Profibus erfolgen.
Das lokale Verzeichnis entspricht jenem auf dem  PC/Web-Panel, bei welchem die
Web-Connect Software läuft. Es ist möglich, grosse Dateien (z.B. Bilder, Java
Applet, ...) welche Sie nicht im PCD.Web-Server ablegen wollen, in diesem
Verzeichnis zu speichern. Somit kann der PCD Speicher reduziert werden.

Web-Browser

Um Saia®PCD.Web Seiten darzustellen, wird Microsoft Internet Explorer 5.5 oder
Netscape Navigator 6 benötigt. Um Web-Editor Seiten darzustellen, wirde eine Java
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Virtual Machine 1.17 oder höher benötigt.

S-Web-Editor

Der S-Web Editor erlaubt eine rein grafische Entwicklung von S-Web MMIs. Die
Kommunikation zwischen MMI und Webserver/Zielsystem ist bereits programmiert.
Vorkenntnisse über HTML oder Java Programmierung wird keine benötigt. Die
grafischen Objekte sind speziell für Saia PCD Produkte angepasst. Der S-Web Editor
kann als "Stand-Alone" oder als Add On-Tool in Saia®PG5 benutzt werden. Der Web
Editor erstellt ein Java Applet, welches anschliessend von der Start HTML Seite
geladen wird. Für jede Seite wird eine individuelle Konfigurations-Datei (*.teq) erstellt.

Web-Builder
Der Saia®Web-Builder ist ein PG5 Add On-Tool für die Verwaltung des Saia®PCD.
Web-Server Projekts. Alle Dateien (HTML Seiten, Teq-View Dateien, Java Applet,
Bilder, usw.), welche in den PCD.Web-Server gespeichert werden, müssen mit dem
Web-Builder in ein PG5 kompatibles Format konvertiert werden. Der Web-Server
Inhalt wird anschliesend mit dem PG5 in die PCD geladen.

Dateistruktur & Formate
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Dieser Abschnitt erklärt die Projektstruktur und alle Dateien welche zur Erzeugung von
S-Web basierten MMIs benötigt werden. Das PCD.Web-Server Projekt ist für jede
CPU individuell und im PG5 Projektverzeichnis (z.B. C:\PG5 Projects\Project
name\CPU Name\..) der entsprechenden CPU abgelegt. Der S-Web Editor arbeitet
mit zwei verschiedenen Verzeichnissen im CPU Projekt:

…\web ist das Arbeitsverzeichnis des S-Web Editors. Es enthält alle, mit dem S-Web
Editor erzeugte Dateien. Wenn der Editor über PG5 gestartet wird, werden diese
Dateien editiert. Die *.teq-Dateien in diesem Verzeichnis können jedoch nicht für den
PCD.Web-Server benötigt werden.

…\html ist das PCD.Web-Server Verzeichnis, welches alle Dateien enthält, die mit
dem Web-Builder selektiert und erzeugt werden können. Die Dateien (*.html, *.itq, *.
tcr, *.teq, *.gif, IMaster.jar) werden automatisch vom S-Web Editor erzeugt und in das
Verzeichnis kopiert. Beachten Sie, dass diese jedoch nur mit dem "Build All"-Befehl
bearbeitet werden. HTML Dateien werden durch den S-Web Editor erzeugt (Project->
Generate html...). Andere Dateien (z.B. Text Dateien), welche ebenfalls im PCD. Web-
Server enthalten sein sollen, müssen Sie manuell in das Verzeichnis kopieren. 

Sämtliche Java Klassen werden in einem Java-Archiv mit dem Namen IMaster.jar
gespeichert.

Um nun eine embedded Webserver basierte Visualisierung zu erhalten, müssen
folgende Dateien im Zielsystem gespeichert werden:

Die <ihr_projektname>.html -Startseite

Die Java Klassenbibliothek IMaster.jar

Alle Grafikbilder (*.teq - Dateien)

Alle zusätzlichen Anwenderspezifischen HTML-Dateien (wie z.Bsp: Hilfeseiten, ..)

Alle Bilddateien die benutzt werden.

Die Variablen-Initialisierungsdateien <ihr_projektname>.tcr und <ihr_projektname>.
itq

Der S-Web Editor unterstützt ebenfalls das Erstellen Makro Painterobjekte (*.esm
files), welche in einem Makro Bibliothek Verzeichnis ('MacroLib') abgelegt werden
können. Für das Verzeichnis kann ein beliebiger Name gewählt werden. Ein Makro
basiert auf Standart Painterobjekte, welche im S-Web Editor gruppiert und
anschliessend als Makro in der Makro Bibliothek gespeichert werden.
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2 Installation

Für Windows 32-Bit Betriebssysteme

Der S-Web Editor wurde für Microsoft 32-Bit Betriebssysteme geschrieben und ist auf
der Saia®PG5 Controls Suite CD Rom enthalten. Die Installationsroutine installiert
sämtliche für den Betrieb benötigten Komponenten. Der S-Web Editor wird direkt über
die Navigations-Seite von der CD als Add-On-Tool für PG5 installiert (start.htm). Bitte
beachten Sie, dass die Web Editor Lizenz einen Benutzerschlüssel erfordert.

Der Installationsvorgang kann auch manuell über das Setup Programm im S-Web
Editor Verzeichnis gestartet werden: ..\Web-Editor\Setup.exe

Der S-Web-Editor wird als "Add on-Tool" für PG5 installiert.
Bitte beachten:    Zu diesem Tool ist eine Web-Editor Lizenz enthält erforderlich.

System Anforderungen

Der S-Web Editor läuft unter Windows 95/98/ME/NT/2000. Wir empfehlen ein Pentium
System mit mindestens 300MHz Taktfrequenz und 64MByte RAM. Die Anwendung
benötigt ca.10MByte Festplattenspeicher. Eine Bildschirmauflösung von 1024x768
oder besser ist zu empfehlen. Eine PG5 Version 1.3 oder höher ist erfordert.

Probleme vermeiden durch Sperren des Puffers in der Sun Java-
Virtual-Maschine

Das IMaster Java Applet sendet HTTP GET und POST Anfragen um mit dem Web
Server der PLC zu kommunizieren. Die Antworten auf diese Anfragen werden
dynamisch generiert. 
Um zu vermeiden, dass die Sun Java Virtual Maschine diese dynamisch generierten
Antworten behindert, muss das Puffern im System wie folgt deaktiviert werden:

1. Start->Settings->Control Panel

2. Java Symbol wählen

3. Weiter mit 'General' Reiter auswählen
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4. anschliessend 'Settings'

5. 'Delete Files...'

6. Deaktivieren der Checkbox 'Keep temporary files on my computer'
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7. Bestätigen mit 'OK'
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3 IE Einstellungen (nur für Windows 'Vista')

Dieses Kapitel ist nur relevant, falls Sie Windows Vista und Internet Explorer
verwenden.

Seit Internet Explorer 7 für Windows Vista wurde ein "Geschützter Modus" eingeführt".
In diesem Modus wird das Java Applet mit anderen Sicherheitseinstellungen
ausgeführt. Das Applet kann nur in temporäre Verzeichnisse Dateien speichern.
Schreiboperationen in andere Verzeichnisse funktionieren, werden aber vom
Betriebssystem automatisch in temporäre Verzeichnisse umgeleitet.

Dies kann zu Probleme führen, wenn Sie versuchen über ein S-Web Makro Dateien
zu speichern oder zu öffnen (z.B. bei Alarming Makros). Fügen Sie die URL des MMI
deshalb zu "Vertrauenswürdige Sites".
Java-Applet, dass im geschützten Modus ausgeführt wird:

Das Java-Applet ausserhalb des geschützten Modus ausführen

1. Öffnen Sie den Dialog "Internetoptionen" über das Menü Extras->Internetoptionen.
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2. Wählen Sie 'Vertrauenswürdige Sites' im Reiter 'Sicherheit' und klicken 'Sites'
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3. Deaktivieren Sie die Checkbox, die nur "https" URLs erlaubt. Geben Sie danach die
URL des MMI ein und klicken "Hinzufügen".
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Internet Explorer deaktiviert daraufhin den geschützten Modus für Ihr MMI.
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4 Erste Schritte

Unterstützt*

- Java Applet
- MicroBrowser
- NanoBrowser

* Bezieht sich auf alle Funktionen, die in diesem Kapitel beschrieben werden

Neues Projekt

Ein neues PG5 S-Web Projekt wird erstellt durch die Wahl von "Web Editor Project (*.
prj)".
(Siehe auch Benutzer handbuch PG5 26/732)

'OK' öffnet ein neues Web Editor Projekt
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Dies ist das Hauptfenster der S-Web Editor Applikation. Hier werden alle anderen
Fenster verwaltet und die Standardeinstellungen vorgenommen.
Alle zu diesem Projekt gehörenden Dateien werden zum PG5 Projekt in einem
Unterverzeichnis hinzugefügt.

Erstellen einer Bildschirmanzeige (View)

Im nächste Schritt werden wir eine leere View (Grafikbild) dem Projekt hinzufügen.
Wählen Sie den Menubefehl Project->Add->New. Der Editor schlägt einen Dateinamen
vor, der aus dem Projektnamen, einem fortlaufendem Index und der Endung *.teq
besteht

<ihr_projektname0>.teq

Nun können Sie anfangen grafische Visualisierungsobjekte (Painterobjekte)
einzufügen. Diese wählen Sie aus der Symbolleiste für Painterobjekte (Grafiksymbole)
aus. Die Bedeutung dieser Painterobjekte wird im Kapitel Painter Reference
beschrieben.
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Hinzufügen eines Textes bzw. Anzeigen eines PPOs

Wählen Sie aus der Symbolleiste für Painterobjekte (Grafiksymbole) das Painterobjekt
Statischer Text (Static Text) aus und platzieren ihn in der View. Dies geschieht durch
Setzen der linken oberen Ecke mittels linker Maustaste und durch Setzen - bei
gedrückter Maustaste - der rechten unteren Ecke. Geben Sie die Maustaste frei und
das Painterobjekt ist platziert.

Durch den Doppelklick auf das Painterobjekt erscheint der Eigenschaften-Dialog. Er
enthält verschiedene Seiten mit Eigenschaften des Painters. Mit der ersten Seite
Allgemein werden statische Eigenschaften wie Position, Grösse, Farben und Schriftart
festgelegt. Diese Eigenschaften existiert für alle Painterobjekte (Grafiksymbole).

Im zweiten Tab Repaints lässt sich einstellen, welcher Text angezeigt werden soll.
Aktivieren Sie das Kontrollkästchen Datenquelle, wählen Sie STRING im Auswahlfeld
Typ und geben Sie den gewünschten Text im Feld Name ein. Drücken Sie OK und der
Text erscheint in der View.

Alternativ lässt sich der Typ eines Painters auf HTML_TAG, CONTAINER oder PPO
setzen. Mit PPO als Typ lassen sich auf diese Weise Prozessdatenpunkte darstellen.
Wenn Sie einen PPO nicht nur ausgeben aber auch editieren wollen, wählen Sie das
Grafiksymbol Edit Box, dass im nächsten Abschnitt beschrieben wird.

Mit dem Typ CONTAINER lässt sich eine lokale Variable darstellen. Lokale Variablen
sind innerhalb eines oder mehrerer Views sichtbar.

Mit dem Typ HTML_TAG kann ein mehrsprachiges MMI realisiert werden.
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Ändern eines Prozessdatenpunktes (PPO)

Im nächsten Schritt fügen wir der View einen Edit Box Painterobjekt hinzu. Dieses
Objekt erlaubt die Darstellung und Eingabe eines Prozessdatenpunktes. Wählen Sie
Edit Box aus der Symbolleiste für Painterobjekte (Grafiksymbole) und platzieren Sie es
auf dieselbe Weise wie beim Painterobjekt 'Statischer Text'. Öffnen sie das
Eigenschaftsfenster durch einen Doppelklick auf das  Painterobjekt und gehen Sie in
das Register Repaints.

Das Source bearbeiten (Datenquelle) Kontrollkästchen muss aktiviert sein und der Typ
sollte auf PPO gesetzt sein. Im Namensfeld können Sie nun einen symbolischen
Namen für Ihren Prozessdatenpunkt angeben. Dieser Name ist nur innerhalb eines S-
Web Editor Projektes sichtbar und muss später mit dem richtigen Prozessdatenpunkt
auf der Steuerung verknüpft werden. Dies geschieht durch die Menufunktion Project -
>Init PPOs...
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Aufruf für dieses Einstellfenster durch das Menü "Projekt -> Init PPOs ..." .

Sämtliche Prozess Punkte können hier mit den Grenzen (min.- und max.-Werte),
Format und Wert pro Einheit konfiguriert werden (zB ° C).

Diese Prozess-Punkte werden nur mit der relativen Adressen verknüpft, welche in der
PG5-Symboltabelle definiert sind, wenn ein Build auf das gesamte PG5-Projekt
ausgeführt wird.

Die Schaltfläche "OK" des Eigenschaften-Dialog speichert die Einstellungen. 

Erzeugung einer zweiten View

Die zweite View wird auf die selber Weise hinzugefügt. Wählen Sie wiederum den
Menubefehl Projekt->Zum Projekt Hinzufügen->Neu... Übernehmen Sie den
vorgeschlagenen Dateinamen oder wählen Sie einen eigenen. Fügen Sie nun der
View einen statischen Text wie z. B. „Dies ist das zweite Bild“ hinzu.

Navigation zwischen den Views

Im nächsten Schritt wollen wir Schaltflächen erstellen, mit denen wir zwischen zwei
Views navigieren können. Wählen Sie aus der Symbolleiste für Painterobjekte das
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Symbol 'Button' (Schaltfläche) aus und platzieren ihn in der ersten View. Ein
Doppelklick auf das eingefügten Painterobjekt öffnet auch hier den
Eigenschaftsdialog. Geben Sie dem der Schaltfläche einen Namen und formatieren
ihn mit den Eigenschaften der Dialogseite Repaints gleich wie beim Painterobjekt
'Statischer Text' (Static Text). 

Anschliessend gehen Sie in das Register Aktionen Jump und aktivieren das
Kontrollkästchen View Jump. Geben Sie im Feld View Name den Dateinamen der
zweiten View ein.

Button Label definieren:

View Jump definieren:

Ein ähnlicher Knopf kann nun zur zweiten View 'Tutorial2.teq' hinzugefügt werden, wo
der Name in der "action tab" auf die 'Tutorial1.teq' View verweisen soll.

Erzeugen der HTML-Startseite

Im letzten Schritt generieren wir die HTML Seite, die das ganze Projekt umfasst und
als Startseite für unser MMI dient. Wählen Sie den Menubefehl Project->Generate
HTML... übernehmen Sie den vorgeschlagenen Dateinamen oder wählen Sie einen
eigenen. Anschliessend sollten Sie über den Menubefehl File->Save All speichern alle
Projektdateien speichern.

Erster Test in einem Browser

Für einen ersten Test lässt sich die HTML-Startseite mit einem PC-Browser (MS
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Internet Explorer, Netscape Navigator, Mozilla, Opera, ...) öffnen und testen. Natürlich
werden hier aber noch keine Prozessdatenpunkte angezeigt. Diese müssen erst noch
mit den symbolischen Namen des Projektes verknüpft werden. 
Anschliessend muss das Projekt in den Webserver im Zielsystem übertragen werden.
Dies ist zielsystemabhängig und wird im übernächsten Kapitel beschrieben. Des
weiteren müssen noch die HMI internen Variablen initialisiert werden. Diese heissen 
Container und sind nur im HMI sichtbar und nicht im Zielsystem.

Bevor Sie Ihr Projekt herunterladen müssen die ein 'Build All' ausführen. Wählen Sie 
Project->Build All oder klicken Sie auf das folgende Icon in der Toolbar:

('Build All' Icon)
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5 Vorder- und Hintergrund-Seiten (TEQ's)

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Das drei Ebenen Konzept

Das Verwenden von Vorder- und Hintergrund TEQs ist eine erweiterte Funktionalität
und bei simplen Projekten nicht notwendig. Die Idee bei Vorder- und Hintergrund
TEQs basiert auf dem Ansatz drei Ebenen für jede View zu verwenden.
Zur Laufzeit werden diese drei Ebenen zu einer Ansicht zusammengefügt. Der
Benutzer kann optional jeder View ein separates Hintergrund- bzw. Vordergrund-TEQ
zuweisen.

Das Hintergrund-TEQ enthält typischerweise Elemente, die in allen oder vielen Views
angezeigt werden sollen. Diese im Hintergrund-TEQ zu platzieren spart bei
Änderungen Zeit. Typische Element sind Buttons, Texte und andere Painterobjekte.
Das Vordergrund-TEQ wird oft dazu verwendet um Nachrichten, die eine Ausnahme
behandeln, anzuzeigen. Wenn der Benutzer sicherstellen will, dass die Nachricht in
jedem Fall angezeigt wird, muss das selbe Vodergrund-TEQ allen Views zugewiesen
werden.

Die Elemente im Vordergrund-TEQ können mit einer Bedingung verknüpft werden,
damit diese nur angezeigt werden, wenn die Bedingung zutrifft (auch im Hintergrund-
TEQ möglich).

Vordergrund-TEQ

Grundsätzlich kann jede TEQ-View als Vordergrund-TEQ für eine oder mehrere Views
verwendet werden. Vordergrund-TEQs verdecken die aktuell geladene View zur
Laufzeit. Mit Vordergrund-TEQs ist es nicht notwendig, sich wiederholende Teile des
MMI immer wieder zu kopieren. Zum Beispiel um Warnungen oder Statusindikatoren
anzuzeigen. Für Layoutelemente verwenden Sie besser Hintergrund-TEQs.

Erstellen eines Vordergrund Alarm-TEQ

Fügen Sie dem Projekt als erstes eine neue TEQ-View hinzu. Dies können Sie
entweder über Projekt->Zum Projekt hinzufügen->Neu... oder über den entsprechenden
Button in der Symbolleiste tun.

Hinzufügen und Konfigurieren des Alarms

Bitte fügen Sie die folgenden Painterobjekte (Static Text) in Ihre View ein:

Definieren der Nachricht

Öffnen Sie den Eigenschaften Dialog mit einem Doppelklick auf den 'Static Text'
Painterobjekt.
Ersetzen Sie "STATIC TEXT" mit Ihrer Nachricht.
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Beispiel:

Konfigurieren der Alarmbedingung

Die Warnung erscheint, wenn myVar2 kleiner als 25 ist.
Definieren Sie diese Bedingung im Reiter 'Repaints'.

 

Definieren der View als Vordergrund-TEQ

Sie können die View als Standard Vordergrund-TEQ, oder nur für spezielle Views
definieren.

Definieren eines Standard Vordergrund-TEQ

Wählen Sie das Menü Projekt->Projekteinstellungen... Im Tab "Projekt - TEQ-
Konfiguration" finden Sie das DropDown "Vordergrund-TEQ". Wählen Sie dort den
Dateinamen Ihres Vordergrund-TEQ und bestätigen Sie mit "OK".

Diese Einstellung wirkt sich auf die von jetzt an erstellten TEQ-Views, nicht aber auf
die bereits existierenden aus.
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Definieren des Vordergrund-TEQ für die aktuelle Ansicht

Öffnen Sie zuerst die TEQ-View für die Sie ein Vordergrund-TEQ definieren möchten.
Im Dialog Projekt->TEQ-View Konfiguration... können Sie das Vordergrund-TEQ für die
geöffnete View zuweisen.

Hintergrund-TEQ

Die Verwendung von Hintergrund-TEQs macht das Kopieren ganzer HMI Teile
überflüssig. Layout Elemente die in allen oder in vielen Views vorkommen, werden in
das Hintergrund-TEQ kopiert.
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Wie beim Vordergrund-TEQ kann auch beim Hintegrund-TEQ eine
Standardeinstellung für das Projekt vorgenommen werden.

Warnung:  AWT-Komponente werden immer im Vordergrund erscheinen, es können
keine anderen Elemente darüber gelegt werden.
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6 Prozessdatenpunkte (PPO's) Initialisierungen

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Init PPO Dialog

Sobald das "Web Editor"-Projekt abgeschlossen ist und alle TEQ-Views
(Bildschirmseiten) erstellt wurden, sollten Ausgabeformate der einzelnen
Prozesspunkte, sprich PPO's, festgelegt werden. Dies geschieht unter dem
Menupunkt "Projekt -> Init PPOs...".

Der Dialog zeigt eine Liste aller verwendeten Symbolnamen mit ihrer Konfiguration.
Diese kann mittels Doppelklick auf ein Feld in der Liste verändert werden. Das
Verlassen des Dialogs geschieht mit 'OK'. Dadurch werden die Werte übernommen
und eine '<Datei Projektname>.tcr'-Datei erstellt. Diese Datei wird automatisch ins
PG5 Unterverzeichnis 'Web' gespeichert. Sobald ein 'Build All' ausgeführt wird, wird
die Datei in das HTML-Unterverzeichnis des PG5 Projekts kopiert. Der Web Builder
braucht das HTML-Unterverzeichnis im PG5 Projekt um alle Quellen anzeigen zu
können. Es ist wichtig, dass die 'Projektname>.tcr-Datei für den Download in die PLC
mit dem Web Builder vorgängig ausgewählt wurde. Die Bedeutung der verschiedenen
Felder ist die folgende:

PPO Min Val & PPO Max

Eingaben des Benutzers können durch ein Minimum- und Maximum-Wert
eingeschränkt werden. Der definierte Wertebereich kann über Benutzereingaben bei
Laufzeit des Programmes nicht überschritten werden.
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PPO Format Val

Für PCD-Text ist es zwingend, das 'String' Format im 'init PPO' Dialog gewählt
zu haben.

Definieren Sie das Format für jeden Prozesspunkt. Die Min/Max Prüfung verlangt,
dass das Format korrekt definiert wurde. Ein Beispiel wie dies im Browser dargestellt
wird, ist hier ersichtlich:

    STRING-i                             This is also a text

Es ist überaus wichtig das richtige Ausgabeformat für jeden PPO festzulegen! Z.B.
muss ein PCD-Text als 'String' im 'Init PPO' Dialog festgelegt werden. Andererseits
wird der S-Web Editor eine Fehlermeldung ausgeben 'syntax error'.
Weitere Informationen befinden ich im Kapitel 'Error Meldungs'.

PPO Einheit Val

'Val' ist ein beliebiger String (Zeichenfolge), die jeweils dem angezeigten PPO-Wert
angefügt wird.
Beispiele:
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7 Spezielle HTML-Tag-Namen

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Spezielle HTML-Tags

Der S-Web-Browser (IMaster Java Applet oder MicroBrowser) verwendet spezielle
HTML-Tags. Der Name diesesr HTML Tags ist reserviert.
Ist dieser HTML-Tag im "Cross Ref" Makrofenster vorhanden, darf er nicht geändert
oder derselbe Name noch einmal verwendet werden.

HTML Tag
Example

Description Supporte
d by Java
Applet
Client*

Supported
by
MicroBrow
ser*

Supporte
d by
NanoBro
wser

<PARAM
NAME="Encoding
PPO"
VALUE="UTF-8">

Ermöglicht das UTF-8 kodieren
für lesen  und schreiben von
PPO Variablen. 

X X -

* X = supported, - = not supported
** not supported on all platforms

Avoid That The S-Web Editor Overrides Your Custom HTML Tags

Der S-Web-Editor gibt einige Laufzeit-Parameter direkt im HTML ein. Deshalb wird die
HTML-Datei jedes mal beim Rebuild überschrieben.
Um den benutzerdefinierten HTML-Tag permanent in der HTML-Datei zu erhalten, ist
es erlaubt, eigene HTML Tags in bestimmten Abschnitten der HTML-Datei einzufügen.

Es gibt zwei Abschnitte, die manuell geändert werden dürfen, ansonst sie der Editor
sie überschreiben würde:
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Ändern oder Kundenspezifische HTML Tags hier hinzufügen...
<!-- START TAG1 ALL TEXT UNTIL END OF THAT TAG IS OVERWRITTEN FROM

EDITOR DURING HTML FILE GENERATION -Library->Get object from library... 
Der Rest in diesem Abschnitt sollte nicht manuell geändert werden.
<!-- END TAG1 -->
Ändern oder Kundenspezifische HTML Tags hier hinzufügen...
<!-- START TAG2 ALL TEXT UNTIL END OF THAT TAG IS OVERWRITTEN FROM
EDITOR DURING HTML FILE GENERATION -->
Der Rest in diesem Abschnitt sollte nicht manuell geändert werden.
<!-- END TAG2 -->
Ändern oder Kundenspezifische HTML Tags hier hinzufügen...
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8 Dateitransfer zur PCD

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

"Build all"

Nachdem alle PPO's defniniert sind, sollten Sie unter 'Datei' den Befehl 'Build All'
ausführen. Es werden nun alle benötigten Dateien im PG5 Projekt vom
Unterverzeichnis 'Web' ins Unterverzeichnis 'html' kopiert.

Durch einen Doppelklick auf die *.wsp-Datei (Web-Server Projekt-Datei) im PG5
Projekt Manager (PG5-Menu: File->New..->Web-server Project) öffnet sich folgendes
Fenster:

Auf der linken Seite des Dialogs befinden sich alle Quellen des PG5 "\html"
Unterverzeichnis. Auf der rechten Seite sind alle Quellen gelistet, welche in die PLC
geladen werden.  Mit 'Add' können Sie die für den Download bestimmten Dateien
hinzufügen. Es ist zwingend, dass die Dateien <Projektname>.itq, <Projektname>.tcr,
'<Projektname>.teq' und '<Projektname>.html' für den Download hinzugefügt werden.

Drücken Sie anschliessend 'Generate' und schliessen Sie den Dialog. Laden Sie nun
das Projekt in der PG5 Umgebung auf Ihre Steuerung.

File Transfer zum PCD System vom S-Web-Editor FTP-Client

Der Editor enthält einen integrierten FTP-Client mit dem HMI-Projektdateien in die
SPS geladen werden. Durch klicken auf den Downloadknopf der Toolboxleiste

oder durch Menu Project -> Download Project öffnet sich das folgende Bedienfenster:
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Durch klicken auf den Knopf 'Download Project' werden alle benötigten Dateien des
HMI-Projekts in das "Root Directory" des Webservers geladen.

Benutzen von Unterverzeichnissen

Es ist möglich das HMI-Projekt in Unterverzeichnissen auf der SPS zu speichern.
Dazu ist folgendermassen vorzugehen:
Der gewünschte Unterverzeichnisname ist im Eingabefeld einzugeben
(Windowskonforme schreibweise beachten!). 
Der Button "Make / Change Dir 'ändert das aktuelle Verzeichnis auf der SPS. Das
aktuelle Unterverzeichnis wird im oberen Feld mit dem Namen "Remote-Verzeichnis"
angezeigt.

Falls das angegebene Verzeichnis nicht existiert, wird es automatisch erstellt. Die
Schaltfläche 'Up Dir' ändert das aktuelle Verzeichnis in das oben angezeigte
Verzeichnis.
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Der Knopf 'Download Project' speichert alle Projektdateien in das unter 'Remote
Directory' angegebene Verzeichnis.

Der FTP-Client speichert in der Regel auf das SPS Web-Root-Verzeichnis des
Servers. Vorsicht bei der Verwendung von 'Up Dir. Es ist möglich Dateien außerhalb
des Web-Servers Root-Verzeichnises zu speichern. 

Einige FTP-Server verstehen den FTP-Befehl 'Up Dir' nicht. Deshalb ist es möglich in
dem im Eingabefeld '../', links neben dem Knopf "bewegen Marke / Change Dir ', ein
übergeordnetes Verzeichnis angegeben werden kann. Der nächste Schritt ist ein
anklicken des "Make / Change Dir '-Knopfes.
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9 Aktualisieren der Werte vom Server

Jede View enthält eine Anzahl Referenzen für PPO's des PCD Systems. Um eine
bessere Leistung im Bezug auf das Aktualisieren dieser Werte zu erzielen, fragt der S-
Web Editor den Web Server nicht für jeden Wert einzeln ab. Das Applet erfasst alle
für PPO's bei seiner Initialisierung, erstellt daraus eine Liste und sendet diese zum
Server. Dieser Request informiert den Server, welche Werte für die gegenwärtige
View behalten werden müssen. Wenn diese View sich aktualisieren muss, frägt sie
nach der aktualisierten Liste, welche vom Server zurückgegeben wird. Diese Liste
enthält alle Werte, die erforderlich sind. Der Benutzer kann zwischen zwei Modi
wählen:

Einzelanfrage für alle Ansichten

Unterstützt:

- Java Applet

Es wird nur eine Liste für das Applet erzeugt; sie umfasst alle benötigten Views. Die
Vorteile sind:

Weniger Dateien und dadurch weniger Verkehr auf dem 'File System'.
Sofortige Initialisierung weil dem Server alle PPO's bereits bekannt sind.

Einzelanfrage für eine Ansicht

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Diese Option erzeugt durch das Applet eine Abfrage für jede View aus. Die Vorteile
sind:

Wenn das Applet viele Views mit vielen Variablen enthaltet, müssen die kompletten
Resultate geladen werden, ebenfalls jene welche für die aktuelle Ansicht nicht
verwendet werden. Für komplexe HMI's ist dieser Prozess deshalb schneller.

Diese Option wird in der HTML Datei mit dem Aktivieren von 'OrderPerView' im
'Project Configuration' Dialog gewählt.

Periodisches aktualisieren.

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Die Periode, in welcher das Applet über Änderungen seiner Prozesspunkt informiert
wird, kann durch den Anwender definiert werden. Der standard Modus eines Applet ist
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'polling'.

Diese Periode  kann unter Project->Project Configurations... Dialog eingestellt werden.

Bedingte Aktionen

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Für bestimmte Eigenschaften der Painterobjekte können Sie eine Bedingung
anzeigen, die zutreffend sein muss, um die Einstellung aktiv zu setzen. Beispiele sind
die 'Edit a Source' Einstellung in den 'Repaints' oder die 'Border Advanced'
Eigenschaften wo Sie eine Farbe abhängig einer Bedingung setzten können. Das
Format dieser Konditionen ist immer die selbe:

Zuerst wählen Sie einen Typ der Variable, von der die Bedingung abhängen soll.
Wählen Sie PPO' für Prozess Punkte oder 'CONTAINER' für HMI-interne Variablen.
Geben Sie nun den Namen der Variable im Feld 'Name' und den Wert im Feld 'Value'
ein. Entscheiden Sie sich für eine Bedingung:

!= ungleich

< kleiner als

<= kleiner oder gleich als

== gleich

>= grösser oder gleich als

> grösser als
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10 Fehlercodes verarbeiten

Unterstützt:

- Java Applet
- MicroBrowser

Über die Verwendung von Fehlercodes können Systemmeldungen definiert werden,
die in Funktion eines Fehlercodes angezeigt werden. Die Fehlercode wird in einem
Prozesspunkt als Integer abgelegt.

Die Fehlermeldung könnte auch direkt als 'String' von der SPS geliefert werden. Die
Nachteile dieser Vorgehensweise sind die folgenden:

Wenn die Fehlermeldungen in verschiedenen Sprachen zur Verfügung stehen
sollen und der Benutzer die Sprache am Panel ändern kann, wird es schwierig dies
so zu lösen.
Die Behandlung von String-Variablen auf der SPS braucht viel Speicherplatz und ist
eher kompliziert.

Das Konzept beschrieben in diesem Kapitel erlaubt es, die Fehlermeldung als
Fehlercode zu Übertragen (als Integer Variable). Dieser Fehlercodes werden dazu
verwendet, über die jeweilig ausgewählte Sprachressource die Fehlermeldung zu
bestimmen.

CSV-Sprachdateien werden dazu verwendet, die Fehlermeldungen zu definieren.

Verwendung des "Error Codes"

Setzen Sie den 'Source' Typ im Painterobjekt, welcher die Fehlermeldung anzeigen,
soll auf 'HTML TAG'

Um die jeweilige Fehlermeldung zu referenzieren, muss die folgende Syntax im
HTML-Tag verwendet werden:

ErrorCode_@PPO_MyPPOName@

ErrorCode_ Präfix für Ihre Fehlercodes (frei wählbar).

MyPPOName PPO die den aktuellen Fehlercode enthält

Zur Laufzeit wird das HTML-Tag mit dem speziellen Syntax
"ErrorCode_@PPO_MyPPOName@" in einen normalen HTML-Tag
umgewandelt:"ErrorCode_0", "ErrorCode_1",.. "ErrorCode_N, wenn die PPO den Wert
0, 1 bzw. N aufweist.
Über das so ermittelte HTML Tag wird schliesslich, über die CSV-Sprachdatei, die
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definierte Fehlermeldung geladen.

Erstellen Sie als Beispiel eine CSV-Sprachdatei mit folgendem Inhalt:

Importieren Sie die CSV-Datei über Projekt->Zum Projekt hinzufügen->Datei...

Wählen Sie Projekt->Projekteinstellungen und aktivieren die Checkbox 'HTML
Parameter in CSV-Datei' und geben den Dateinamen Ihrer CSV-Datei in das
DropDown 'CSV-Datei' ein.

Sie können die Fehlermeldungen in den jeweiligen Sprachdateien unterbringen und
dort übersetzten. Bitte beachten Sie das Kapitel 'Multilingual HMI's' für Einzelheiten.
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11 Mehrsprachige HMI's

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

In diesem Kapitel lernen Sie, wie mehrsprachige HMIs erstellt werden können. Dem
Benutzer wird es möglich sein, die Sprache über einen Button zur Laufzeit
umzuschalten.

Das vorliegende Konzept basiert auf Sprachdateien. Für jede Sprache wird dem
Projekt gibt es eine separate Datei. Die Sprachdateien liegen im CSV (comma
separated values) Format vor und können mit einem beliebigen Texteditor bearbeitet
werden. Lesen Sie das Kapitel 'Texte im Unicode Format', falls Sie mit Unicode
arbeiten möchten.

Als 'Source' Typ für die zu übersetzenden Texte, wählen Sie 'HTML TAG', statt wie
bisher 'STRING'.

Der S-Web Editor kann alle 'HTML TAG' Referenzen sammeln und daraus
automatisch eine CSV Datei generieren, die alle 'HTML TAG' Referenzen enthält. Sie
können die Übersetzung direkt in der automatisch erstellten Datei vornehmen. Der S-
Web Editor hält die definierten CSV Dateien auf dem aktuellen Stand, in dem neue
'HTML TAG' Referenzen hinzugefügt und alte entfernt werden. Die vom Benutzer
eingegeben Übersetzungen werden dabei nicht überschrieben.

Zum Beispiel können Sie eine Schaltfläche in Ihre TEQ-Ansicht einfügen, dass die
aktuelle Sprache in Ihrer HMI Anwendung während der Laufzeit mit einer einfachen
Button-Aktion wechselt.

Definieren was übersetzt werden soll

Öffnen Sie die Eigenschaften des jeweiligen Painters über einen Doppelklick und
ändern 'Typ' zu 'HTML-Tag'
Wiederholen Sie diesen Schritt für jedes Painterobjekt dessen Text Sie übersetzen
wollen

Der Text 'Bitte Passwort eingeben:' ist im Beispiel eine 'HTML TAG' Referenz. Dieser
Text wird so angezeigt, falls keine Übersetzung in der CSV Sprachdatei vorgenommen
wird oder die Sprachdatei fehlt.
Sie können auch 'HTML TAG' Referenzen in der Form 'PWTEXT1' definieren und z.B.
'Bitte Passwort eingeben:' in der deutschen Sprachdatei und in der 'Please enter your
password:' englischen Sprachdatei definieren.

Eine CSV Datei für jede Sprache
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Bevor S-Web Editor eine CSV Sprachdatei mit allen 'HTML TAG' Referenzen erstellt,
müssen Sie die einzelnen Dateinamen definieren.
Wählen Sie Projekteigenschaften->Projekt-TEQ-Konfiguration->Projekteinstellungen... und
geben die Dateinamen unter 'CSV-Dateien' an (wählen Sie 'Hinzu', falls die Datei
bereits existiert)

Schliessen Sie die Projekteigenschaften und wählen Sie der Toolbar 'Generate HTML
TAGS CSV file':

Der S-Web Editor erstellt, die in den Projekteinstellungen definierten CSV Dateien.
Sind die Dateien erstellt, können Sie über 'Generiere HTML-Tag CSV-Datei'
automatisch aktualisiert werden. Kommt eine neue Referenz im Projekt hinzu, wird
diese jeweils auf der ersten Zeile in die CSV-Datei eingefügt. Bereits gemachte
Übersetzungen werden nicht überschrieben. Ist ein bestimmtes 'HTML TAG' in keiner
TEQ-View mehr referenziert, erscheint ein Dialog über den Sie entscheiden können,
ob der Eintrag in der CSV-Datei gelöscht oder beibehalten werden soll.

Die Sprachdateien werden entweder direkt im S-Web Editor oder mit einem Texteditor
wie z.B. Notepad bearbeitet.

Syntax: HTML TAG Ref er enz;  Über set zung
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Übersetzen Sie die einzelnen Referenzen nun in allen Sprachdateien.

Definieren der vorausgewählten CSV-Dateien

Wählen Sie unter Projekteigenschaften den Reiter ' Pr oj ect  -  Appl et

Advanced' .

Aktivieren Sie 'HTML Parameter in CSV-Datei' ansonsten der Browser oder das Java-
Applet die "HTML TAG 'Verweise in die HTML-Datei während der Laufzeit sucht.

Definieren Sie den Dateinamen der Sprache, die automatisch beim Start des HMI
ausgewählt werden soll.

Bedienknopf für Sprachumschaltung

Im nächsten Schritt erstellen Sie einen Button für die Sprachumschaltung im HMI
während der Laufzeit:
Fügen Sie einen neuen 'Button Painterobjekt in eine bestehende TEQ-View ein 
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Öffnen Sie die Painterobjekt Eigenschaften (Doppelklick auf Painterobjekt)

Ersetzen Sie 'BUTTON' im Reiter 'Repaints' mit einem passenden Text.

Wählen Sie 'Actions Set Variables' und übernehmen die Parameter von nachfolgender
Abbildung:

 

Wenn Sie nur eine CSV Datei haben, können Sie nicht zur 'Original Sprache'
zurückkehren. Deshalb müssen Sie eine zusätzliche CSV Datei anlegen:

Fügen Sie ein 'Button Painter' in Ihre View für die 'Original Sprache' ein:

Öffnen Sie das 'Painter Property' Fenster (Doppelklick).

Gehen Sie zum Ritter 'Repaints' und ersetzten Sie den Text 'BUTTON' mit Ihrem
eigenen. Gehen Sie nun in den Ritter 'Actions Set Variables' und übernehmen Sie die
folgende Einstellung :
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Im vorliegenden Beispiel, ist die vorausgewählte Sprache Deutsch. Der Benutzer kann
aber über die Buttons zwischen Deutsch und Englisch wählen.

Arbeiten mit UnicodeTextformat

Java-Applet und MicroBrowser können Unicode Text verarbeiten Die meisten
Schriftarten enthalten nicht alle Unicode Zeichen. Es wird empfohlen die Schriftart 'MS
Sans Serif' zu verwenden

Wenn Sie Unicode verwenden, können Sie die CSV Dateien nicht im S-Web Editor
bearbeiten, da dieser die Dateien im ASCII Modus abspeichert. Sie können
beispielsweise Notepad verwenden. In Microsofts Excel können Sie im 'Speichern
unter' Dialog wählen, dass Sie 'Unicode' verwenden möchten. 

Es genügt, die CSV-Datei im Unicode Format zu speichern. Sie müssen keine
zusätzlichen Einstellungen im S-Web Editor vornehmen.
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12 Arbeiten mit Macros

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Macro-Objekte können verwendet werden, um häufig verwendete Painter
Kombinationen und deren Konfiguration in einer separaten Datei (*. esm) zu
verwalten.

Ab der Editorversion 5.12 erzeugt dieser Makro-Dateien mit *. esm Dateierweiterung.
Rückwärtskompatibilität zum alten Format, den *. tlb-Dateien, ist gegeben.

Individual Solutions

Für individuelle Painter-Objekte ist die Firma IniNet Solutions GmbH zu kontaktieren.
Sie entwickelt auf Wunsch maßgeschneiderte Painter. Diese werden als Makro-
Objekte geliefert und können ins Projekt mit dem Menüpunkt Library->Get object from
library... importiert werden.

Benutzerdefinierten Macro erstellen

1. Neues Projekt z.B. "MeinMacro" erstellen. (Wie ein neues Projekt erstellt wird, ist
unter Erste Schritte) nachzulesen).

2. Neue Teq-Seite (Bildschirmdarstellungsdatei) erstellen mit Project->Add to Project-
>New menu.

3. Alle gewünschten Painter-Objekte im Macro-Object einsetzen und parametrieren.

4. Alle Painters selektieren und anschliessend auf das Gruppensymbol in der
Symbolleiste klicken (siehe Kapitel Gruppenfunktion für Details)

5. Die soeben erstellte Macro-Paintergruppe markieren und anschliessend die Macro-
Datei erstellen mit Library->Insert object into library....

6. Macronamen eingeben (*.esm) und "New_Save" anklicken.
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Mit 'Extra files' sind zusätzliche Dateien mit der Erweiterung "*.GIF" oder "*.TXT"
gemeint. Mit 'Add Files..' können die gewünschten Dateien in der Liste hinzugefügt
werden. Werden keine zusätzlichen Dateien benötigt, ist dieses Feld leer zu lassen.

Macro Objekt aus der Bibliothek (Library) einfügen

Mit der Menü-Funktion Library->Get object from library... lassen sich Objekte aus einer
Bibliothek in die aktive TEQ-Seite einfügen. Nach dem Einsetzen eines solchen
Objektes, muss dessen Referenz entsprechend angepasst werden. Durch einen
Doppelklick auf das Objekt öffnet sich der dazugehörende Pop-up "Dialog". Mit dem
TAB "Cross-Reference" (Querverweis) lassen sich die Referenzen ändern.

Sollen einzelne Ojekte des Macros  verschoben werden, ist dazu die Gruppe mit der
Ungroup-Funktion erst zu degruppieren.

Macro Objekt aus der Bibliothek (Library) löschen

Dies geschieht mit der Menü-Funktion Library->Remove object from library.. Der
Dateiauswahldialog wird angezeigt, durch ihn lässt sich das gewünschte Macros aus
der Liste löschen.

Vorhandenen Macro ändern

Das Ändern eines vorhandenes Makros und ihm anschliessend einen anderen Namen
zu geben, ist möglich. Das Problem dabei ist die Tatsache, dass ein Makro aus
mehreren Dateien (Bilder, PPO und Container intitialisation, Makro-Dialog, etc.)
bestehen kann. Besonders, wenn der Benutzer ein Makro mit einem eigenen Makro-
Dialog (zB Tacho) ändern will, muss dieser Dialog zusammen mit dem modifizierten
Makro gespeichert werden. Dazu kann ein Makro nicht einfach kopiert und umbenannt
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werden, sondern muss nach dem beschriebenen Verfahren geändert werden:

Library->Modify macro from library..
Das gewünschte Makro wählen und mit dem Editor zur Änderung übernehmen.
ACHTUNG: Das Löschen von Kernobjekten bestimmter Makroteile, kann zu einem
nicht vorhersagbaren Betrieb führen. Ändern von Größe, Layout, Farbe und Schriftart-
Eigenschaften oder das Hinzufügen weiterer Objekte ist immer ohne Probleme
möglich.

Library->Insert object into library..
Den geänderten Makro unter neuemn Namen speichern. Im "Speichern"-Dialog
besteht die Möglichkeit, Dateien zu Ihrem Makro hinzuzufügen (z.B. GIF-Bilder).

Wichtiger Hinweis: Bitte die temporäre Datei TEQ-View nicht schliessen. 
Bitte dazu Library->Insert object into library.. nutzen! 
Bei einem allfälligen Absturz den Editor schliessen und wieder

öffnen.
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13 Mehrere Ansichten

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Dieses Kapitel beschreibt, wie das HMI eingestellt werden muss, um mit mehreren
Views arbeiten zu können. Da wir uns in einer vernetzten Umgebung befinden, gibt es
bestimmte Punkte, die für das Design solch einer Lösung betrachtet werden müssen.

Im allgemeinen gibt es zwei verschiedene Wege um von der einen zur anderen
Ansicht zu wechseln.

Mehrere Views In Einem Applet

Der Anwender ruft eine HTML Seite mit dem Browser auf. Diese HTML Seite (<your
projectname>.html) enthält ein Applet (IMaster.jar) welches mehrere Views anzeigen
kann (gespeichert als*.teq Dateien). Alle Views und das entsprechende Applet werden
gestartet sobald die HTML Datei <your projectname>.html in den Browser geladen
wird. Dies ist der schnellste Weg um zwischen mehreren Views zu wechseln.

Diese Datei wird erstellt unter:  Project->Generate HTML

Link zu einer anderen HTML Datei

Es ist ebenfalls möglich ein Applet View mit einer andernen HTML View zu
verknüpfen, welche auch ein Applet enthält. Der Nachteil ist, dass der Browser
dadurch einige Zeit benötigt, um die neue Seite und das Applet zu initialisieren und
laden.   Dennoch kann diese Eigenschaft in bestimmten Fällen nützlich sein:

Links zu Help Dateien (gespeichert als HTML)

Links zu HMI's auf anderen Webserver, um 'praktisch' eine eine einzige HMI zu
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erhalten

Links zu anderen Applets oder Seiten welche nicht mit S-Web Editor erstellt
wurden



50

Saia-Burgess Controls AG Java Sicherheitseinstellungen (für Microsoft VM)

 

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

14 Java Sicherheitseinstellungen (für Microsoft VM)

Dieses Kapitel ist nur relevant, wenn Sie das Microsoft VM (Virtual Machine)
verwenden.

Es kann vorkommen, dass Sie Operationen im MMI ausführen wollen, welche das
Sicherheitsmodell des VM PlugIn nicht erlaubt.
Wenn zum Beispiel eine Datei an den Server gesendet oder empfangen werden soll.
Bei solchen Operationen muss das Java Applet so konfiguriert werden, dass es
ausserhalb der "Security Sandbox" ausgeführt wird.

Wie kann das Java-Applet ausserhalb der "Java Security Sandbox"
ausgeführt werden?

1.  Öffnen Sie den Dialog für Internetoptionen: Tools->Internet Options... (oder Alt T und
O).

2. Wählen Sie den Reiter "Security"

3. Doppelklick auf das grüne "Trusted sites" icon.

4. Deaktivieren Sie die Checkbox "Require Server verification (https:) ...".

5. Wählen Sie "Sites..." , fügen die die Web Seite wo das Applet abgelegt ist (z.B.:
MyPCName oder http://MyWebFrontServer), hinzu und bestätigen mit "OK".

6. Wählen Sie "Custom Level…" (für sichere Seiten)
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7. Wählen Sie Java->Java Permission->Custom aus der Liste

8. Klicken Sie auf den Button "Java Custom Settings…"

9. Wählen Sie den Reiter "Edit Permission"

10.Selektieren Sie aus der Liste: Unsigned Content->Run Unsigned Content->Enable
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11.Klicken Sie "OK" und "Apply".

12.Starten Sie den Browser neu und rufen das Applet erneut auf.

Ein grünes Icon in der Statuszeile des Internet Explorer zeigt nun an, dass Sie sich auf
einer "Trusted Site" befinden.
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15 Signierte Applet's (für Sun VM PlugIn)

Dieses Kapitel ist nur relevant, wenn Sie das Sun VM PlugIn verwenden.

Der S-Web Editor verwendet "Signed Applets". Es erscheint folgendes Dialogfenster
beim Öffnen des HMI:

Akzeptieren Sie das Zertifikat mit "Yes" oder "Always". Wenn Sie das Zertifikat nicht
akzeptieren, kann das Applet keine Dateien auf der lokalen Festplatte speichern.
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16 Arbeiten mit dem MicroBrowser

Dieses Kapitel beschreibt MicroBrowser für Saia Terminals (MB-Terminal).

uBTerminal Container

Die Firmware der Terminals stellt dem Anwender einige Container zur Verfügung. 

Mit diesen Container Variablen kann das Anwendungsprogramm Informationen mit
der Firmware austauschen. Alle Container Variablen werden zu beginn mit "uBT_"
adressiert.

Container-Variablen für QVGA MB-Panels

Container Variable FTP
Konfigura
tionsoptio
n *

Beschreibung

uBT_Version Read Aktuelle Firmware-Version

uBT_BooterVersion Read Aktuelle Booter-Firmware-Version

uBT_ SerialNumber Read Serienummer

uBT_DispResolution no Display Auflösung:
x = x Achse [Pixel]                         Beispiel: 320
y = y Achse [Pixel]                         Beispiel: 240
z = Farbtiefe je Pixel (Bits je Pixel)  Beispiel: 8

uBT_IsTSPresent no Touchscreen vorhanden
‚0’ = „Nein“
‚1’ = „Ja“

uBT_SDCardPresent no ‚0’ = SD-Karte nicht vorhanden
‚1’ = SD-Karte vorhanden

uBT_IsConfigChanged no ‚0’ = Ungeänderte Konfiguration
‚1’ = Geänderte Konfiguration

uBT_RestoreConfig no ‚1’ = Letztes gespeicherte Konfiguration wird
wieder hergestellt

uBT_SaveConfig no ‚1’ = Aktuelle Konfig. wird gespeichert. Wenn
IPAddr, SubNetMask oder DefaultGateway
gewechselt wird, erfordert dies ein Neustart des
Terminal.

uBT_EnableCache R/W Für alle Dateien außer Bilddateien.
‚0’ = Cache ist ausgeschaltet.
‚1’ = Cache ist eingeschaltet. Eine Datei wird vom
Cache (falls vorhanden) geladen. 
Dateien werden vor der Verwendung
zwischengespeichert.
Der Cache wird zuerst nach der gesuchten Datei
durchsucht, unabhängig von der lokalen
Einstellungsdatei.
Der Cache wird beim Start und bei einem URL-
Sprung gelöscht.

Bild-Dateien werden dekomprimiert und in einem
eigenen Video-Cache, der immer aktiv ist,
zwischengespeichert.
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Diese Video-Cache wird bei einem Start und bei
URL-Sprünge gelöscht. Bei zu viel geladenen
Dateien werden alle benötigten Dateien neu
geladen und wieder dekomprimiert.. 

uBT_DispType no DisplayTyp: „Mono“ oder „Color“

uBT_DoLcdCalib R/W Falls ein Touchscreen vorhanden ist wird
 bei ‚1’ eine neue Kalibration ausgeführt.

uBT_LcdContrast R/W '0..20' Einstellung von Kontrast / Helligkeit der
Hintergrundbeleuchtung (20=100% hell).

uBT_BackLight no Hintergrundbeleuchtung 
‚1’ = Ein, ‚0’ = Aus
Bei Berührung des Bildschirms wird die
Hintergrundbeleuchtung eingeschaltet oder dessen
Ausschaltverzögerung neu gestartet.
Fernsteuerung nur über PPO <-> Container-
Kopplung.
Die Nutzung mit "Button" und "Edit-Painter" wird
nicht unterstützt.

uBT_BackLightTimeout R/W Ausschaltverzögerung in Minuten. Wenn während
dieser Zeit keine Aktion des Benutzers stattfindet,
wird die Hindergrundbeleuchtung ausgeschaltet.
‚0’ = Hintergrundbeleuchtung immer aktiv. 

uBT_MACAddr Eigene MAC-Adresse
String (Lesen)

uBT_TCPIPAddr no TCP/IP-Adresse des Terminals (eigene Adresse).
Änderung erfordert Neustart des Terminals. Verliert
die FTP-Verbindung.

uBT_SubNetMask no Subnetmask des Terminals. Modifikation erfordert
Neustart.

uBT_DefaultGateway no Default Gateway des Terminals. Modifikation
erfordert Neustart.

uBT_EnableSIP R/W SIP = Soft Input Panel = virtuelle Tastatur
‚0’ = virtuelle Tastatur ausgeschaltet.
‚1’ = virtuelle Tastatur („alphapad.teq“ oder
„keypad.teq“) eingeschaltet.

uBT_FirstPadName R/W Lokaler Dateiname einer alternativen, virtuellen
Tastatur als Ersatz für 'alphapad.teq'.
Standartmässig wird 'alphapad.teq' aus dem
Setup-Menü (ab INTFLASH / WEB) verwendet.
Die Alternative-Datei -, welche anders als
alphapad.teq genannt werden muss, ist im M1-
Steckplatz oder auf SD-Flashkarte über FTP zu
speichern. Weitere Möglichkeit 'Web-Projekt' im
Remote-Server.
Die maximale Anzahl der Zeichen (Dateiname und
Dateierweiterung inkl. Punkt) ist 24.

uBT_BuzzVol R/W Lautstärkeneinstellung des Summers bei
Berührung (20 = 100%)

uBT_BuzzFreqIndex R/W Frequenz des Summers bei Berührung Wert '0 …
6', entspricht Frequenz-einstellung 125, 250, 500,
1000, 2000, 4000, 8000.

uBT_AlarmStart ** no Wert in 1/1000 Sekunden für die
Einschaltverzögerung oder stoppen des gepulsten,
akustischen Alarms.
Der akustische Alarm kann mit einer Einstellung
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der Pausenzeit (0 .. 30000 ms) gestartet werden.
'50%' = Ein- und Ausschaltzeit sind gleich.
Wenn bereits eine Einstellung ausgeführt wird, wird
die Einstellung noch ignoriert.
‚0’ = schaltet sofort.
Alarmstop durch Berührung des Bildschirms. 

uBT_AlarmFrequency
**

R/W Frequenzeinstellung des akustischen Alarms (Hz)
(gerundet auf 125, 250, 500, 1000, 2000, 4000,
8000)
Geänderte Einstellung wird erst beim nächsten
Aufruf des Alarms verwendet.

uBT_AlarmVolume ** R/W Lautstärke '0..20'  des akustischen Alarms
(20=100%, Standard = '10').
Einstellen vor dem nächsten Alarm!
Die Änderung wird erst beim nächsten Alarm
verwendet.

 *  Parameter access over FTP using the configuration file in INTFLASH, INFLASH/
CONFIG/CONFIG.DAT.
    The settings can be read over a file read of this file over FTP.
    Overwriting the file over FTP causes the terminal to take all changes that are given
within the file.
    To use FTP an Ethernet connection is required.
    Do not use write access on the container from the application and over FTP at the
same time. 
    This may lead to undefined results.

**  Acoustic alarm: New feature for QVGA FW 1.10.45 upwards. Button and Edit
painter use is supported.
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Container-Variablen für VGA MB Panels

Container Conf
ig
file
entry

Typ Stan
d-
art
Eins
tellu
ng

Min
Wert
Min
Läng
e

Max
Wert
Max
Läng
e

Beschreibung

uBT_AlarmFreq
uency

R/W ANSI-
Text
String

100
0

125 8000 Frequenzeinstellung des
akustischen Alarms (Hz)
(Gerundet auf 125, 250,
500, 1000, 2000, 4000,
8000)
Geänderte Einstellung
wird erst beim nächsten
Aufruf des Alarms
verwendet.

uBT_AlarmStart no Dezimalw
ert-String

0 0 3000
0

Wert in 1/1000
Sekunden für die
Einschaltverzögerung
oder stoppen des
gepulsten, akustischen
Alarms.
Der akustische Alarm
kann mit einer
Einstellung der
Pausenzeit (0 .. 30000
ms) gestartet werden.
'50%' = Ein- und
Ausschaltzeit sind gleich.
Wenn bereits eine
Einstellung ausgeführt
wird, wird die Einstellung
noch ignoriert.
‚0’ = schaltet sofort.
Alarmstop durch
Berührung des
Bildschirms. 

uBT_AlarmVolu
me

R/W Dezimalw
ert-String

10 0 20 '0..20' Lautstärke des
akustischen Alarms
(20=100%).
Einstellen vor dem
nächsten Alarm!
Einstellung wird erst
beim nächsten Alarm
verwendet.

uBT_AutoRepe
at

R/W Boolean-
Wert
String

0   Bildschirmtastatur:
Autorepeat 
‚1’ = Ein, ‚0’ = Aus

uBT_Backlight no Boolean-
Wert
String

EIN   Hintergrundbeleuchtung 
‚1’ = Ein, ‚0’ = Aus
Bei Berührung des
Bildschirms wird die
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Hintergrundbeleuchtung
eingeschaltet oder
dessen
Ausschaltverzögerung
neu gestartet.
Fernsteuerung nur über
PPO <-> Container-
Kopplung.
Die Nutzung mit "Button"
und "Edit-Painter" wird
nicht unterstützt.

uBT_BackLight
On

no Boolean-
Wert
String

EIN 0 1

uBT_BackLight
Timeout

R/W Dezimalw
ert-String

15 0 5000 Zeit (Sek.), nach der sich
die
Hintergrundbeleuchtung
ausschaltet, Reset durch
beliebiges Berühren des
Bildschirms oder per
Software.
‚0’ = die
Hintergrundbeleuchtung
bleibt eingeschaltet.

uBT_BooterVer
sion

Read ANSI-
Text
String

Strin
g
aktu
elle
Vers
ion

0 8 Firmware-Booter Version

uBT_BuzzFreq R/W ANSI-
Text
String

500 125 8000 Frequenzeinstellung des
Summers bei Berührung
(125, 250, 500, 1000,
2000, 4000, 8000)

uBT_BuzzOnOf
f

R/W Boolean-
Wert
String

EIN  0  1 Akustischer Summer bei
Berührung Ein/Aus

uBT_BuzzVol R/W Dezimale
r
Aufzählun
gs-String

0 =
AUS

0 20 Lautstärkeneinstellung
des Summers bei
Berührung (20 = 100%)

uBT_ConfigTyp
e

Read ANSI-
Text
String

Aktu
eller
Conf
ig
Typ

0 24 Konfigurationstyp
String (Lesen)

uBT_ConfigVer
sion

Read ANSI-
Text
String

Aktu
eller
Conf
ig
Vers
ion

0 4 Konfigurations Version
String (Lesen)
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uBT_DefaultGat
eway

R/W IP
address
string

0x00
000
000

  Gateway Adresse für
Fernzugriff  (peer), 
‚0’ = nicht konfiguriert

uBT_DispResol
ution

no ANSI-
Text
String

<Scr
een
widt
h>
<Scr
een
heig
ht>
<Col
orde
pth>

0 16 Info Auflösung
String
(Schreibgeschützt)

uBT_DispRotati
on

R/W UTF8 !!!
1) 
Text
String

0°
(0x3
0C2
B0)

0° 270° Rotation
0°,90°,180°,270°
Modifikation benötigt
Neustart.
FTP-Verbindungen
werden unterbrochen.
 !!! 1) FTP-Client
unterstützt unter
Umständen nicht die
direkte Anzeige von
UTF8.
Der Displayinhalt ist
drehbar. Ein Teil des
Bildschirms wird
möglicherweise nicht
angezeigt - auch im
Auto-skaliermodus nicht.

uBT_EnableCa
che

R/W Boolean-
Wert
String

EIN  0  1 ‚1’ = Dateicache aktiv,  
‚0’ = kein Dateicache für
Nicht-Bilder-Dateien.
Dateien werden vor der
Verwendung
zwischengespeichert.
Der Cache wird zuerst
nach der gesuchten
Datei durchsucht,
unabhängig von der
lokalen
Einstellungsdatei.
Der Cache wird beim
Start und bei einem
URL-Sprünge gelöscht.

Bild-Dateien werden
dekomprimiert und in
einem eigenen Video-
Cache, der immer aktiv
ist, zwischengespeichert.
Diese Video-Cache wird
bei einem Start und bei
URL-Sprünge gelöscht.
Bei zu viel geladenen
Dateien werden alle
benötigten Dateien neu



60

Saia-Burgess Controls AG Arbeiten mit dem MicroBrowser

 

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

geladen und wieder
dekomprimiert.

uBT_EnableSIP R/W Boolean-
Wert
String

EIN
(Ena
ble)

 0 1 Bildschirmtastatur
‚1’ =  verwenden
(alphapad.teq und
keypad.teq)
‚0’ = ausgeschaltet

uBT_FirstPadN
ame

R/W Dezimale
r
Aufzählun
gs-String

alph
apa
d.
teq

 1 24 Lokaler Dateiname einer
alternativen, virtuellen
Tastatur als Ersatz für
'alphapad.teq'.
Standartmässig wird
'alphapad.teq' aus dem
Setup-Menü (ab
INTFLASH / WEB)
verwendet.
Die Alternative-Datei -,
welche anders als
alphapad.teq genannt
werden muss, ist im M1-
Steckplatz oder auf SD-
Flashkarte über FTP zu
speichern. Weitere
Möglichkeit 'Web-
Projekt' im Remote-
Server.
Die maximale Anzahl der
Zeichen (Dateiname und
Dateierweiterung inkl.
Punkt) ist 24.

uBT_FlashStatu
s

no Dezimalw
ert-String

0 0 255 M1 Flash Status:
‚20’ = Gerät vorhanden,
kein Dateisystem
‚21’ = Gerät vorhanden,
Dateisystem OK
‚22’ = Gerät vorhanden,
Fehler bei
Dateisystemerstellung 
‚23’ = Gerät vorhanden,
erstellt gerade
Dateisystem 
‚24’ = Gerät vorhanden,
führt gerade
Kompression auf  Flash-
Sektor-Ebene durch
‚-1’ = Unbekannter
Fehler

uBT_FocusBord
erWidth

R/W Dezimalw
ert-String

2 0 5 Rechteckige Fokus-
Rahmenlinienbreite  des
aktiven Edit- und Button-
Painterobjekts: 1-5
(Pixel).
‚0’ =
Fokusanzeigerahmen
ausgeschaltet
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uBT_IntFlashSt
atus

no Dezimalw
ert-String

0 0 255 Interner Flash-Status:
‚20’ = Gerät vorhanden,
kein Dateisystem
‚21’ = Gerät vorhanden,
Dateisystem OK
‚22’ = Gerät vorhanden,
Fehler bei
Dateisystemerstellung 
‚23’ = Gerät vorhanden,
ist gerade dabei das
Dateisystem zu erstellen 
‚23’ = Gerät vorhanden,
beschäftigt mit
Kompression auf der
Ebene des Flash-
Sektors
‚-1’ = Unbekannter
Fehler

uBT_IntroGraph
icName

R/W ANSI-
Text
String

Saia
SUG
rand
e.gif

0  20 Intro Graphik

uBT_IntroGraph
icXPos

R/W Dezimalw
ert-String

100 0 639 Intro Graphikposition

uBT_IntroGraph
icYPos

R/W Dezimalw
ert-String

50 0 479 Intro Graphikposition

uBT_IntroText R/W ANSI-
Text
String

'Wel
com
e'

0 32 Intro Text

uBT_IntroTextX
Pos

R/W Dezimalw
ert-String

350 0 639 Intro Textposition
(Horizontale Position von
links)

uBT_IntroTextY
Pos

R/W Dezimalw
ert-String

300 0 479 Intro Textposition
(Vertikale Position von
oben)

uBT_TCPIPAdd
r

R/W IP
address
string

0xA
C17
03D
F:
192.
168.
12.9
0

 *  * TCP/IP-Adresse des
Terminals (eigene
Adresse)

Modifikation erfordert
Neustart des Terminals.
Verliert die FTP-
Verbindung.

uBT_IsTSPrese
nt

no Dezimalw
ert-String

aktu
eller
Wert

0 255 ‚1’ = Touchscreen
gefunden, ‚0’ = wurde /
wird die Kalibrierung
beim Hochfahren
übersprungen.

uBT_LastKeyEv
ent

no ANSI-
Text
String

 0 32 Letzter KeyDown-Event
Code

uBT_LastKeyEv
entUp

no ANSI-
Text

 0 32 Letzter KeyUp-Event
Code
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String

uBT_LcdContra
st

R/W Dezimalw
ert-String

10 0 20 '0..20' Einstellung
Kontrast / Helligkeit der
Hintergrundbeleuchtung
(20=100% hell).

uBT_LocalFileS
earch

R/W Dezimale
r
Aufzählun
gs-String

Loca
l
befo
re
rem
ote
0 =
OFF

(1) 2 Modus für lokale
Dateisuche auswählen
‚0’ = keine Verwendung
lokaler Dateien
‚1’ = Lokale Dateien vor
Ferndatei verwenden
‚2’ = Ferndatei vor der
lokalen Datei
verwenden. 
Der Befehl für die lokale
Suche ist festgelegt, in
der Reihenfolge der
Verwendung:
- Video-Cache (nur Bild)
- Dateicache (wenn
aktiviert)
- Interner Flash
- M1_Flash
- SD Card Flash, wenn
verwendet

uBT_MACAddr no ANSI-
Text
String

 0 20 Eigene MAC-Adresse
String (Lesen)

uBT_SbusAddr R/W Dezimalw
ert-String

10 0 253 Eigene SBus-Adresse

uBT_
ScaleMode

R/W

uBT_SecondsT
oInactivity

R/W ANSI-
Text
String

0 0 5 Überwachungszeit
(Sek.) für Touchscreen /
Tastatur
Dies kann für eine
Umstellung auf eine
weniger häufige
Berührung verwendet
werden / Tastatur-
Eingabe Polling-Modus.

uBT_SerialNum
ber

Read ANSI-
Text
String

 0 12 Seriennummer
String (Lesen)

uBT_Setup no Boolean-
Wert
String

 0 0 1 ‚1’ = öffnet ein Pop-up
und   springe zum
Setup-Menü.

uBT_SubNetMa
sk

R/W String IP-
Adresse

0xF
FFF
FF0
0

 *  * SubNetMaske
Modifikation erfordert
Neustart des Terminals.
FTP-Verbindung wird
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Unterbrochen.

uBT_Version Read ANSI-
Text
String

Strin
g
aktu
elle
Vers
ion

0 32 Firmware-Version
String (schreibgeschützt)

*   Generally IPv4 private addresses are used. Standard settings are:
     - 1 x A class, with subnet addresses 10.x.x.x, and mask 255.0.0.0  - parts may be
used also
     - 16 x B class,  with subnet addresses 172.16.x.x up to 172.31.x.x and mask
255,255,0,0 – 
       parts or combinations may be used also
     - or 256 x C class, with subnet addresses 192.168.0.x up to 192.168.255.x  and
mask 255,255,255,0 -
       combinations may be used also



64

Saia-Burgess Controls AG Arbeiten mit dem MicroBrowser

 

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

Fonts auf den MB-Panels PCD7.D4xx, QVGA und VGA Auflösung.

Standart Variablen für QVGA MB-Terminals

Font and font style Character Size

Arial 10, 12, 16

Arial Bold 14, 20

Courier New 10, 12, 16

Courier New Bold 14, 20

Tahoma 10, 12, 16

Tahoma Bold 14, 20

Standart Variablen für VGA MB-Terminals

Font and font style Character Size

Arial 10, 12, 16, 20, 24, 36

Arial Bold 14, 20, 24, 36

Courier New 12, 16, 20

Courier New Bold 14, 20

Tahoma 12, 16, 20, 24

Tahoma Bold 14, 20, 24

Wird nicht auf die Schriftart und den Stil im Web-Editor geachtet, besteht das Risiko
die Ausgabe unerwünschter Zeichen. Im folgenden ist eine kleine Übersetzungstabelle
mit einigen gängigen Schriftarten und Stil's.

Beispiele falscher Interpretation der Schriftgrösse und Schriftart
(QVGA):

Arial 8, 20 -> Arial 8 wird Arial 10, Arial 20 wird  Arial fett 20
Arial fett 12, 24 -> Arial fett 12 und 24 wird Arial 12
Courier New 8, 20 -> Courier New 8 wird Courier New 10, Courier New 20
wird Courier New fett 20
Courier New fett 10 -> Courier New 10
Tahoma 8, 20 -> Tahoma 8 wird Tahoma 10, Tahoma 20 wird Tahoma
fett 20
Tahoma fett 16 ->  Tahoma 16
Arial 12 kursiv -> Arial 12
Arial 12 fett & kursiv -> Arial 12
Lucida Calligraphy 12 -> Arial 12

Siehe Kapitel 'WYSIWYG For Fonts' für weitere Details

Funktionstasten programmieren mit FKEY pads für Web Panel
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Knopf platzieren und den Funktionstasten-Tab öffnen.

Verwendung der Syntax: FKEY_1  ,   FKEY_2 , FKEY_3 , ….. und ESC
Die Anzahl der Knöpfe ist abhängig der Nummer von Fkeys welche Sie einsetzen
wollen.

Groß-und Kleinschreibung wird nicht unterschieden.

Beispiel: Mit dem Comfort Line MB Panel sind 12 Funktionstasten verfügbar.

Achtung: Nicht den “Hide Painter” benutzen um verborgene Knöpfe zu erstellen !

Verborgene Knöpfe werden kurze Zeit sichtbar wenn die Seite wechselt. Wir raten
davon ab, diese Knöpfe auf einem vergrösserten Bereich auf dem Hindergrund TEQ
zu platzieren.

Weitere Details:
Die TEQ View kann mit drei verschiedenen Layer erstellt werden. Jeder dieser Layer
kann durch den Anwender einzeln editiert werden. Im Betrieb werden diese drei Layer
zu einer View zusammengefasst.
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Ausrichtung der Knöpfe

Dazu ist ein TEQ-Hintergrundbild zu erstellen und es zu vergrößern. Die F-Taste
können irgenwo gesetzt werden. Auf diese Weise werden sie auf dem Bildschirm-
Panel unsichtbar.

(Beispiel mit MB QVGA Panels: Standardgrösse ist 320 x 240, vergrössert 320 x 280).

(Beispiel mit MB QVGA Panels: Standardgrösse ist 640 x 480, vergrössert 640 x 560).

Weitere Informationen in folgenden Dokumentationen:

Dokument Referen
z

Hinweis WEB

User’s guide QVGA MB panels 26/869 English

User’s guide VGA MB panels 26/858 English (in the
packing)

Manual QVGA and VGA MB
panels

26/851
EN

English www.sbc-support.ch/

Handbuch QVGA und VGA MB
Panels

26/851
DE

German www.sbc-support.ch/

Manual QVGA and VGA MB
panels

26/851
FR

French www.sbc-support.ch/
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17 Arbeiten mit dem NanoBrowser

NanoBrowser ist für die eDisplay Hardware mit seiner begrenzten Menge an Speicher
optimiert. NanoBrowser enthält fast alle Eigenschaften, welche vom MicroBrowser
bekannt sind und ist 100% kompatibel mit dem S-Web Editor. Die Arbeitsweise, mit
welcher Sie vertraut sind, hat sich nicht geändert. Der S-Web Editor überprüft einige
Projektparameter um sicherzustellen, dass das HMI Projekt mit der eDisplay
Hardware kompatibel ist und seine Speichergrenzen nicht überschritten werden (wird
während 'Build All' ausgeführt).

Der Projekt Wizard Und Die eDisplay Projekt Optionen

Der S-Web Editor liesst Informationen über die eDisplay Hardware Begrenzung von
einem Hardware Profil heraus, welches im Projekt Wizard erstellt wird.

S-Web Editor Projekt Wizard:

Entsprechend dem Hardware-Profil bildet der Projekt Wizard die Einstellungen,
welche am Besten zur eDisplay Hardware passen. (TEQ-View Grösse, Zoom Faktor,
Farbe…etc.).
Der S-Web Editor setzt automatisch die erforderten Projekteinstellungen für die
eDisplay Hardware.

Projekt 'Build Advanced' Einstellungen die durch den Project Wizard eingestellt
werden:
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Der NanoBrowser benötigt SpiderControl Schriftdateien, um Schriften, welche Sie in
Ihrem HMI Projekt verwenden, für das eDisplay zur Verfügung stellen zu können. Der
S-Web Editor liesst Ihre sprachabhängigen CSV-Dateien um festzustellen, welche
Unicode Charakter für welche Schriftart und Schriftgrösse für das HMI benötigt
werden. Der S-Web Editor erstellt SpiderControl Schriftdateien welche exakt diese
Unicode Charakter enthält. Dies ermöglicht es, alle Unicode Charakter zu benutzen,
welche im jeweiligen 'TrueType' vorhanden sind (siehe Kapitel Multilingual HMIs,
Working With Unicode)..

Der S-Web Editor ist ab Version 5.14.05 fähig, SpiderControl Schriftdateien (*.fnt)
während dem 'Build All' Prozess zu generieren. Diese SpiderControl Schriftdateien
werden mit allen übrigen Projekt Dateien erstellt und heruntergeladen, somit sind
keine speziellen Tätigkeiten dafür notwendig. Sollten Sie das eDisplay Hardware Profil
auswählen, ist die Option um SpiderControl Schriftdateien zu erstellen automatisch
aktiviert.

Wie im Bild oben ersichtlich, enthält der S-Web Editor eine Option namens 'Convert
project's Gif to Bmp' im Falle einer vorhandenen eDisplay Hardware. Der S-Web
Editor erstellt während dem 'Build All' Prozess monochrome Bitmaps wenn diese
Option vorgängig aktiviert wurde. Es wird nicht empfohlen, diese Option zu
deaktivieren, weil das eDisplay nicht in der Lage ist, GIF-Bilder anzuzeigen.

Wenn Sie mit dem eDisplay arbeiten ist 'Generate/Update Scalable html files' eine
nützliche S-Web Editor Funktion. Der MicroBrowser und das Java-Applet ist fähig das
HMI mit Ihrem, im S-Web Editor definierten Faktor zu skalieren (siehe Kapitel 'Editor
Reference>Main Window').

NanoBrowser Makro Bibliothek

S-Web Editor enthält eine Makro Bibliothek, welche für die kleinere Displaygrösse und
die Speicherbegrenzung des eDisplays ausgerichtet ist (siehe Kapitel 'Macro Library
Index').
Das Makro Format ist für alle Ebenen identisch. Wenn Sie die Begrenzung der
Display- sowie Speichergrösse beachten, sind Sie in der Lage, mit den gleichen
Makros zu arbeiten, die Sie für andere S-Web Editor Projekte bildeten. 
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Was Sie wissen müssen, um ein Benutzerprojekt zu erstellen

Standart-Projektname
Der Standartname eines jeden Projekts ist  ‘estart.html’ .

Zeichenbearbeitung
Zeichenbearbeitung für PPO mit STRING-Format

Maximum of PPOs, containers, painters … per project and per view

Objekt Anzahl

Max PPO per
project

100

Max Container per
project

16

Max HTML Tag
per project

1000

  

Max PPO per view 30

Max Container per
view

16

Max HTML Tag
per view

1000

Max Painter per
view

20

Siehe ".../Web Editor/ SaiaDefaultSpiderHWProfile.shp"

Navigation
Für die Systemnavigations (ohne Touchscreen) reicht ein
"EventP_SetFocus_onGainFocus" Makro in jeder TEQ-View-Datei. Es empfiehlt sich
das Makro für einen Seitewechsel unter einem "Jump action"-Ereignis anzugeben.

Standartschriftart, Schriftarten und Schriftartengenerator
Die Standartschriftart in der Projektkonfiguration ist Tahoma regular 8, 10 oder 12 !!!!

Default Fonts
Die 3 Standartschriftart und Schriftgrössen sind:

Tahoma regular 8 
Tahoma regular 10 
Tahoma regular 12

Diese Standartschriftarten können für PPO's, Containers, Strings oder HTML-Tags
verwendet werden.
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Andere Schriftarten

Painters Format Tahom
a
regular
 
8

Tahom
a
regular
10

Tahom
a
regular
12

Add*
font
1

Add*
font
2

Add*
font
3

Add*
font
4

Button + 
Static text

String x x x     

 PPO x x x     

 Contain
er

x x x     

 Html
Tag

x x x x x x x

Edit-box PPO x x x     

 Contain
er

x x x     

Multi-line
label

String x x x     

 Html
Tag

x x x x x x x

Macros         

Table control  x x x     

Drop down
PPO

 x x x     

Drop down
html tag

 x x x x x x x

* erstellt mit dem Schriftartengenerator (Projektkonfiguration: Generate Spider Schrift-
Dateien)

Siehe auch:

Dokument ArtikelNr Hinweis www

Handbuch eDisplay PCD7.
D300E

26/870 English sbc-support.ch
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18 XX7 Variablenliste import

Supported Platforms

- Java Applet
- MicroBrowser

Ab dem S-Web-Editor Version 5.15 können XX7-Symbole anstatt nur PDP-Speicher-
Adressen wie z.B. PDP,, MW500, d verarbeitet werden.

XX7-Symbole können durch surfen in der S7P Symboldatei wie im folgenden Bild
gezeigt, importiert werden:

Darüber hinaus ist es möglich, Container-Offsets innerhalb XX7 Symbolen zu
verwenden. Dies ist sehr nützlich beim Zugriff auf die S7-Daten-Arrays und sogar
Arrays von Strukturen mit Hilfe von Container-Variablen.

Die folgenden Schritte beschreiben, wie das Einrichten eines XX7 Projekts und das
Verbinden mit S7P Projektdatei vor sich geht. Anschliessend wird gezeigt, wie der
Container-Offset mit s7 PPO Symbole verwendet werden kann.

XX7 Projekt einrichten

1. Der Menübefehl File->New Project wählen, um den Dialog 'Project Creation'  zu
öffnen. Den Projektnamen  eingeben und auf "Browse" (durchsuchen) klicken, um
das Projekt-Verzeichnis zu wählen. Mit 'OK' bestätigen.
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2. Menupunkt Project->Project Configurations...  wählen

3. Projekttyp ändern von 'Saia Standard' zu 'Saia XX7' wie nachfolgend gezeigt.:
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Dieser Schritt wechselt den Projekttyp und ersetzt IMasterSaia5_15_00.jar durch
IMasterXX7_5_15_00.jar (Applet für XX7-Projekte)

4. Den Reiter 'Project - Advanced' wählen. Erneut den Menupunkt Project->Project
Configurations... öffnen, nach dem der letzte Schritt mit 'OK' bestätigt wurde.

5. 'Browse' neben dem Textfeld 'Saia xx7 PPO variable list Project File' anklicken und
anschliessend eine "*.s7p"-Datei wählen.
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6. S7 Programmnamen wählen und anschliessend 'OK' drücken.

7. Den Projekt Konfigurationsdialog mit 'OK' bestätigen.

8. Einen neuen TEQ view im Projekt mit Pr oj ect - >Add To Pr oj ect - >New. . .
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einfügen.

9. Einen "edit box painter" (siehe Bild) einfügen.

10.Doppelklick auf die soeben eingefügte Editbox ausführen, um die
Einstellungsoptionen zu öffnen und den Reiter  'Repaints' wählen.

11.Den Knopf "Select" betätigen um den "S7 symbol browse dialogue" zu öffnen:

12.Die gewünschte S7 Symbolvariable wählen und auf 'OK' klicken.

13.Den Haupt-TEQ in der Projektkonfiguration definieren. Project->Project
Configurations... wählen und zum 'Project - Applet Advanced' wechseln.

14.Das Projekt mit der Funktion 'Build All' kompilieren.
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15.Das Projekt kann nun in die SPS geladen werden. Dazu wird die S-Web
Editoreigene FTP Funktion verwendet.

Siehe auch unter 'File Transfer To PCD System From S-Web-Editor FTP-Client' im
Kapitel 'Filetransfer to the PCD system'.

Container Offset und XX7 Symbolnamen

Es ist möglich mit der '@ CO'-Syntax auf die Strukturen innerhalb eines Arrays
zuzugreifen. S-Web-Editor berechnet den Speicher-Offset automatisch. Die
tatsächlichen Offset-Bytes der Struktur müssen nicht beachtet werden.

Der Variablenname muss nicht eingetippt werden. Einfach den 'PPO Selector'-Dialog
wie im letzten Beispiel verwenden.

Beispiel einer Benutzervariablen mit Containeroffset:
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Die Syntax ist die gleiche, wie bereits im Kapitel 'Container Offset' beschrieben.

Important Notice: If you work with S7 symbols you cannot use the '@COFF' syntax
also known as 'Incremental Container Offset'. 
Wichtiger Hinweis: Wird mit S7-Symbolen gearbeitet, ist es nicht möglich mit der '@
COFF'-Syntax den "Incremental Container Offset' zu verwenden.
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19 Container

19.1 Initialisierung der Container

Unterstützt:

- Java Applet
- MicroBrowser
- NanoBrowser

Container sind lokale Variablen, die innerhalb einer oder mehreren Ansichten sichtbar
sind (nicht aber im Zielsystem). Mit dem Menubefehl Projekt->Init Container... lässt sich
der Eigenschaftsdialog für Container-Variablen öffnen. Darin werden alle Container
aufgelistet.

Um den Wert einer Container-Variable zu ändern klicken Sie in der entsprechenden
Zeile auf die Spalte Initial Value. Ein Klick auf <OK> schliesst den Dialog und erzeugt
eine Container Initialisierungsdatei mit dem Namen <i hr _pr oj ekt name>. i t q.

Diese Datei muss ins Zielsystem übertragen werden.

Toolbar-Symbol:

Alle Container sind hier aufgelistet.

Den Anfangswert eines jeden Containers lässt sich im in der Spalte "Initial Value"
vorgeben. Beim Verlassen des Dialogs mit 'OK' wird die Datei "<projectname>. ITQ"
angelegt.

'MB_tmz_en' und 'MeldungBoxCO' sind reservierte Container-Variablen welche immer
vorhanden sind.

19.2 Container Offset

Unterstützt:

- Java Applet
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- MicroBrowser
- NanoBrowser

Mit "Container Offset" können Arrays im MMI angezeigt und editiert werden. Für das
Editieren des Arrays, werden zwei Eingabefelder eingefügt. Eines vom Typ Container
für den Array Offset und ein zweites für die Anzeige des Array Elements vom Typ
PPO.

Der Benutzer kontrolliert nun, welches Array Element angezeigt wird, in dem er den
entsprechenden Index 1, 2, 3 oder 4 in das zweite Eingabefeld eingibt.

Für das Eingabefeld, welches den Wert des Array Elements anzeigt, wird in der
Adressierung ein spezieller Syntax verwendet.

Beispiel: Inkrementeller Container Offset

1. Fügen Sie zwei grafische Visualisierungsobjekte 'Edit Box' (Eingabefeld) in eine
neue TEQ-View ein.

 

2. Definieren Sie den Typ "CONTAINER" für einen der eingefügten Eingabefelder
sowie einen Namen für die Array Offset Variable.

3. Definieren Sie den Typ "PPO" für das zweite Eingabefeld. Das Array wird nun über
einen speziellen Syntax adressiert.

 

Genereller Syntax für Container Offset:
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Syntax im Fall einer absoluten PDP-Adresse:

 
Der Text vom Präfix "+@COFF" bis zum Trennzeichen "@" wird nun mit dem Wert
von "ContainerName" ersetzt.
Der Wert von "ContainerName" muss ein Zahlenwert sein. 

Wenn ein PPO im Stil von "my123Var" hat, entspricht "BasePPOName" dem Teil "my"
und der Suffix dem "Var".

4. Durch "'Build All" wird das Projekt mit PG5 in die SPS geladen.

Was passiert zur Laufzeit?

Definiren des PPO Namens: PDP,,R1000+@COFF_MyContainer@

'PDP,,R1000' ist die PPO-Basisaddresse. Zu dieser Basisaddresse wird nun der Wert
im Container 'MyContainer' addiert (flankiert vom Begriff  '+@COFF_' und dem
nächsten '@'-Zeichen).

Text (String) ersetzen
Syntax für den PPO Namen:
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Der Text zwischen "@CO_" und dem Trennzeichen "@" wird mit dem Wert bzw. Text
von "ContainerName" ersetzt.

Bitte verwenden Sie keine symbolischen PPO-Variablen und Ersetzen-Strings wie
@CO. Verwenden Sie immer einen absoluten PPO-Adresse wie PDP, F2004 ...

Wichtiger Hinweis:  Die Verwendung einer Offset-Syntax mit Hilfe einer PPO-
Variable um eine andere  PPO-Variablen zu adressieren, ist nicht erlaubt:

19.3 Session Container

Unterstützt:

- Java Applet
- MicroBrowser

Session Container dienen dazu, Informationen über die gesamte Dauer einer 'Session'
zu behalten, sogar wenn der Benutzer zu einem anderen HMI wechselt. Schliesst der
Benutzer den Browser, werden die Werte der Session-Variablen verworfen.

Es gibt 20 Session-Container mit vordefinierten Namen: "_NOINITSESSCO_0",
"_NOINITSESSCO_1"... "_NOINITSESSCO_19"
Verwenden Sie z.B. Session-Variablen um den 'Benutzer-Level' einer Passwort-
Einstiegsseite (Password Entry Page)über die Dauer der gesamten Session zu
erhalten.

Die Session endet sobald der Anwender den Browser schliesst.

19.4 Spezielle Container Namen

Unterstützt:

Siehe Tabelle unten

Spezielle Container Namen

Der S-Web Browser (IMaster Java Applet or MicroBrowser) verwendet einige spezielle
Container Variablen. Die Namen dieser Container Variablen sind reserviert. 

Wenn Sie einen speziellen Container beispielsweise im 'Cross Ref' Dialog eines
Makros sehen, ändern Sie diesen auf keinen Fall. 
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Wenn Sie eigene Container definieren, achten Sie darauf, dass Sie nicht den Namen
einer speziellen Container Variable verwenden.

Die speziellen Container Variablen sind entweder in dieser Liste aufgeführt oder sind
daran zu erkennen, dass der Name mit '@MACRO' beginnt.

Container-Name Beschreibung Unterstützt

Java
Applet
Client*

Micro
Browse

r*

Nano
Browse

r

@BLINKCO S-Web Browser 'toggelt' (0/1) den
Wert dieser Container Variable
jede Periode (read-only)

X X -

@CURRENT_PAGE Name der aktuellen TEQ-View
(read-only)

X X X

@LAST_PAGE Name der letzten TEQ view (read-
only)

X X X

@FOCUS Siehe Set Focus On Gain Focus
Makro

- X X

@LANGUAGE Enthält den Namen der CSV
Sprachdatei

X X X

@MB_FKEY_EVENT Letzter Funktions-Key (read-only) X X -

@MB_FULL_REDRA
W

Schreiben Sie '0' bzw. '1' um die
Option 'Full Redraw' aus- bzw.
einzuschalten

- X -

@MODAL_FOREGR
OUND

Modales Vordergrund-TEQ ein-
bzw. ausschalten (0 = deaktiviert;
1 = aktiviert)

X X -

AUTOINCRCO Container wird nach jeder Periode
automatisch inkrementiert.
z.B.: Animated GIF macro

X X -

IMaster.VERSION IMaster Java Applet
Versionsnummer (read-only)

X - -

IsWebBrowser 0 = MicroBrowser hat lokales HMI
geöffnet
1 = MicroBrowser hat HMI von
'Remote' geöffnet

X X -

MB_APP_VERSION MicroBrowser Versionsnummer
(read-only)

- X -

MB_VERSION NanoBrowser Versionsnummer
(read-only)
Versionsnummer der XML
Konfigurationsdatei für den
MicroBrowser  .

- - X

MB_Backlight ** LCD/Display
Hintergrundbeleuchtung
0 = deaktivieren / 1 = aktivieren

- X -

MB_BringWindowToT
op **

Applikations-Fenster über den
Fensternamen (oder nur einen
Teil davon) in den Vordergrund
bringen
'_self' bringt das MicroBrowser

- X -
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Fenster in den Vodergrund

MB_Buzzer ** Buzzer:   0 = deaktivieren / 1 =
aktivieren

- X X

MB_ConcecutivUpdat
e
PPOCGIErrorsCount

The number of consecutively failed
HTTP requests for PPO updates
(Order Values Read File or ILR
Updates). Resets to 0 after one
successful request. Can be used
to detect problems with the
connection to the web server.

X X

Version 
1.5.15.1

13
and

newer

-

MB_ExeToTop ** Applikation in Vordergrund
bringen in diesem Container.

- X -

MB_FOCUS Enthält die Objekt-ID (0..n) des
aktuell ausgewählten Objektes
- 10 bedeutet keine Selektion

- X -

MB_Gateway Gateway Adresse des Clients
(read-only)

- X -

MB_HEAP1_SIZE Zeigt benötigte Anzahl Bytes in
Heap1 Speicher (read-only)

- - X

MB_HEAP2_SIZE Zeigt benötigte Anzahl Bytes in
Heap2 Speicher (read-only)

- - X

MB_LocalHostName Local host name (read-only) - X -

MB_inactivity_pts_ms Refresh-Intervall in Millisekunden
für den Zustand 'Benutzer inaktiv'

Entspricht der Einstellung
'inactivity_pts_ms' aus der XML-
Konfigurationsdatei (uBrowser.
xml)

- X -

MB_inactivity_to_sec Zeit in Sekunden, bis der
MicroBrowser in den Zustand
'Benutzer inaktiv' wechselt.
Entspricht der Einstellung
'inactivity_to_sec' aus der XML-
Konfigurationsdatei (uBrowser.
xml)
z.B.:
MB_inactivity_pts_ms = 5000
MB_inactivity_to_sec = 60
Die Refresh-Periode ist auf
5000ms nach 60sec Inaktivität
gesetzt (Inaktivität = keine
Aktivität des Anwenders).

- X -

MB_InactivityCounter Diese Variable inkrementiert jede
Sekunde. Sie wird auf '0' gesetzt,
sobald der Benutzer aktiv ist.
(read-only)
Z. B.  diesen Zähler mit einem
Event-Painter auf '0' setzen. Es ist
nicht, einen anderen Wert in
diesen Container zu schreiben.
z.B.: Event Timeout Logout
Macro; beschrieben in Kapitel 
Automatical View Jump

X X X

MB_InactivityCounter
Min

Variable inkrementiert jede
Minute, wenn der Benutzer inaktiv
ist (read-only)

X X -
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Wird auf 0 zurückgesetzt, sobald
der Benutzer aktiv wird

MB_IpAddress IP-Adresse des Client (read-only) - X -

MB_OS_VERSION Versions Bezeichner des
Betriebssystems (read-only))

- X -

MB_PERCO_0
MB_PERCO_1
...
MB_PERCO_19

Siehe Kapitel 'Persistente
Container'

- X -

MB_PLATFORM Plattformname, z.B. "uBT",
"uBCE", "uBXP", ... (read-only)

- X -

MB_PollTimeSubstitut
e

Erlaubt es, jederzeit eine neue
Refresh-Periode zu setzen ('0'
bedeutet der Client verwendet die
Projekteinstellung)

X X -

MB_SCREEN_HEIG
HT

Höhe des Bildschirms in Pixel
(read-only)

- X -

MB_SCREEN_WIDT
H

Breite des Bildschirms in Pixel
( (read-only)

- X -

MB_StartProcess ** Über den Namen, kann ein
beliebiges Programm gestartet
werden.
'killme' schliesst den
MicroBrowser

- X -

MB_Subnet Client Subnet-Maske (read-only) - X -

MB_tmz_en Lokale Zeitzone oder UTC Zeit
(0/1)
Wird z.B. für die Zeitanzeige in
Trending und Alarming verwendet

X X -

MB_UpdateAfterCoW
rite

Container Variable auf '1' setzen
um die Reaktionszeit nach dem
Schreiben von Container
Variablen zu verbessern

- X -

MB_UpdateAfterPpo
Write

Container Variable auf '1' setzen
um die Reaktionszeit nach dem
Schreiben von PPOs zu
verbessern

- X -

MB_Volume ** Lautstärke in Prozent - X -

MB_WakeUp ** Auf '1' setzen um den
Bildschirmschoner abzuschalten

- X -

MessageBoxCO Reservierte Variable für die
Message Box TEQ-View

X X -

MSGBOX_NR Anzahl Meldungen in der
Message Box

- X -

_KEYEVENT Vom Keypad verwendete Variable - X -

_KEYPAD Wert der im gerade Keypad
bearbeitet wird

- X -

_KEYPAD_DEST_NA
ME

Name der Variable in die das
Keypad schreiben wird

- X -
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_KEYPAD_DEST_TY
PE

Typ der Variable in die das
Keypad schreiben wird

- X -

_KEYPAD_OPEN Öffnet die Keypad View - X -

_KEYPAD_SHIFT Implementiert eine Caps Lock
Funktionalität

- X -

_KEYPAD_TF_FOCU
S

Vom Keypad verwendete Variable - X -

KEYPAD_MIN Anzeigen des Minimum-Wertes
der bearbeiteten (PPO) Variable
(nicht beim Format z.B. DEC.2)

X X -

_KEYPAD_MAX Anzeigen des Maximum-Wertes
der bearbeiteten (PPO) Variable
(nicht beim Format z.B. DEC.2)

X X -

_KEYPAD_FORMAT Anzeige des Formates, definiert in
der TCR-Datei der bearbeiteten
(PPO) Variable

X X -

MB_SCREEN_BPP Zeigt die Anzahl der Bit per Pixel
für die Anzeige, 8, 16 oder 24-bpp

- X -

MB_ERRORTYPE Der Wert ändert sich nach der Art
des letzten Fehlers:
0: Für Web-Server-Fehler
1: Für Min/Max Grenzen
überprüfen Fehlern
Kann für MsgBox.teq Anpassung
verwendet werden.

X - -

* "X"= unterstützt, "-" = nicht unterstützt
** nicht auf allen Plattformen unterstützt

Reservierte Platzhalter und Containernamen

Die folgenden Container Namen werden vom Browser für Makro-interne Logik nur
verwendet. Verwenden Sie diese Vorwahlen oder Namen für Ihre eigenen Container-
Variablen.

Reserved Name AppendSrcToLocalFileResultCo

Reserved Name WriteSrcToLocalFileResultCo

Reserved Prefix ?S_ 

Reserved Prefix MB

Reserved Prefix @MACRO

19.5 Persistent Containers

Unterstützt:

- MicroBrowser



86

Saia-Burgess Controls AG Container

Persistent Containers

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

Dieses Kapitel ist nur relevant, wenn Sie MicroBrowser einsetzen. Persistente
Container haben spezielle Namen:

MB_PERCO_[0...19](for example MB_PERCO_2)

Die Werte von persistenten Containern sind permanent auf dem Dateisystem des
MicroBrowser Client gespeichert.
Wenn Sie MicroBrowser schliessen, gehen die Werte nicht verloren. Dies ist eine
nützliche Funktionalität, um beispielsweise die Spracheinstellung zu speichern.
Die persistenten Container haben keinen vordefinierten Verwendungszweck, Sie
können diese nach Bedarf verwenden.
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20 Erweiterte Funktionen

20.1 Übersicht Makro Bibliothek

Dieses Kapitel listet alle offiziellen Makro Bibliotheken ('MacroLib') auf. Es bietet einen
kurzen Überblick über ihre Funktionalität und verweist auf Hinweise in anderen
Kapiteln für ausführliche Beschreibungen.

Einige Makros besitzen mehrere Datenquellen/Adressen. Die Tabelle zeigt nur die
wichtigsten Quellen/Adressen an. Sind weitere Informationen erwünscht, so geben die
jeweiligen Kapitel dazu Auskunft.

Makros unterscheiden sich in ihrer Komplexität. Einige Makros enthalten nur ein
Painterobjekt, komplexere Makros mehrere. Jedes Makro hat sein eigener
Konfigurations-Dialog.

\SaiaAlarmingMacro

Macro Name Filename Description/Comment

Online Alarm List 2
MacroAlarmingDefOnline_5_15_00
f.esm

Alarmin (2) Übersicht
Online Alarm Liste

Offline Alarm History 2
MacroAlarmingHisOffline_5_15_00
b.esm

Alarmin (2) Übersicht
Offline Alarm History

Online Alarm History 2
MacroAlarmingHisOnline_5_15_00
b.esm

Alarmin (2) Übersicht
Online Alarm History

Online Alarm List
MacroAlarmingDefOnline_5_14_05
.esm

Alarming Overview,
Online Alarm List

Offline Alarm History
MacroAlarmingHisOffline_5_13_06
.esm

Alarming Overview,
Offline Alarm History

Online Alarm History
MacroAlarmingHisOnline_5_14_05
.esm

Alarming Overview,
Online Alarm History

\SaiaAlarmingMacro\QVGAcolors

Macro Name Filename (add '_5_13_01.esm') Description/Comment

Online Alarm List QVGA Q_MacroAlarmingDefOnline
Alarming Overview,
Online Alarm List

Online Alarm List QVGA
(Complete)

Q_MacroAlarmingDefOnlineCompl
et

Alarming Overview,
Online Alarm List

Online Alarm List QVGA
(Minimal)

Q_MacroAlarmingDefOnlineMini
Alarming Overview,
Online Alarm List

Offline Alarm History QVGA Q_MacroAlarmingHisOffline
Alarming Overview,
Online Alarm History

Online Alarm History QVGA Q_MacroAlarmingHisOnline
Alarming Overview,
Online Alarm History

Online Alarm List QVGA,
FKEY (Complete)

QFKEY_MacroAlarmingDefOnline
Complet

Alarming Overview,
Online Alarm List
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Macro Name Filename (add '_5_13_01.esm') Description/Comment

Online Alarm List QVGA,
FKEY (Minimal)

QFKEY_MacroAlarmingDefOnline
Mini

Alarming Overview,
Online Alarm List

Offline Alarm History QVGA,
FKEY

QFKEY_MacroAlarmingHisOffline
Alarming Overview,
Offline Alarm History

Online Alarm List QVGA,
FKEY

QFKEY_MacroAlarmingHisOnline
Alarming Overview,
Offline Alarm History

\SaiaEventList

Macro Name Filename Description/Comment

Event List EventsList_5_15_00m.esm Ereignislisten Übersicht

\SaiaGeneral\PasswordLogin

Makro Name
Dateiname (add
'_5_13_40.esm')

Quell
e Ziel

Beschreibung /
Kommentar

Password
Dialog
Macro (User
Level)

PasswordDialog_U
serLevel

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

CON
TAIN
ER,
PPO

Login mit
Passwort (kein
Benutzername)
Siehe Kapitel 
Password Entry
Page

Password
Dialog
Macro (User
Level)
Auto TEQ-
Jump

PasswordDialog_U
serLevel_Auto

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

CON
TAIN
ER,
PPO

Login mit
Benutzername
und Passwort
Siehe Kapitel 
Password Entry
Page

Logout
Event-
Painter (On
Timeout)

EventP_Logout_on
Timeout

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

TEQ
INDE
X,
CON
TAIN
ER

Siehe Kapitel 
Password Entry
Page

\SaiaGeneral\URLJumps

Makro Name
Dateiname (add
'_5_13_40.esm')

Quell
e Ziel

Beschreibung /
Kommentar
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URL Jump
Button (On
Mouse
Down)

ButonURLJump_on
MouseDown_5_14_
30.esm

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

URL Führt ein URL
Jump bei
Mouse Down
aus. Die
Knopfbeschriftu
ng kann als
STRING, PPO,
HTML TAG or
CONTAINER
definiert
werden.

URL Jump
Event-
Painter
(isEqual)

EventP_URLJump_
isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

URL Führt ein URL
Jump aus wenn
X gleich Y ist. X
und Y können
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

URL Jump
Event-
Painter
(On
Timeout)

EventP_URLJump_
onTimeout

STRI
NG,
PPO,
CON
TAIN
ER

URL Führt ein URL
Jump nach
einer gewissen
inaktiven Zeit
des Anwenders
aus.

\SaiaGeneral\ViewJumps

Macro Name
Dateiname (add
'_5_13_40.esm')

Quell
e Ziel

Beschreibung/
Kommentar

View Jump
Event-
Painter
(isEqual)

EventP_ViewJump
_isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

TEQ
INDE
X

Führt ein TEQ-
View Jump aus,
wenn X gleich Y
ist. X und Y
können
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

View Jump
Event-
Painter
(On
Timeout)

EventP_ViewJump
_onTimeout

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

TEQ
INDE
X

Führt ein TEQ-
View Jump
nach einer
gewissen
inaktiven Zeit
des Anwenders
aus.

\SaiaGeneral\WriteSourceToDestination
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Für Details siehe Kapitel 'Write Source To Destination Macros'

Makro Name
Dateiname (add
'_5_13_40.esm')

Quell
e Ziel

Beschreibung /
Kommentar

Write Source
To
Destination
Event-
Painter
(On Lost
Focus)

EventP_writeSrc2D
st_onLost

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten bei
'On Lost Focus'

Write Source
To
Destination
Event-
Painter
(On Repaint)

EventP_writeSrc2D
st_onRepaint

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten bei
'On Repaint'

Write Source
To
Destination
Event-
Painter
(On Gain
Focus)

EventP_writeSrc2D
st_onGain

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten bei
'On Gain Focus'

Write Source
To
Destination
Event-
Painter
(isEquall)

EventP_writeSrc2D
st_isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten wenn
X gleich Y ist.
X und Y können
vom Typ
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

Write Source
To
Destination
Event-
Painter
(isGreater)

EventP_writeSrc2D
st_isGreater_5_14_
19.esm

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten wenn
X gleich Y ist.
X und Y können
vom Typ
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

\SaiaGeneral

Makro Name Dateiname Quell Ziel Beschreibung /
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e Kommentar

DropDown
List

DropDownList_5_1
3_40.esm

STRI
NG,
HTM
L
TAG

PPO,
CON
TAIN
ER

Führt ein
DropDown aus
welche eine
Liste von einem
STRING oder
HTML TAG liest
und benutzt ein
PPO oder
CONTAINER
um auf das
laufende Objekt
zu zeigen

DropDown
List with GIF
Label

DropDownListGifBu
tton_5_14_28.esm

FILE
(GIF)
,
HTM
L
TAG

PPO,
CON
TAIN
ER

Enthält die
selbe Funktion
wie das Macro
'DropDown List',
zusätzlich ein
GIF-Bild mit
einem
Pfeilsymbol
(kann
ausgetauscht
werden).

Animated
GIF

AnimatedGif_5_13_
01.esm

FILE - Führt eine
animierte GIF
Funktionalität
aus.
Siehe Kapitel 
Animated GIF
Macro

Blinker Blinker_5_10_00.tlb @BL
INKC
O
(CO
NTAI
NER
)

- Blinker

Tacho Tacho_5_13_40.
esm

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

- Tachometer

Table
Control
Editable
PPO Page
Jump

TableControl_Edita
blePPO_
PageJump_5_10_0
0.tlb

PPO,
CON
TAIN
ER

PPO Enthält separate
Edit-Felder

Language
Button

LanguageButton_5
_14_28.esm

STRI
NG
(lang

@LA
NGU
AGE

Enthält einen
Knopf zur
Sprachwahl
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uage
filena
me)

(CO
NTAI
NER
)

während der
Laufzeit.

\SaiaHDLogTrendMacro

Makro Name
Dateiname (add
'_5_14_03.esm')

Beschreibung /
Kommentar

HDLog Trend
Macro (Complete)

RemoteOffSavedTrdCo
mplete

Siehe Kapitel  HDLog
Trend Macros

HDLog Trend
Macro (Minimal)

RemoteOffSavedTrdMin
i

Siehe Kapitel  HDLog
Trend Macros

\SaiaTrendMacro

Siehe Kapitel Trend Macros Introduction um das Konzept der Online, Offline und
Saved Trendings zu verstehen.

Makro Name
Dateiname (add
'__5_13_01.esm')

Beschreibung /
Kommentar

Offline Saved
Trend (Complete)

OfflineSavedTrendCom
plete

Siehe Kapitel Offline
Saved Trend Complete

Offline Saved
Trend (Minimal)

OfflineSavedTrendMini
mal

Offline Saved Trend
Minimal

Offline Saved
Trend (Scalable)

OfflineSavedTrendScala
ble

Offline Saved Trend
Complete

Offline Trend
(Complete)

OfflineTrendComplete Offline Trend Complete

Offline Trend
(Minimal)

OfflineTrendMinimal Offline Trend Minimal

Offline Trend Load
X Min Definition
(Minimal)

OfflineTrendMinimalOn
LoadXMinDef

Offline Trend Minimal

Offline Trend
(Scalable)

OfflineTrendScalable_5
_13_01.esm

Offline Trend Scalable

Offline Trend Load
X Min Definition
(Scalable)

OfflineTrendScalableOn
LoadXMinDef

Offline Trend Scalable

Online Trend
(Complete)

OnlineTrendComplete Online Trend Complete

Online Trend
(Minimal)

OnlineTrendMinimal Online Trend Minimal

Online Trend
(Scalable)

OnlineTrendScalable Online Trend Scalable
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\SaiaTrendMacro\QVGAcolors

Makro Name
Dateiname (add
'_5_13_01.esm')

Beschreibung /
Kommentar

Offline Saved
Trend QVGA
(Minimal)

Q_OfflineTrendMinimal Offline Trend Minimal

Offline Saved
Trend QVGA,
Save To File
(Minimal)

Q_OfflineTrendMinimal
_Save2File

Offline Trend Minimal

NanoBrowser Macro Library (eDisplay)

Makro Name
Dateiname (add
'_5_14_03.esm')

Quell
e Ziel

Beschreibung /
Kommentar

NanoBrowse
r Blinker

eD_Blinker @BL
INKC
O
(CO
NTAI
NER
)

- Blinker Makro

NanoBrowse
r URL Jump
Button (On
Mouse
Down)

eD_ButonURLJump
_onMouseDown

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

URL Führt ein URL
Jump On
Mouse Down
aus. Der
Anwender kann
wählen
zwischen 
STRING, PPO,
HTML TAG
oder
CONTAINER.

NanoBrowse
r DropDown
List

eD_DropDownList STRI
NG,
HTM
L
TAG

PPO,
CON
TAIN
ER

Führt ein
DropDown aus
welche eine
Liste von einem
STRING oder
HTML TAG liest
und benutzt ein
PPO oder
CONTAINER
um auf das
laufende Objekt
zu zeigen

NanoBrowse
r Logout
Event-
Painter (On
Timeout)

eD_EventP_Logout
_onTimeout

STRI
NG,
PPO,
CON
TAIN
ER,

TEQ
INDE
X,
CON
TAIN
ER

Siehe Kapitel 
Password Entry
Page
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HTM
L
TAG

NanoBrowse
r URL Jump
Event-
Painter
(isEqual)

eD_EventP_URLJu
mp_isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

URL Führt ein URL
Jump aus, wenn
X gleich Y ist. X
und Y können
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

NanoBrowse
r URL Jump
Event-
Painter
(On
Timeout)

eD_EventP_URLJu
mp_onTimeout

STRI
NG,
PPO,
CON
TAIN
ER

URL Führt ein URL
Jump nach
einer gewissen
inaktiven Zeit
des Anwenders
aus.

NanoBrowse
r View Jump
Event-
Painter
(isEqual)

eD_EventP_ViewJu
mp_isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

TEQ
INDE
X

Führt ein TEQ-
View Jump aus,
wenn X gleich Y
ist. X und Y
können
STRING, PPO,
CONTAINER
oder HTML
TAG sein.

NanoBrowse
r View Jump
Event-
Painter
(On
Timeout)

eD_EventP_ViewJu
mp_onTimeout

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

TEQ
INDE
X

Führt ein TEQ-
View Jump
nach einer
gewissen
inaktiven Zeit
des Anwenders
aus.

NanoBrowse
r Write
Source To
Destination
Event-
Painter
(isEquall)

eD_EventP_writeSr
c2Dst_isEqual

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten wenn
X glich Y ist. X
und Y können
STRING, PPO,
CONTAINER
oder HTML
TAG sein

NanoBrowse
r Write
Source To
Destination
Event-
Painter
(On Gain
Focus)

eD_EventP_writeSr
c2Dst_onGain

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten 'On
Gain Focus'

NanoBrowse eD_EventP_writeSr STRI PPO, Schreibt die
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r Write
Source To
Destination
Event-
Painter
(On Lost
Focus)

c2Dst_onLost NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

CON
TAIN
ER

Quelldaten in
Zieldaten 'On
Lost Focus'

NanoBrowse
r Write
Source To
Destination
Event-
Painter
(On Repaint)

eD_EventP_writeSr
c2Dst_onRepaint

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

PPO,
CON
TAIN
ER

Schreibt die
Quelldaten in
Zieldaten 'On
Repaint'

NanoBrowse
r Password
Dialog
Macro (User
Level)

eD_PasswordDialo
g_UserLevel

STRI
NG,
PPO,
CON
TAIN
ER,
HTM
L
TAG

CON
TAIN
ER,
PPO

Login mit
Passwort (kein
Benutzername)
Siehe Kapitel 
Password Entry
Page

NanoBrowse
r Table
Control
Editable
PPO Page
Jump

eD_TableControl_E
ditablePPO_PageJ
ump

PPO,
CON
TAIN
ER

PPO Enthält separate
Edit-Felder

Set Focus
Event-
Painter (On
Gain Focus)

EventP_SetFocus_
onGainFocus

X
and
Y
coor
dinat
es of
the
Even
t-
Paint
er

@F
OCU
S

Benutzen Sie
dieses Makro
um zu
definieren,
welcher Painter
als erstes
selektiert
werden soll.
Siehe Kapitel 
MicroBrowser
Specific Macros
.

Was ist eine 'Daten Quelle' oder 'Daten Ziel'?

Die meisten Makros schreiben eine Quelle in ein Ziel um eine geforderte Aktion
auszuführen. Die folgenden Datentypen sind möglich: STRING, PPO, CONTAINER,
HTML TAG, URL, FILE, TEQ INDEX

Was ist ein Event-Painter (EventP)?

Ein Event-Painter ist ein unsichtbarers Painterobjekt welches fähig ist, von
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spezifischen Events und Konditionen abhängige Aktionen auszuführen.
Folgende Events sind möglich:

Name Wann treten sie auf?

On Gain Focus: Anwender Jumps auf eine TEQ-View

On Lost Focus: Anwender verlässt eine TEQ-View

On Repaint: Jederzeit

On Mouse
Down:

Maus klick

Kontitionen:

Name Wann sind sie wahr?

On Timeout: Wert @MB_InactivityCounter ist höcher als X

Is Equal X ist gleich Y

20.2 Allgemeine Macro's

20.2.1 Animiertes GIF

Im S-Web Editor können animierte GIFs nicht direkt importiert werden. Es existieren
unterschiedliche zu einander inkompatible Formate für animierte GIFs. Statt dessen
können Sie das hier beschriebene Makro verwenden.Einzelne Bilder einer Animation
können separat als statische GIF-Dateien gespeichert werden. Das Makro lädt die
Bilder in einer über den GIF-Dateinamen vorgegeben Reihenfolge und zeigt so eine
Animation.
Jede GIF-Datei enthält am Ende des Dateinamens einen Index der die Reihenfolge
definiert.
Nachfolgend ein Beispiel (Index ab '0' beginnen):

myAni0.gif
myAni1.gif
...
myAniN.gif (ersetzten Sie 'N' mit der letzten Nummer)

Während der Anzeige des HMIs im Browser werden die GIFs in der definierten
Reihenfolge, jeweils eines pro Periode, angezeigt.
Das Makro wechselt zum Bild mit dem Index '0' wenn das letzte Bild der Animation
erreicht wurde und zeigt die Animation erneut.

Name: AnimatedGif_[EDITOR_VERSION].tlb

Schritt für Schritt
1. Importieren Sie das Makro durch Library->Get object from library...
2. Doppelklick auf das im TEQ eingefügte Makro und Auswahl des Reiters 'Cross Ref'
3. Nachfolgender Cross Ref Dialog erscheint (hier werden die Einstellungen für das

Makro vorgenommen):
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CONTAINER
"AnimatedIndexCO"

Enthält den Index des aktuell gezeigtes GIF Bildes.
Sie müssen den Container-Namen ändern, wenn Sie
mehr als ein „Animated GIF“ Makro im selben HMI
verwenden.
Sie können in diesem Fall den Container für den
Index mit einem Index ergänzen:
AnimatedIndexCO
AnimatedIndexCO1
...
AnimatedIndexCON

Beachten Sie, dass das Macro Objekt nicht
mehrmals mit dem selben Index Container in Ihrer
HMI verwendet wird.

CONTAINER
"AUTOINCRCO"

Nicht anpassen!

STRING "%" Nicht anpassen!

STRING "NbrImages" Ersetzen Sie „ NbrImages“ mit der Anzahl GIF-
Dateien.
myAni0.gif
myAni1.gif
...
myAni4.gif

Sie müssen z.B. „NbrImages“ mit „5“ ersetzen (Index
startet ab 0).

FILE
"Animated@CO_Animat
edIndexCo@.gif"

Der GIF-Dateinamen der mithilfe des Container
Offset definiert wird (siehe Kapitel Container Offset
Bitte ändern Sie den Teil des Dateinamens bis zum
ersten „@“.

Im Beispiel mit 'myAni0.gif' müsste der String so
definiert werden:
FILE "myAni@CO_AnimatedIndexCo@.gif"

Wenn Sie den Namen des Containers
'AnimatedIndexCO' geändert haben, müssen Sie
den Dateinamen auch hier anpassen. Ersetzen Sie
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den String zwischen den '@' Zeichen mit dem neuen
Namen Ihres Index Containers.

4. Bestätigen Sie ihre Änderungen und verlassen den 'Cross Ref' Dialog. Das
animierte gif sollte nun im Browser funktionieren.

20.2.2 Kopieren von Datenquellen

Die folgenden Makros können verwendet werden, um Datenquellen wie Container,
PPO's,  statische Strings oder HTML Tag's an eine Zieladresse zu kopieren.
Alle Makros werden über so genannte Event-Painter verarbeitet und deshalb für den
Benutzer des HMIs unsichtbar (nur im S-Web Editor sichtbar).

Makro Name Dateiname (add
'_5_13_40.esm')

Daten
quelle

Daten
ziel

Beschreibung/
Kommentar

Write Source To
Destination
Event-Painter
(On Lost Focus)

EventP_writeSrc2D
st_onLost

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data 'On
Lost Focus'

Write Source To
Destination
Event-Painter
(On Repaint)

EventP_writeSrc2D
st_onRepaint

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data 'On
Repaint'

Write Source To
Destination
Event-Painter
(On Gain Focus)

EventP_writeSrc2D
st_onGain

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data 'On
Gain Focus'

Write Source To
Destination
Event-Painter
(isEquall)

EventP_writeSrc2D
st_isEqual

STRING,
PPO,
CONTAINE
R, HTML
TAG

PPO,
CONTAI
NER

Writes the source
data to the
destination data if X
is equal to Y.
Where X and Y can
be STRING, PPO,
CONTAINER or
HTML TAG

Was ist ein Event-Panter (EventP)?
Ein Event-Painter ist ein unsichtbares Painterobjekt, welches fähig ist eine Aktion
aufgrund spezifischen Events oder definierten Konditionen auszuführen.

Die nachfolgend beschriebenen Ereignisse sind möglich:

Ereignisname Beschreibung

On Gain Focus: Benutzer gelangt auf TEQ-View

On Lost Focus: Benutzer verlässt TEQ-View

On Repaint: Jede Periode
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Schritt für Schritt
Der S-Web Editor bietet ein einfachen Weg um die Event-Painter Macros zu
konfigurieren.
Mit Doppelklicken öffnen Sie im importierten Macro den Konfigurations-Dialog.

Weitere Informationen finden Sie im Kapitel Working With Macros.
 

20.2.3 Passwort Einstiegsseite

Der S-Web Editor enthält verschiedene Makros um eine Passwort-Einstiegsseite für
Ihr HMI zu erstellen. Das Makro schreibt den Wert im Eingabefeld in eine Container-
Variable. Der Benutzer kann nur auf eine an andere Seite gelangen, wenn ein
korrektes Passwort eingegeben wurde. Das Makro ermöglicht es bis zu vier
Passwörter zu definieren. Der Mechanismus um mit bis zu vier Benutzerebenen
('userLevel') zu arbeiten, ermöglicht es, entsprechend der Privilegien, Objekte auf dem
HMI auszublenden und bzw. oder zu deaktivieren. Mit einem zusätzlichen Makro kann
zudem überprüft werden, ob der Anwender einen korrekten Benutzernamen
eingegeben hat (siehe unten aufgeführte Liste).

Makro Name
Dateiname (add
'_5_13_40.esm') Beschreibung

Password Dialog
Macro (User Level)

PasswordDialog_UserLev
el

Standart Einstiegsseite Makro
welches vier 'User Level' und
Passworte zur Verfügung stellt.

Password Dialog Auto PasswordDialog_UserLev Einstiegsseite Makro welches
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TEQ Jump Macro
(User Level,
Username and
Password)

el_Auto zusätzlich eine Kontrolle der 
Benutzernamen und einen
automatischen TEQ-View Jump
ausführt, wenn der Benutzer den
richtigen Benutzername sowie
Passwort eingegeben hat.

Logout Event-Painter
(On Timeout)

EventP_Logout_onTimeou
t

Führt nach einer bestimmten
inaktiven Zeit ein 'Logout' aus. Der
Logout Mechanismus setzt den 'user
level' auf '0' und führt ein TEQ-View
Jump zu einer Logout-TEQ-View
aus.

Schritt für Schritt

Der S-Web Editor bietet ein einfachen Weg um die Event-Painter Macros zu
konfigurieren.

Mit Doppelklicken öffnen Sie im importierten Macro den Konfigurations-Dialog.

Weitere Informationen finden Sie im Kapitel Working With Macros.

20.2.4 Auswahlliste

Eine DropDown Makro gibt dem Benutzer eine Auswahl verschiedener Einträge vor.
Der Benutzer wählt eine davon, die Auswahl schliesst danach automatisch und die
Combobox zeigt nur noch den ausgewählten Wert an.

Eine DropDown ist verknüpft mit zwei Datenquellen:

Eine PPO die den Index speichert und eine zweite Datenquelle mit der Liste der
verfügbaren Elementen. Enthält der Index den Wert '0', entspricht dies beispielsweise
dem ersten Element in der Liste ('1' entspricht dem zweiten Element, '2' dem dritten
usw.).

Sie können die Liste der Elemente entweder als 'Static String' direkt im 'Cross Ref'
Dialog eingeben oder als HTML-Tag. Diese kann in einer sprachabhängigen CSV-
Datei definiert werden. (Lesen Sie hierzu das Kapitel 'Mehrsprachige HMIs').

Macro Name Dateiname Datenquelle Datenziel

DropDown List DropDownList_5_13_40.
esm

STRING, HTML
TAG

PPO,
CONTAINER

Schritt für Schritt
Die Elementliste wird auf einer einzelnen Zeile mit '\n' (zwei Zeichen) als Trennzeichen
zwischen den Elementen eingegeben.
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Beispiel:
None\nMove1\nMove2\nMove3\nMove4\nMove5\nMove6

Vorgängig wurde ein '¢' als Terminierung (ASCII 162) verwendet. IMaster Java-Applet
und MicroBrowser sind nach wie vor zu dieser Schreibweise kompatibel.

Der S-Web Editor bietet ein einfachen Weg um die Event-Painter Macros zu
konfigurieren.
Mit Doppelklicken öffnen Sie im importierten Macro den Konfigurations-Dialog.

Weitere Informationen finden Sie im Kapitel Working With Macros.

20.2.5 Automatischer TEQ/URL Wechsel

Automatische TEQ/URL Macros werden verwendet, um bei einer bestimmten
Kondition oder einem eintreffenden Event ein TEQ/URL-Wechsel anzustossen. Für
den Anwender ist das Macro im Betrieb nicht sichtbar, da es mit Event-Painter
aufgebaut ist (nur im S-Web Editor sichtbar).

Folgende Events sind möglich:

Name Wann treten sie auf

On Gain Focus: Anwender wechselt auf eine TEQ-View

On Lost Focus: Anwender verlässt eine TEQ-View

On Repaint: Jede Periode

Konditionen:

Name Wann sind sie wahr?

Is Equal Wenn X gleich Y ist

\SaiaGeneral\URLJumps

Macro Name Dateiname (add
'_5_13_40.esm')

Datenque
lle

Datenzi
el

Beschreibung/
Kommentar

URL Jump Event-
Painter (On
Repaint)

EventP_URLJump_onRepa
int

STRING,
PPO,
CONTAIN
ER,
HTML
TAG

URL Führt ein URL
Jump On Repaint
aus.

URL Jump Event-
Painter
(isEqual)

EventP_URLJump_isEqual STRING,
PPO,
CONTAIN
ER,
HTML
TAG

URL Führt ein URL
Jump aus wenn X
gleich Y ist. X und
Y können
STRING, PPO,
CONTAINER oder
HTML TAG sein.
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URL Jump Event-
Painter
(On Timeout)

EventP_URLJump_onTime
out

STRING,
PPO,
CONTAIN
ER

URL Führt ein URL
Jump nach einer
gewissen
inaktiven Zeit des
Anwenders aus.

\SaiaGeneral\ViewJumps

Macro Name Dateiname (add
'_5_13_40.esm')

Datenqu
elle

Datenzie
l

Beschreibung/
Kommentar

View Jump
Event-Painter (On
Repaint)

EventP_ViewJump_onRe
paint

STRING,
PPO,
CONTAI
NER,
HTML
TAG

TEQ
INDEX

Führt ein TEQ-View
Jump On Repaint
aus

View Jump
Event-Painter
(isEqual)

EventP_ViewJump_isEq
ual

STRING,
PPO,
CONTAI
NER,
HTML
TAG

TEQ
INDEX

Führt ein TEQ-View
Jump aus, wenn X
gleich Y ist. X und Y
können STRING,
PPO, CONTAINER
oder HTML TAG
sein.

View Jump
Event-Painter
(On Timeout)

EventP_ViewJump_onTi
meout

STRING,
PPO,
CONTAI
NER,
HTML
TAG

TEQ
INDEX

Führt ein TEQ-View
Jump nach einer
gewissen inaktiven
Zeit des Anwenders
aus.

Schritt für Schritt
Der S-Web Editor bietet ein einfachen Weg um die Event-Painter Macros zu
konfigurieren.

Mit Doppelklicken öffnen Sie im importierten Macro den Konfigurations-Dialog.

Weitere Informationen finden Sie im Kapitel Working With Macros.

20.2.6 Tabellen

Das Makro besteht aus einzeln angeordneten Eingabefelder als Tabelle. Jedes der
Felder zeigt auf eine PPO, die gelesen und geändert werden kann. Im 'Table Control'
kann seitenweise über Auf-/Ab-Buttons gescrollt werden (Zeilenscrollen wird nicht
unterstützt). 

Das Makro basiert auf einem Adressmechanismus mit Indexierung. Der Index 'listOff'
gibt den 'Offset', die Seite auf der sich der Benutzer befindet, vor. Eine Zeile innerhalb
der Tabelle entspricht einem Array, welches mit einer speziellen PPO Basis Adresse
beginnt. 'listOff' wird jeweils an diese Basisadresse angefügt, um die tatsächliche
Adresse zu ermitteln. Diese Basisadresse wird im S-Web Editor in jedem Eingabefeld
eingetragen.

Die Tabelle kann beliebig verändert und erweitert werden. Die bereits im Makro
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definierten Zeilen, zeigen beispielhaft ein Schema, für eine mögliche Adressierung.
Selektieren Sie jeweils eine ganze Zeile, um die Basis Adresse danach über 'Cross
Ref' anpassen zu können.Sie können die einzelnen PPOs einzeln anpassen oder
'Suchen/Ersetzen' verwenden (siehe 'CrossRef' Dialog). Geben Sie nur den Teil des
PPO Namens an, den Sie für alle Felder ändern wollen und geben eine neue Adresse
an. Wenn Sie zum Beispiel die Reihe 'PDP,,R100x,d' mit einem symbolischen Array
myVar[x] tauschen wollen, tun Sie es folgendermassen:

1. Selektieren Sie die ganze Reihe und öffnen Sie den 'Cross Ref' Dialog (rechte
Maustaste Menu). Wählen Sie den 'Cross Ref' Reiter.

2. Drücken Sie 'Suchen/Ersetzen' und genben Sie 'PDP,,R100' in das Feld 'Suchen'
sowie 'myVar[' in das Feld 'Ersetzen' ein. Drücken Sie 'OK'. Geben Sie
anschliessend ',d' in das Feld 'Suchen' sowie ']' in das Feld 'Ersetzen' ein. Drücken
Sie 'OK'.

Wenn Sie dieses Makro mehrmals im selben HMI verwenden, müssen Sie die Offset
Container Variable ändern, damit die Tabellen unabhängig voneinander funktionieren
können.

Name: TableControl_EditablePPO_PageJump_[EDITOR_VERSION].tlb

Schritt für Schritt
1. Importieren Sie das Makro: Library->Get object from library...
2. Gruppierung aufheben
3. Ändern Sie die die Eingabefelder einzeln oder über den 'Cross Ref' Dialog
4. In der Auf und Ab-Buttons: Ändern Sie die Inkrement-/Dekrement-Wert

entsprechend der Anzahl vorhandener Zeilen.
5. Im Seite nach unten Button ändern Sie die 'Painter ausblenden/deaktivieren'

Einstellungen. Es wird so verhindert, dass gescrollt zu weit gescrollt werden kann.
6. Entfernen Sie zum Schluss den grau eingefärbten Kommentartext

20.2.7 Blinker

Das Makro zeigt in jeder Periode abwechselnd eine der beiden definierten Farben an.
Machen Sie einen Doppelklick auf das eingefügte Makro und klicken Sie auf den
Eintrag "Rectangle Repaint". In der Registerkarte 'Border Advanced ' können die
beiden Farben angegeben werden.
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Name: Blinker_[VERSION_NUMBER].tlb

Schritt für Schritt
1. Importieren Sie das Makro: Library->Get object from library...
2. Doppelklick auf Makrobibliothek
3. Reiter 'Erweiterte Selektion'
4. Doppelklick Eintrag 'Rectangle Repaint'
5. Reiter 'Rahmen Erweitert'
6. Definieren Sie die gewünschten Farben

20.2.8 MicroBrowserspezifisch

Dieses Kapitel beschreibt Makros, welche nur vom MicroBrowser Client unterstützt
werden. Dies bedeutet, die Makros verwenden spezielle Container Variablen.
Sie finden die Makros unter dem Pfad 'General/MicroBrowser' in der Makrobibliothek.

Focus 'On Gain Focus' setzen

Platzieren Sie dieses Makro über das Painterobjekt, den Sie als erstes selektiert
haben wollen, wenn die TEQ-View geladen wurde (z.B. hilfreich wenn eine 'Nächste
Seite'-Taste eingesetzt wird).
Das Makro teilt MicroBrowser seine X-/Y-Koordinaten mit und dieser selektiert das
Objekt, welches darunter liegt.

\SaiaGeneral\MicroBrowser

Makro Name
Dateiname (add
'_5_13_40.esm') Datenquelle

Datenzie
l

Set Focus Event-
Painter (On Gain
Focus)

EventP_SetFocus_onGai
nFocus

X and Y Koordinaten
des Event-Painter

@FOCU
S

Schritt für Schritt
1. Macro importieren

2. Platzieren Sie dieses Makro über das Painterobjekt, den Sie als erstes selektiert
haben wollen.

20.3 Trend Macros

20.3.1 Einleitung

Einleitung
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Welche Arten von Trend Makros gibt es?

Jeder dieser drei Gruppen (Offline, Offline Saved, Online) enthält verschiedene Makro
Varianten die in Komplexität und Funktionswiese variieren können.

Online Trend im Browser

Der einfachste Weg ist, einen Prozesspunkt in Echtzeit im Browser Client zu
überwachen. Die zugehörige Trendkurve wird in diesem Fall fortlaufend aktualisiert.
Verlässt der Benutzer das HMI, werden keine Daten mehr aufgezeichnet. Dieses
Prinzip liegt den 'Online Trend' Makros zu Grunde.

PCD RAM Basiertes Trending (für kleine Datenmengen)

Vom Trending Service der Steuerung aufgezeichnete Daten können mit 'Offline Trend'
Makros verarbeitet werden. Der Benutzer kann auf die Steuerung wann immer er will
zugreifen und sich die Trendkurven, welche durch die Steuerung aufgezeichnet
wurden darstellen. Das Aufzeichnen dieser Daten auf die Steuerung kann jedoch zu
einer Begrenzung der Daten-Bandbreite führen. Der Anwender hat jedoch die
Möglichkeit, eine Aufzeichnungsweise zu wählen, welcher nur ein Teil in der
Steuerung gespeicherten Daten lädt. Alle diese Daten werden lokal gespeichert. Der
Anwender kann in den geladenen Daten zoomen und navigieren. Zudem ist es
jederzeit möglich, zusätzliche Daten zu laden. Die bereits gespeicherten Daten gehen
nicht verloren.
Die PCD behält die Daten des Offline Trend Makros im RAM. Wenn Sie diese Makros
brauchen, werden Sie sehr limitiert sein, in wie viele Trenddaten sie verwalten können.
Möchten Sie über eine längere Zeit Daten aufzeichnen, ist das folgende Makro
empfehlenswert.

PCD Flash Basiertes Trending (für grosse Datenmengen)

HDLog Trend Makros sind fähig grosse Datenmengen zu verarbeiten. Dies ist möglich
weil mit dem neuen Konzept die Trenddaten in den Flash Speicher der PCD und nicht
im RAM (wie bei 'Offline Trend Makros') gespeichert werden. Weitere Informationen
finden Sie im Kapitel 'PCD Flash Based trending'.

Ansicht Trend Logfiles

Es ist möglich, Trenddaten in einer Datei auf Seite des Browser Clients abzulegen. Die
Aufzeichnung kann so auf einem lokalen Datenträger abgelegt werden. Die Dateien
liegen im CSV Format vor und können mit Programmen wie z.B. Excel analysiert
werden.
Diese Dateien können auch mit 'Offline Saved Trend' Makros geladen werden.. Offline
Saved Trend Makros benötigen keine Verbindung zur Steuerung und können
vollständig beim Client liegen.

Maximale Anzahl Trends Pro Makro

Beim Offline Trending ist die Konfiguration des Trend Makros in einem String mit einer
max. Grösse von 2 KB gespeichert.
Die Grösse einer Trendkurve entspricht 90 Bytes + Länge des Trendnames.
Beispiel: Wenn Ihr Trend Name 10 Charakter lang ist:
2000 Bytes / (90 Byte + 10 Byte) = 20 Trends

Mit HDLog Trend Makros können maximal 10 Trendkurven verarbeitet werden.



106

Saia-Burgess Controls AG Erweiterte Funktionen

Trend Macros

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

20.3.2 PCD Flash basierendes Trending

HDLog Trend Makros

HDLog Trend Makros sind fähig grosse Datenmengen zu verarbeiten. Dies ist möglich
weil mit dem neuen Konzept die Trenddaten in den Flash Speicher der PCD und nicht
im RAM (wie bei 'Offline Trend Makros') gespeichert werden.
Im Vergleich zu den Offline Trend Makros gibt es einen Unterschied wie der Browser
mit der PCD kommuniziert. Mit HDLog Trend Makros werden die Trenddaten in
Dateien abgelegt. Somit brauchen HDLog Makros keine CGI Befehle um Daten von
der PCD zu erhalten.

Benutzung des HDLog Trend Makros im Editor

Als Erstes müssen Sie die HDLog HDF-Dateien im Projekt Konfigurator erstellen.

Wählen Sie Project-> Project configurations... und fügen Sie Ihre HDLog Dateien mit
'Add' hinzu:

(PG5 erstellt diese HDF Dateien. Siehe PG5 Manual)

Bestätigen Sie mit 'OK' und importieren Sie das folgende Makro:

\SaiaHDLogTrendMacro
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Makro Name Dateiname (add '_5_13_40.esm')

HDLog Trend
Macro
(Complete)

RemoteOffSavedTrdComplete

S-Web Editor bietet einen einfachen Dialog um die HDLog Trend Makros zu
definieren.

Öffen Sie diesen Dialog mit einem Doppelklick auf das importierte Makro:

Displayed Time Definiert den dargestellten Zeitbereich

Stored Time Maximale Datenmenge im RAM

Show Grid Raster während Betrieb anzeigen?

Automatic Y... Automatische Y-Achse Beschreibung?

Add Eine Trendkurve hinzufügen

Insert Fügt eine Trendkurve oberhalb der markierten Zeile ein.

Remove Löscht die markierte Trendkurve

Wenn Sie 'Add' oder 'Insert' klicken, sehen Sie eine Liste mit allen verfügbaren
Trendkurven. Diese ist abhängig der HDLog Datei:
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Für mehr Details zum Thema Macros siehe Kapitel Working With Macros.

Benutzung des HDLog Trend Makros zur Laufzeit

Das Arbeiten mit HDLog Trend Makros ist sehr einfach und ähnlich zu anderen Trend
Makros.

Mit Zoom und Scroll kann die Darstellung Ihren eigenen Wünschen angepasst
werden. Dies kann dazu führen, dass der Client neue Trenddaten aus der PCD
lädt.
Clear Logs löscht die dargestellten Trenddaten behält sie jedoch im RAM (nicht
im PCD Flash).
Save Logs to file: Speichern Sie darurch die Trenddaten in eine Datei auf Ihrem
lokalen Laufwerk.
Stop Load Data: Unterbrechen Sie den Ladeprozess der neuen Trenddaten
Reload Last: Laden Sie die neuste Trenddatei von Ihrer PCD

Wenn die TEQ-View mit der HDLog Trend Makro geöffnet wird, wird als Standart
Zeitachse wird ein Bereich von 10 Stunden angezeigt (siehe im Konfigurations-Dialog
'Displayed Time [s]'), wie im Screenshot unten dargestellt
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Mit Zoom und Scroll kann die Darstellung angepasst werden. Zusätzlich kann jeder
Trendkurve eine eigene Farbe zugeordnet werden

Variationen Der HDLog Trend Makros

Die Bibliothek enthält zwei modifizierbare HDLog Trend Makros:

Makro Name Dateiname (add '_5_14_23.esm')

HDLog Trend Macro (Scalable) RemoteOffSavedTrdScalable

HDLog Trend Macro (Minimal) RemoteOffSavedTrdMini

 
Das skalierbare HDLog Makro zeigt alle zehn Linien der konfigurierbaren
Trendkurven, sodass während Laufzeit kein scrolling nötig ist. Sollte der Benutzer
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weniger als zehn Trendkurven anzeigen wollen, kann er die nicht benötigten Kurven
löschen.
Das Minimal Makro hat keine Optionen um während Laufzeit Trends zu modifizieren.
Jeder Trend, welcher im S-Web Editor definiert wurde, wird geladen und dargestellt.

20.3.3 PCD RAM basierendes Trending

20.3.3.1 Einleitung

Einleitung

Dieses Kapitel gibt einen Überblick über die Offline Trend Makros. Einzelheiten zu den
verschiedenen Online Trend Varianten sind in separaten Kapiteln beschrieben.

1. Offline Trend Complete

2. Offline Trend Minimal

3. Offline Trend Scalable

Offline Trend Painterobjekt sind Makroobjekte und können über Library->Get object
from library... in eine TEQ-View importiert werden. Offline Trends können historisch
aufgezeichnete Trenddaten von einer Saia®PCD laden und als Trendkurven
darstellen. Die PCD zeichnet die Daten mit der HDLog FBox auf. Die Bibliothek der
HDLog FBoxen werden unterstützt durch den S-Web Editor und können in das
Verzeichnis PG5&/Libs/usr FBox installiert oder kopiert werden. Um historische Daten
aufzuzeichnen, müssen die FBoxen in einem PG5 Fupla Projekt vorhanden sein. Die
dazu zwingenden Einstellungen werden in den "FBox adjust" Einstellungen gemacht.
Die PG5 Symbole der Trending Datenblocks sind im S-Web Editor nur verfügbar,
wenn im PG5 Projekt die HDLog FBoxen vorhanden sind. Für weitere Details,
informieren Sie sich bitte in der Online Hilfe der FBox.

Benutzung von Offline Trend Makros im Editor

Trend Makros bestehen aus einzelnen Paintern, die zu einem Makroobjekt gruppiert
sind. Der Benutzer kann die Gruppierung aufheben und einzeln auf die Painterobjekte
zugreifen. Die meisten dieser Objekte können nicht über den Dialog 'Painter
Eigenschaften' verändert werden.

Die Referenzen werden über den CrossRef Dialog angepasst. Aufgrund der eher
komplexen Funktionswiese wird dies aber nicht empfohlen. Grösse und Position jedes
Painters können jedoch einfach angepasst werden.

Die einzelnen Objekte des Trend Makros kommunizieren über spezielle Container
Variablen miteinander. Die Namen dieser Container werden beim Import des Makros
in die TEQ-View um einen eindeutigen Index erweitert. Dies ist notwendig um eine
eindeutige Instanz des Makros zu erstellen. Die Namen dieser Container können so
aussehen: '

@MACRO_NewYMax.122345676788990'. 

Der Benutzer darf diese Variablen nicht verändern, da sie automatisch vom S-Web
Editor generiert und verändert werden. Wenn Sie ein verändertes Makro wieder in die
Bibliothek einfügen wollen, wird dieser Index automatisch wieder entfernt. Sie müssen
sich also nicht um diese Indizes kümmern.
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Einfügen eines Online Trend Makros in eine TEQ-View

1. Erstellen Sie eine neue TEQ-View: Projekt->Zum Projekt hinzufügen->Neu

2. Wählen Sie Library->Get object from library...

3. Wechseln Sie in das 'MacroLib' Verzeichnis. Wählen Sie den Dateinamen des
gewünschten Offline Trend Makros:

Offline Trend Complete: "OfflineTrendComplete.tlb"
Offline Trend Minimal: "OfflineTrendMinimal.tlb"
Offline Trend Scalable: "OfflineTrendScalable.tlb"

Das gewählte Offline Trend Complete Makro:

Offline Trend Minimal:
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Skalierbarer Offline Trend:

Konfigurieren des Makros

Dieser Abschnitt beschreibt, wie die Offline Trend Makros konfiguriert werden
müssen. Das Grundprinzip ist bei allen Varianten das selbe.
1. Doppelklick auf das Makro um den 'Cross Ref' Dialog zu öffnen.
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2. Wählen Sie den Eintrag '.._Macro Offline Trend_Repaint:_@MACROOFTActive....'
im Reiter 'Erweiterte Selektion.
Alternativ ist es möglich, die Gruppierung zuerst aufzuheben und danach das
Painterobjekt, das die Trendkurven anzeigt, doppelt anzuklicken.

3. Gehen Sie zum Reiter 'Macro Offline Trend'
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4. Drücken Sie "Select" um ein PG5 Symbol (z.B.. Trend_Base_DB) zu wählen. Der
The basic data block contains basic information (e.g. data base size, number of
trends, &) for all trend curves of the HDLog data base.
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5. Confirm your choice with "OK"

6. Nun sollten die Trendkurven ausgewählt werden. Klicken Sie dazu "Select".

7. Wählen Sie ein PPO and klicken Sie "OK". Diese Variabel MUSS die Daten
Strukture enthalten, welche in den Trend FBoxen definiert ist. Die Trend PPO's
enthalten die Informationen und Daten einer Trendkurve.

8. Definieren Sie den PPO-Namen, Y-Min, Y-Max und Farbe.

9. Klicken Sie "Add" um eine Kurve hinzuzufügen.

10.Wiederholen Sie die Schritte 9 bis 12 für alle Trendkurven die Sie anzeigen wollen
11.
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Um eine Trendkurve zu ändern, wählen Sie zuerst den Eintrag aus der Liste, führen
die Änderung durch und bestätigen mit 'Update'.

Raster anzeigen (Optional)

Diese Option fügt dem Trend Makro ein Raster mit 10x10 Pixel Auflösung hinzu. Sie
finden die zu aktivierende Checkbox im 'Macro Online Trend' Reiter:

1. Doppelklick auf das eingefügte Makro

2. Den Eintrag '.._Macro Offline Trend_Repaint:_@MACROOFTActive.... ' im Reiter
'Erweiterte Selektion' wählen.

3. Checkbox 'Raster anzeigen' aktivieren.

4. Verlassen Sie den Dialog mit 'OK', um die Änderung zu bestätigen.

Automatische Y-Achsenbeschriftung (Optional)
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'Automatische Y-Achsenbeschriftung' erzeugt für jede Trendkurve eine Y-
Achsenbeschriftung. Die Beschriftung beginnt mit 'Y Min' und reicht bis 'Y Max'.
Bei zwei Kurven würde eine Beschriftung am linken, die zweite am rechten Rand
gezeichnet (siehe Abbildung). Die Schriftfarbe entspricht der Farbe, die im Makro
konfiguriert wurde.
Die automatische Beschreibung zur Laufzeit:

1. Doppelklick auf das eingefügte Makro

2. Den Eintrag '.._Macro Offline Trend_Repaint:_@MACROOFTActive....' im Reiter
'Erweiterte Selektion' wählen.

3. Checkbox 'Automatische Y-Achsenbeschriftung' aktivieren.

4. Verlassen Sie den Dialog mit 'OK', um die Änderung zu bestätigen.

Zeichenlänge und Format der Y-Achsenbeschriftung

Bitte beachten Sie Formatierung und Zeichenlänge der Y-Achsenbeschriftung. Die
Beschriftung kann zu lang sein und damit die benachbarte Beschriftung überlappen.

Sie können die Formatierung der Skala und deren Schrift anpassen.

Beispiele für Anpassungen der Formatierung:
Ist '0.1' als Y Min und '1.234' als Y Max definiert, haben alle Werte drei
Nachkommastellen.
Werte mit mehr als drei Nachkommastellen werden in diesem Fall abgeschnitten.

Eine weitere Variante ist es, Y Min und Y Max in Exponentialschreibweise zu
definieren. Die gesamte Skala wird danach in Exponentialschreibweise dargestellt.
Im vorliegenden Beispiel konnte mit dieser Notation die Textlänge aller Werte von 7
auf 4 reduziert werden ('100000' wurde zu '1E6')

'-1e1' wurde als Y Min und '1E6' als Y Max angegeben.
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Die Formatierung kann bei Y Min und Y Max im Editor oder direkt zur Laufzeit in den Y
Min und Y Max Eingabefeldern festgelegt werden.

Projekt vorbereiten

1. Wählen Sie Project-> Init PPOs und klicken Sie "OK".

2. Anschliessend Project->Generate HTML...
3. Wählen Sie File->Save All...

4. Laden Sie das HMI Projekt per FTP auf Ihre Steuerung.

Benutzung des Offline Trend Makros zur Laufzeit

Dieser Abschnitt beschreibt die Benutzung der Offline Trend Makros zur Laufzeit.
Unterschiede und Einzelheiten zu den verschiedenen Makrovarianten finden Sie in
separaten Kapiteln.

Zoom- und Scroll-Buttons

Nachdem Ladevorgang werden die Trendkurven angezeigt. Sie können jetzt auf der
Zeitleiste navigieren:
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Speichern Sie die Trendkurven auf einer lokalen Disk

Es ist möglich, die aufgezeichneten Daten lokal auf dem Rechner des Browser-Clients
zu speichern. Die Trendkurven werden in Form von CSV-Dateien abgelegt. Java
Applets haben einen nur eingeschränkten Zugriff auf Ressourcen des Computers.

Bei Microsoft Virtual Machine und Sun VM, müssen Sie Sicherheitseinstellungen
anpassen, damit das Applet Daten lokal speichern kann.
Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

Um das "Logfile" zu speichern, klicken Sie "Save Logs to file":
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Clear Logs

Bereits geladene Trendpunkte werden bei mehrmaligem Laden überschrieben. Neue
Trendpunkte werden hinzugefügt. Verwenden Sie 'Clear Logs', um alle Trenddaten im
Browser Client zu löschen.

20.3.3.2 Offline Trend komplet

Bitte lesen Sie das Kapitel 'Offline Trend Überblick' für allgemeine Informationen zu
Offline Trends.

Benutzung des Offline Trend Complete Makros zur Laufzeit

Overview

This section explains how the offline trend macro will be used at runtime. The browser
will show a view like this:
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Start Load Data Starten Sie den Ladevorgang der Trenddaten

Load Infos Laden Sie Informationen zu den aktiven Trendkurven, bevor Sie
diese laden.

start date/time Ab welcher Uhrzeit bzw. Datum beginnt das sichtbare
Zeitfenster?

end date/time Bei welcher Uhrzeit bzw. Datum endet das sichtbare Zeitfenster?

zoom buttons Zeitfenster verkleinern oder vergrössern

scroll buttons Scrolle auf Zeitachse vorwärts bzw. rückwärts

activated PPO's
trends

Liste aller aktiven Prozesspunkte
PPO
Name:

PPO Name des aktiven PPOs

RGB: Rot-Grün-Blau Farbwert der Trendkurve

Min/Max:
Definiert Maximum und Minimum der Y-Achse für den
jeweiligen Trend.

Update:
Um Einstellungen, wie z.B. Min/Max oder RGB Wert
zu übernehmen.

Add: Prozesspunkt zu der Liste aktiver PPOs hinzufügen.
Remove: Prozesspunkt von der Liste aktiver PPOs entfernen.

available PPO's
trends

Liste der verfügbaren Prozesspunkte. Währen Laufzeit können
neue Trendkurven mit der "New" Taste hinzugefügt werden.

Clear Logs Löscht die Trenddaten des Browser Client

Save Logs to
file

Speichert die geladenen Trenddaten auf Seite des Clients in
einer Datei.

Curve info Curve Info zeigt Informationen über aller Trendkurven bei einem
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bestimmten Zeitpunkt.

Trendkurve hinzufügen

Wählen Sie einen Eintrag aus der Liste der verfügbaren PPOs:

Fügen Sie mit 'Add' die selektierte Liste hinzu:

Wählen Sie 'Load Infos' um die Anzahl verfügbarer Punkte zu ermitteln. Die
Trendpunkte jeder aktiven Kurve werden zu dieser Anzahl addiert. Der Benutzer kann
so abschätzen, wie lange das Laden dauern wird. Diese Funktionalität ist nützlich,
wenn etwa nur eine langsame Modemverbindung zur Steuerung besteht.
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Wählen Sie eine PPO Liste um die Details zu dessen Trendkurve zu sehen und
editieren Sie nötigenfalls die Angaben.
Weil die Trendkurven "Event" getrieben sind, ist es nicht möglich die Start- und
Stoppzeit und das Datum zu kennen, bevor alle Trends geladen sind. Der
Ladevorgang kann auf verschiedene Weise erfolgen. Wenn die ausgewählte
Trendkurve nicht die gewünschte Periode bedeckt, kann der Benutzer die Position des
Pointers modifizieren. Die Daten, welche während einer zweiten Phase geladen
werden, werden zu den bereits vorhandenen Daten hinzugefügt. 

Optional: Über die Eingabefelder links vom 'Update' Button lässt sich Start und Ende
des zu ladenden Zeitfensters festlegen. Nehmen Sie diese Einstellung vor nachdem
Sie auf 'Load Infos' geklickt haben. Zudem können Min/Max sowie RGB Farbwert
definiert werden. Bestätigen Sie alle Eingaben mit 'ENTER' und anschliessendem
Klick auf 'Update', um die Änderungen auf die Trendkurve anzuwenden.
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'Start Load Data' leitet den Ladevorgang ein. Falls dies zu viel Zeit in Anspruch nimmt,
kann der Vorgang abgebrochen werden. Bereits geladene Daten werden so
verworfen.

Nachdem Ladevorgang werden die Trendkurven dargestellt. Mit den Scroll- und Zoom
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Tasten kann navigiert werden:

Curve Info
Curve Info zeigt Informationen über alle Trendkurven an einem bestimmten Zeitpunkt.

Klicken Sie am gewünschten Ort in der Trend-Zeitachse. Der gewählte Punkt wird als
grüne Linie markiert.
Der erste Eintrag zeigt den definierten Zeitpunkt. Die Liste zeigt Details jeder
Trendkurve über den Trendpunkt, der sich dem definierten Zeitpunkt am nächsten
befindet.

Das unten aufgeführte Bild zeigt ein skalierbarer Offline Trend Painterobjekt (gilt
ebenfalls für das Offline Trend Complete Makro):
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20.3.3.3 Offline Trend scalierbar

Siehe Offline Trend Overview für allgemeine Informationen über Offline Trend Makros.

Benutzung der "Offline Trend Skalierung" im Editor

Das "Offline Trend Scalable" Makro-Objekt Anpassen

1. Das Marko enthält einige kursiv geschriebene Kommentarfelder welche gelöscht
werden sollten. Heben Sie die Gruppierung der Objekte auf, selektieren Sie die
Kommentarfelder und löschen Sie diese. Nun sehen Sie das leere Makro.

Das Makro enthält einige Event Painters, welche sich unter anderen Objekten
befinden ("EventP"). Wenn Sie einige Painterobjekte verschieben, werden Sie diese
speziellen Painterobjekte sehen. Diese EventP Objekte dürfen nicht gelöscht
werden, da sie zur Marko Funktionalität dienen. Im Betrieb sind die Event Painters
nicht ersichtlich.

2. Die "Curve Min/Max" und "Curve info" Bereiche sind optional (können gelöscht
werden). Diese werden nicht benötigt, bieten jedoch dem Anwender zusätzliche
Funktionalitäten.
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Dieses Edit-Feld bietet Ihnen die Möglichkeit, der Y-min. und
max. Bereich ihrer Kurven im Betrieb zu verändern.

Im Betrieb kann der Anwender ein Punkt in der Y-Achse
selektieren. Diese "Curve info"-Liste wird Details über
Kurvenpunkte, welche sich in der Nähe befinden anzeigen.
Siehe "Benutzung der Offline Trend Skalierung zur Laufzeit"
weiter unten für Details.

Das Makro enthält ein Painterobjekt für zwei Varianten. Sie können die "A-Variante"
oder die einfachere "B-Variante" brauchen.
Führen Sie nun die Schritte "Offline Trend Scalable A-Variant" oder "Offline Trend
Scalable B-Variant" aus.

Offline Trend Scalable A-Variante

Löschen Sie keine Objekte ausserhalb dieses Bereichs ausser die Painterobjekte in
den optionalen Bereichen und die Kommentarfelder.
1. Lösen Sie die Gruppierung das Offline Trend Makros auf.

2. Selektieren Sie alle Objekte im Bereich "B-Variant" und löschen Sie diese.

Sie können unbehindert alle Objekte frei positionieren und die jeweilige Grösse
bestimmen.

Offline Trend Scalable B-Variante

Löschen Sie keine Objekte ausserhalb dieses Bereichs ausser die Painterobjekte in
den optionalen Bereichen und die Kommentarfelder.

1. Lösen Sie die Gruppierung das Offline Trend Makros auf.

2. Selektieren Sie alle Objekte im Bereich "A-Variant" und löschen Sie diese.

Sie können unbehindert alle Objekte frei positionieren und die jeweilige Grösse
bestimmen.



128

Saia-Burgess Controls AG Erweiterte Funktionen

Trend Macros

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

Curve Min/Max (Optional)

Dieses Edit-Feld bietet Ihnen die Möglichkeit, der Y-
min. und max. Bereich ihrer Kurven im Betrieb zu
verändern.
 

1. Wählen Sie die Edit Box für die erste Kurve.

2. Öffnen Sie den 'Cross Ref' Dialog und gehen Sie zum Ritter 'General'.

3. Ändern Sie die Farbe zu derjenigen ihrer entsprechenden Kurve (die Kurvenfarbe
kann im Makro Offline Trend Dialog verändert werden).
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Sie werden diese Farbe nur im Betrieb sehen. Die Standardfarbe ist Schwarz.

4. Wiederholen Sie die Schritte 1-3 für alle Trendkurven.

5. Wenn Sie nur zwei Trendkurven haben, können Sie die andere Edit Box löschen.

Projekt Vorbereiten

1. Wählen Sie Project-> Init PPOs und klicken Sie "OK". (Die zugefügten PPO's
werden initialisiert)

2. Wenn Sie eine neue TEQ-View erstellen, wählen Sie Project -> Generate HTML...

3. File->Save All... wählen

4. Kompilieren and und laden Sie das Projekt auf ihre Steuerung.

Erstellen Ihres Eigenen Offline Trend Makro

Wenn Sie Ihre modifizierte Makro Objekte in weiteren Projekten verwenden möchten,
können Sie alle Objekte als ein neues Makro exportieren:

1. Selektieren Sie alle Objekte, welche zum eigenen Makro hinzugefügt werden sollen
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2. Gruppieren Sie die Objekte mit:

3. Wählen Sie Library-> Insert object Into library

4. Speichern Sie das erstellte Makro unter einem neuen Namen

Benutzung der Offline Trend Skalierung zur Laufzeit

Dieser Abschnitt beschreibt wie das Offline Trend Makro im Betrieb angewandt wird.

Erste Schritte
"B-Variante" mit optionaler "Curve info" und "Curve Min/Max":

1. Klicken Sie "Load Infos" um zu sehen, wieviele Trendkurven verfügbar sind. Wenn
Sie die "A-Variante" einsetzen, gehen Sie direkt zum Schritt 3 weil keine "Load
Infos" verfügbar sind. In der "A-Variante" ist es ebenfalls möglich, eine bestimmte
Anzahl Kurvenpunkte zu laden, aber Sie können nicht sehen, wieviele Punkte
vorhanden sind.

2. Wählen Sie den Wert "ALL" wenn Sie alle verfügbaren Punkte sehen wollen oder
tippen Sie eine gewünschte Nummer (z.B. 4000) ein:

3. Klicken Sie "Start Load Data". Die Trendkurven werden nun geladen. Sollte der
Ladevorgang eine zu lange Zeit in Anspruch nehmen, können Sie den Vorgang mit
"Stop Load Data" stoppen und eine tiefere Anzahl Punkte wählen.
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4. Benutzen Sie die 'scroll' and 'zoom' Funktionen wenn der Trend wie im Bild unten
dargestellt wird:

Curve Min/Max

Mit den Objekten im optionalen Bereich "Curve Min/Max" ist es möglich, der minimale
und maximale Wert für jede Kurve im Betrieb einzustellen:
1. Verändern Sie "Min" oder "Max" eines Trends

2. Um zu Aktualisieren, klicken Sie "Y Range Update"

Wie Sie sehen wird die automatische Beschreibung ebenfalls aktualisiert.

Curve Info

Die "Curve Info" Liste zeigt Details über die Trendkurve (Timestamp).
Sobald Sie irgendwo in den Trend klicken, wird der gewählte Bereich mit einer grünen
Linie markiert. Die erste Linie (grün) in der Liste entspricht dem selektierten Punkt des
Anwenders. Die Liste stellt ebenfalls Details angrenzender Punkte dar (nur in
Vergangenheit).
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20.3.3.4 Offline Trend minimal

Bitte lesen Sie das Kapitel 'Offline Trend Überblick' für allgemeine Informationen zu
Offline Trends.

Benutzung des Offline Trend Minimal Makros zur Laufzeit

Dieser Abschnitt erläutert wie das Offline Trend Minimal Macro zur Laufzeit betrieben
wird. .

Erste Schritte

Das Offline Trend Minimal Makro:

1. Wählen Sie "Load Infos&Datas", um die Trenddaten von der Steuerung zu laden.

2. Sie können den Wert 'ALL' ändern, falls Sie verhindern wollen, dass alle
Trendpunkte geladen werden (Anzahl gewünschter Trendpunkte eingeben)
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3. Die Trenddaten werden geladen. Sie können mit 'Stop Load Data' abbrechen, falls
der Vorgang zu lange dauert und eine kleinere Anzahl Trendpunkte eingeben.

4. Verwenden Sie die Scroll- und Zoom Buttons um auf der Zeitachse zu navigieren.

20.3.4 Online Trending

20.3.4.1 Einleitung

Einleitung

Dieses Kapitel gibt einen Überblick über die Online Trend Makros. Einzelheiten zu den
verschiedenen Online Trend Varianten sind in separaten Kapiteln beschrieben.

1. Online Trend Minimal

2. Online Trend Scalable
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3. Online Trend Complete
4.
Online Trend Painterobjekte sind Makroobjekte und können über Makrobibliothek-
>Objekt aus Makrobibliothek laden... in eine TEQ-View importiert werden. Online Trend
Painterobjekte zeichnen zur Laufzeit Trendkurven auf, zeigen Sie an und speichern
diese im Browser Client. Als Datenquellen dienen gewöhnliche Prozesspunkte. Die
maximale Anzahl aufgezeichneter Werte wird im Makroobjekt konfiguriert.
Überschreitet die Anzahl Werte dieses Maximum, werden die ältesten Werte
überschrieben. Beim Verlassen des HMI wird die Aufzeichnung gelöscht.

Benutzung der Online Trend Makros im Editor

Trend Makros bestehen aus einzelnen Paintern, die zu einem Makroobjekt gruppiert
sind. Der Benutzer kann die Gruppierung aufheben und einzeln auf die Painterobjekte
zugreifen. Die meisten dieser Objekte können nicht über den Dialog 'Painter
Eigenschaften' verändert werden.

Die Referenzen werden über den CrossRef Dialog angepasst werden. Aufgrund der
eher komplexen Funktionswiese wird dies aber nicht empfohlen. Grösse und Position
jedes Painters können einfach angepasst werden.

Die einzelnen Objekte des Trend Makros kommunizieren über spezielle Container
Variablen miteinander. Die Namen dieser Container werden, beim Import des Makros
in die TEQ-View, um einen eindeutigen Index erweitert. Dies ist notwendig, um eine
eindeutige Instanz des Makros zu erstellen. Die Namen dieser Container können so
aussehen:

 '@MACRO_NewYMax.122345676788990'. 

Der Benutzer darf diese Variablen nicht verändern, da diese automatisch vom S-Web
Editor generiert und verändert werden. Wenn Sie ein angepasstes Makro wieder in die
Bibliothek einfügen wollen, wird dieser Index automatisch wieder entfernt. Sie müssen
sich also nicht um diese Indizes kümmern.

Einfügen eines Online Trend Makros in eine TEQ-View

1. Erstellen Sie eine neue TEQ-View: 
Projekt->Zum Projekt hinzufügen->neu 
(Wie ein neues Projekt hinzugefügt wird, beschreibt das Kapitel Erste Schritte)

2. Wählen Sie Library->Get object from library...

3. Wechseln Sie in das 'MacroLib' Verzeichnis. Wählen Sie den Dateinamen des
gewünschten Online Trend Makros:
Online Trend Complete: "OnlineTrendComplete.tlb"
Online Trend Minimal: "OnlineTrendMinimal.tlb"
Online Trend Scalable: "OnlineTrendScalable.tlb"

Eingefügter Online Trend Macro:
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Online Trend Minimal:

Online Trend skalierbar:
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Konfigurieren des Makros

1. Doppelklick auf das Makro um den 'Cross Ref' Dialog zu öffnen.

2. Wählen Sie den Eintrag '..._Macro Online Trend_Repaint:_@MACROActiveTrends.'
im Reiter 'Erweiterte Selektion'. Alternativ ist es möglich, die Gruppierung zuerst
aufzuheben und danach das Painterobjekt, das die Trendkurven aufzeichnet,
doppelt anzuklicken.
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3. Gehen Sie zum Reiter 'Macro Online Trend'
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4. Geben Sie den Namen des Prozesspunktes, den Sie hinzufügen möchten, im Feld
'PPO Name' ein. Die so eingegeben PPOs, werden in der Liste der verfügbaren
Prozesspunkte angezeigt. Der Benutzer definiert zur Laufzeit, welche dieser PPOs
er angezeigt haben will. Die PPOs werden vom Benutzer von der Liste der
verfügbaren PPOs zu der Liste der aktiven PPOs hinzugefügt.

5. Bestätigen Sie Ihre Auswahl mit "OK"

6. Definieren Sie Farbe, Y-Min und Y-Max Wert. Diese Werte werden als



139

Saia-Burgess Controls AG Erweiterte Funktionen

Trend Macros

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

Voreinstellungen verwendet. Die Skalierung kann vom Benutzer zur Laufzeit
beeinflusst werden.

7. Wählen Sie 'Add', um die Trendkurve zu übernehmen

8. Wiederholen Sie die Schritte 7-10 für alle Trendkurven, die Sie hinzufügen
möchten.

Um eine Trendkurve zu ändern, wählen Sie zuerst den Eintrag aus der Liste, führen
die Änderung durch und bestätigen mit 'Update'.

Projekt vorbereiten

1. Verlassen Sie den Dialog Macro Online Trend mit "OK".
2. Speichern Sie mit File-> Save
3. Wählen Sie Project-> Init PPOs und klicken Sie "OK".
4. Anschliessend Project-> Generate HTML...
5. Wählen Sie File-> Save All...
6. Laden Sie das Projekt mit PG5 auf Ihre Steuerung.

Benutzung der Online Trend Makros zur Laufzeit

Dieser Abschnitt beschreibt die Benutzung der Online Trend Makros zur Laufzeit.
Unterschiede und Einzelheiten zu den verschiedenen Makrovarianten, finden Sie in
separaten Kapiteln.
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Speichern Sie die Trendkurven auf einer lokalen Disk

Es ist möglich, die aufgezeichneten Daten lokal auf dem Rechner des Browser-Clients
zu speichern. Die Trendkurven werden in Form von CSV-Dateien abgelegt. Java
Applets haben einen nur eingeschränkten Zugriff auf Ressourcen des Computers.

Bei Microsoft Virtual Machine und Sun VM müssen Sie Sicherheitseinstellungen
anpassen, damit das Applet Daten lokal speichern kann.

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

Setzen Sie eine Startzeit und Datum

Sie können das sichtbare Zeitfenster anpassen:
1. 'set manual'
2. Startzeit und Datum eingeben
3. 'ENTER' und anschliessend 'set auto' wählen.
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20.3.4.2 Online Trend komplet

Bitte lesen Sie das Kapitel Online Trend Overview für allgemeine Informationen zu
Online Trends.

Nutzung des 'Online Trend Complete' während der Laufzeit

Überblick

Dieser Überblick erklärt die einzelnen Bedienelemente des Makros:
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Wenn Sie ein Feld editieren, bestätigen Sie anschliessend immer mit 'ENTER'.

start date/time Ab welcher Uhrzeit bzw. Datum beginnt das sichtbare
Zeitfenster?

end date/time Bei welcher Uhrzeit bzw. Datum endet das sichtbare
Zeitfenster?

scroll buttons Scrolle auf Zeitachse vorwärts bzw. rückwärts

set manual Zeitfenster manuell anpassen

activated PPO's
trends

Liste aller aktiven Prozesspunkte (angezeigt und
aufgezeichnet).
PPO
Name:

Überwachter Prozesspunkt

RGB: Rot-Grün-Blau Farbwert der Trendkurve

Min/Max:
Definiert Maximum und Minimum der Y-Achse für
den jeweiligen Trend.

Update:
Um Einstellungen, wie z.B. Min/Max oder RGB Wert
zu übernehmen.

Add: Prozesspunkt zu der Liste aktiver PPOs hinzufügen.
Removes
:

Prozesspunkt von der Liste aktiver PPOs entfernen.

available PPO's
trends

Die Liste der verfügbaren PPOs (kann zur Laufzeit erweitert
werden).
PPO
Name:

Name des verfügbaren Prozesspunktes

RGB: Rot-Grün-Blau Farbwert der Trendkurve

Min/Max:
Definiert Maximum und Minimum der Y-Achse für
den jeweiligen Trend.

New Neuen Prozesspunkt einfügen

zoom buttons Zeitfenster verkleinern oder vergrössern

Clear Logs Aufgezeichnete Trenddaten löschen.

Save Logs to file Aufgezeichnete Trenddaten abspeichern (siehe Kapitel'Online
Trend Überblick', Java Virtual Machine
Sicherheitseinstellungen müssen gegebenenfalls angepasst
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werden)

Benutzung des Online Trend Minimal Complete Makros zur Laufzeit

Prozesspunkt zur Aufzeichnung hinzufügen

Wählen Sie eine PPO von der Liste verfügbarer PPOs (available PPO's trends) und
klicken 'Add'

Eigenschaften eines überwachten PPOs ändern

Wählen Sie eine PPO aus der linken Liste. Name, RGB-Wert, Y-Min und Y-Max
Werte, werden automatisch in die darüber stehenden Eingabefelder kopiert. Diese
Werte können, falls nötig, geändert werden.
Drücken Sie immer die 'ENTER' Taste um Änderungen zu übernehmen. Um diese
Änderungen auf die Kurve anzuwenden, klicken Sie anschliessend den 'Update'
Button.
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Noch nicht verfügbaren PPO's hinzufügen

Darüber hinaus ist es möglich, eine PPO zur Laufzeit hinzuzufügen. Dies kann durch
die Angabe der Adresse des jeweiligen PPO durchgeführt werden. Die Verwendung
von symbolischen Namen ist in diesem Stadium nicht möglich.

Geben Sie den Namen des PPO ein, der nicht auf der Liste verfügbarer PPOs
vorhanden ist, bestätigen mit "ENTER" und klicken auf die Schaltfläche "Neu" um zu
bestätigen.
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20.3.4.3 Online Trend minimal

Bitte lesen Sie das Kapitel Online Trend Overview für allgemeine Informationen zu
Online Trends.

Benutzung des Online Trend Minimal Makros zur Laufzeit

Online Trend Minimal ist die simpelste Variante des Online Trends.
Abbildung eines Online Trend Minimal zur Laufzeit.
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Über Scroll- und Zoom-Buttons können Sie innerhalb des Zeitfensters navigieren:

20.3.4.4 Online Trend scalierbar

Bitte lesen Sie das Kapitel Online Trend Overview für allgemeine Informationen zu
Online Trends.

Benutzung des 'Online Trend Scalable' Makros im Editor
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Für Informationen über die Anwendung des Online Trend Scalable Makros lesen Sie
bitte Kapitel Offline Trend Scalable. Es entspricht dem Online Trend Scalable Makro.

20.3.5 Offline Trending

20.3.5.1 Offline Saved Trend komplet

Die "Offline Saved Trend Painter" sind Makro-Objekte welche unter Library -> Get
object from library importiert werden können. Diese Makros benötigen keine weiteren
Konfigurationen. Sie werden benutzt, um vorgängig aufgezeichnete Trendkurven von
einer CSV-Datei zu laden. Deshalb müssen Sie keine PPO's konfigurieren.

Benutzung des "Offline Saved Trend Complete" zur Laufzeit

Überblick

Dieser Abschnitt beschreibt, wie das 'Offline Saved Trend Complete' Makro zur
Laufzeit benutzt wird. Der Browser wird eine Ansicht ähnlich dem untenstehenden Bild
darstellen:

Drücken Sie ENTER, um Werte in Eingabefeldern zu übernehmen.

start date/time Ab welcher Uhrzeit bzw. Datum beginnt das sichtbare
Zeitfenster?

end date/time Bei welcher Uhrzeit bzw. Datum endet das sichtbare
Zeitfenster?
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scroll buttons Scrolle auf Zeitachse vorwärts bzw. rückwärts

activated PPO's
trends

Liste verfügbarer Prozesspunkte

PPO
Name:

Überwachter Prozesspunkt

RGB: Rot-Grün-Blau Farbwert der Trendkurve

Min/Max:
Definiert Maximum und Minimum der Y-Achse für
den jeweiligen Trend.

Update:
Um Einstellungen, wie Min/Max oder RGB Wert zu
übernehmen.

Add: Prozesspunkt zu der Liste aktiver PPOs hinzufügen.
Remove: Prozesspunkt von der Liste aktiver PPOs entfernen.

available PPO's
trends

PPO
Name:

Name des verfügbaren Prozesspunktes

RGB: Rot-Grün-Blau Farbwert der Trendkurve

Min/Max:
Definiert Maximum und Minimum der Y-Achse für
den jeweiligen Trend.

zoom buttons Zeitfenster verkleinern oder vergrössern

Load Data... Trenddaten aus Datei laden.

Clear Logs Trenddaten, die von der CSV-Datei geladen wurde wieder
löschen (nur im RAM).

Save Logs to file Speichert alle geladenen Trenddaten

Laden der Trenddaten

Wählen Sie "Load trend data" um die Trenddaten zu laden.
Bitte lesen Sie Java Security Settings (for Microsoft VM) und Signed Applets (for Sun
VM), falls kein 'Datei öffnen' Dialog erscheint.

Trendkurven zur Anzeige hinzufügen

Wählen Sie den entsprechenden Eintrag aus der Liste verfügbarer PPOs und klicken
'Add'

Eigenschaften angezeigter Trendkurven ändern

Wählen Sie eine PPO aus der linken Liste. Name, RGB-Wert, Y-Min und Y-Max
Werte, werden automatisch in die darüber stehenden Eingabefelder kopiert. Diese
Werte können, falls nötig, geändert werden. Drücken Sie immer die 'ENTER' Taste
um Änderungen zu übernehmen. Um diese Änderungen auf die Kurve anzuwenden,
klicken Sie anschliessend den 'Update' Button.

20.3.5.2 Offline Saved Trend minimal

Die "Offline Saved Trend Painter" sind Makro-Objekte welche unter Library -> Get
object from library importiert werden können. Diese Makros benötigen keine weiteren
Konfigurationen. Sie werden benutzt, um vorgängig aufgezeichnete Trendkurven von
einer CSV-Datei zu laden. Deshalb müssen Sie keine PPO's konfigurieren.
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Benutzung des Offline Saved Trend Minimal zur Laufzeit

Dieser Abschnitt beschreibt, wie das 'Offline Saved Trend Minimal' Makro zur Laufzeit
benutzt wird. Der Browser wird eine Ansicht ähnlich dem untenstehenden Bild
darstellen:

Benutztn Sie die 'scroll' und 'zoom' Knöpfe um im Trend zu navigieren.

Trend Daten laden

Klicken Sie "Load trend data" um die Daten zu laden.

Bitte lesen Sie Java Security Settings (for Microsoft VM) und Signed Applets (for Sun
VM), falls kein 'Datei öffnen' Dialog erscheint.

20.3.5.3 Offline Saved Trend scalierbar

Die "Offline Saved Trend Painter" sind Makro-Objekte welche unter Library->Get object
from library importiert werden können. Diese Makros benötigen keine weiteren
Konfigurationen. Sie werden benutzt, um vorgängig aufgezeichnete Trendkurven von
einer CSV-Datei zu laden. Deshalb müssen Sie keine PPO's konfigurieren.

Benutzung des Offline Saved Trend Scalable im Editor
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Für Hinweise zur Benutzung des 'Offline Saved Trend Scalable' lesen Sie bitte das
Kapitel 'Online Trend Scalable'. Es gibt keine Variante 'A' oder 'B', ansonsten
unterscheidet sich die Konfiguration im S-Web Editor der beiden Makros nicht.

Benutzung des Offline Saved Trend Scalable zur Laufzeit

Laden der Trenddaten

Wählen Sie "Load trend data" um eine CSV-Datei mit Trenddaten zu laden.

Bitte lesen Sie Java Security Settings (Microsoft VM) und Signed Applets (Sun VM),
falls der Dialog 'Datei öffnen' nicht erscheint. 

20.4 Alarming Macros

20.4.1 Übersicht

Einleitung

Dieses Kapitel gibt einen Überblick über die Alarming Makros. Einzelheiten zu den
verschiedenen Alarming Varianten sind in separaten Kapiteln beschrieben.

1. Online Alarm List
2. Online Alarm History
3. Offline Alarm History

Alarm Painterobjekte sind Makroobjekte und können über Library->Get object from
library laden. Diese Makros können historisch aufgezeichnete Alarm Daten einer
Saia®PCD Steuerung anzeigen und in Form einer Alarmliste darstellen. Die
Prozesssignale werden überwacht und Alarme unabhängig vom Web Browser in der
PCD Steuerung aufgenommen. Die aktuelle Alarm Funktionen sind in der Firmware
der PCD Steuerung enthalten. Eine Fupla FBox Bibliothek für PCD Classic ist
verfügbar. Die Alarme sind in Alarmlisten im nicht flüchtigen internen Speicher der
PCD Steuerung gespeichert.

Verwendung der Alarming Makros im Editor
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Alarm Makros bestehen aus einzelnen Paintern, die zu einem Makroobjekt gruppiert
sind. Der Benutzer kann die Gruppierung aufheben und einzeln auf die Painterobjekte
zugreifen. Die meisten dieser Objekte können nicht über den Dialog 'Painter
Eigenschaften' verändert werden.

Die Referenzen werden über den CrossRef Dialog angepasst. Aufgrund der eher
komplexen Funktionswiese der Makros wird dies aber nicht empfohlen. Grösse und
Position jedes Painters können jedoch einfach angepasst werden.

Die einzelnen Objekte des Alarm Makros kommunizieren über spezielle Container
Variablen miteinander. Die Namen dieser Container werden beim Import des Makros
in die TEQ-View um einen eindeutigen Index erweitert. Dies ist notwendig, um eine
eindeutige Instanz des Makros zu erstellen. Die Namen dieser Container können so
aussehen:

 '@MACRO_NewYMax.122345676788990'. 

Der Benutzer darf diese Variablen nicht verändern, da diese automatisch generiert
und verändert werden. Wenn Sie ein verändertes Makro wieder in die Bibliothek
einfügen wollen, wird dieser Index automatisch wieder entfernt. Sie müssen sich also
nicht um diese Indizes kümmern.

Einfügen eines Alarm Makros in eine neue TEQ-View

1. Erstellen Sie eine neue TEQ-Datei: Projekt->Zum Projekt hinzufügen->Neu
(Das Erstellen eines neuen Projekts ist beschrieben im Kapitel Getting Started)

2. Um das Alarm Makro in die TEQ-Datei einzufügen, wählen Sie Library -> Get object
from library

Online Alarm List: "MacroAlarmingDefOnline.tlb"
Online Alarm History: "MacroAlarmingHisOnline.tlb"
Offline Alarm History: "MacroAlarmingHisOffline.tlb"

Die eingefügte Online Alarm List:
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Online Alarm History:

Offline Alarm History:
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Konfigurieren des Makros

Der folgende Abschnitt erklärt wie den Alarm Makros Painter zu konfigurieren ist:

1. Doppelklick auf das Makro um den 'Cross Ref' Dialog zu öffnen.

2. Wählen Sie den Eintrag '.._Macro his Offline Alarm...' in 'Erweiterte Selektion'.
Online Alarm List: ".._Macro Def Online Alarm..."
Online Alarm History: ".._Macro his Online Alarm..."
Offline Alarm History: ".._Macro his Offline Alarm..."

3. Alarm List PPO Name (In allen Macro Varianten):

Zuerst muss der Alam List PPO Name eingegeben werden. Das Alarm Macro wird
den Alarm List Name vom PPO übernehmen.
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4. Betätigen Sie die 'Select' Taste neben dem 'Alarm List PPO Name' Textfeld um das
PG5 Symbol zu wählen (z.B. A.Alarm.ThisAlarmList.MyName). Mit dem PG5
Symbol ist das Alarm Macro zur Alarm List in der PCD referenziert.

Wenn Sie die Alarming FBox Bibliothek benutzten, wird das PG5 Symbol der Alarm
Liste automatisch generiert. Der Anwender kann den Name der Alarm Liste
definieren, indem er den Name der FBox verändert.
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Die Alarming Bibliothek kann in das PG5&/Libs/usr FBox Verzeichnis installiert oder
kopiert werden. Weitere Details finden Sie im Online Help der FBox Bibliothek.

5. Alarm Texte (optional):
Wenn Sie den Drop Down 'Alarm Texts From CSV File' aktivieren, lädt das Java-
Applet die Alarm Beschreibungen aus der CSV-Datei, andererseits wird das Applet
die Alarm Beschreibungen aus der DB laden.

Um die Alarm Beschreibungen mittels einer CSV-Datei zu definieren, aktivieren Sie
'Alarm Texts From CSV File'. Geben Sie die Grösse (Anzahl Alarm Typen) ihrer
Alarm Liste ein und bestätigen Sie mit 'OK'. Als nächstes Menu Funktion Project ->
Generate HTML TAGS CSV file. Der Editor generiert nun eine neue CSV-Datei.
Öffenen Sie die soeben erstellte CSV-Datei in einem Text Editor (z.B. Notepad) und
definieren Sie die Alarm Beschreibungen anhand der folgenden Bilder:
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Wählen Sie Projekt->Projekteinstellungen... und geben Sie den Dateinamen der CSV-
Datei im Feld 'CSV-Datei' im Reiter 'Projekt - Applet Erweitert' an.

6. Alarm Status Farben:
Definieren Sie für jeden Alarmstatus eine andere Farbe:

No state Alarm inaktiv (war noch nie aktiv)
ON Alarm aktiv
ON ACKED Alarm aktiv und bestätigt
OFF Alam inaktiv (vormals aktiv)
OFF ACKED Alam inaktiv (vormals aktiv) und bestätigt

Beispiel Alarmliste:

7. Filter - Arten:

'Filter - Sort' erscheint nur im Konfigurations-Dialog der Online Alarm Liste (siehe
auch Kapitel Online Alarm History):
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Projekt vorbereiten
1. Wenn Sie eine neue TEQ-Datei erstellen wollen, generieren Sie eine neue HTML

Datei mit Project-> Generate HTML...
2. Wählen Sie File-> Save All...
3. Laden Sie nun das HMI Projekt mit PG5 auf Ihre Steuerung.

20.4.2 Online Alarm Liste

Benutzung Online Alarm List im Betrieb

Übersicht

Die Online Alarm Liste zeigt einen Überblick aller Alarmtypen. Ausgeführte Aktionen in
dieser Liste werden auf alle selektierten Alarmtypen übernommen. Der Benutzer kann
durch Filter und diverse Sortierungstypen die Darstellung verändern.
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ID, Alarmtext und Counter beziehen sich auf die Alarmtypen. Time On, Time Off und
ACK referenzieren auf den jeweils letzten Alarm.

Tabellenspalte

ID Eindeutiger Identifikator für den den Alarmtyp

Alarmtext Alarmmeldung (dem Alarmtyp zugeordnet)

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off Zeitpunkt an dem der Alarm inaktiv wurde. ('---' bedeutet, dass der
Alarm noch aktiv ist)

ACK Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt (NCK) ist

Counter Gibt an, wie viele Alarme des jeweiligen Alarmtyps auftraten

Ack Selected
Alarms

Bestätigt den gewählten Alarm

Delete Selected
Alarms

Löscht alle aufgetretenen Alarme

Ack Alarm List Bestätigt die gesamte Alarmliste

Delete Alarm List Löscht die gesamte Alarmliste

Total Entries Anzahl aufgetretener Alarme

Tasten

Ack Selected Alarms Bestätigt den gewählten Alarm

Delete Selected
Alarms

Löscht alle aufgetretenen Alarme

Ack Alarm List Bestätigt die gesamte Alarmliste

Delete Alarm List Löscht die gesamte Alarmliste
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Select Mode Umschalten zwischen 'Single' und 'Multi-line' Selektion

Auswahlfelder

Filter Mode No Filter - zeigt alle Alarm Typen
Active Alarms - zeigt nur aktive Alarmtypen
Alarms count - zeigt nur Alarmtypen, welche mindestens ein Mal
auftraten
Active or NAK Alarms - zeigt Alarmtypen, welche aktiv oder
unbestätigt sind

Sort Mode Not Sorted - keine Sortierung
Active Time Sorted - der neuste Alarm ist zuoberst

Anzeigefelder

Total Entries Anzahl aufgetretener Alarme

20.4.3 Offline Alarm History

Benutzung Offline Alarm History während Runtime

overview

Das 'Online Alarm History' Makro zeigt eine nach Zeit sortierte Liste aller
aufgetretenen Alarme an. Anfangs ist das Alarm Makro leer. Der Benutzer klickt 'Load
Alarm List' um alle aufzeichneten Alarmdaten von der Steuerung zu laden. 'Total
Entries' zeit die Anzahl vorhandener Alarme an. 'Loaded Alarms' zeigt die Anzahl
bereits geladener Alarme. 'Save To File' erstellt eine CSV-Datei mit allen Alarmdaten.
Die beispielsweise in einem Programm für Tabellenkalkulationen verarbeitet werden
können.

Die Liste können die Alarmliste nach den verschiedenen Spalten sortieren. Klicken Sie
den gewünschten Spaltentitel an:
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Tabellenspalte

TID Eindeutiger Identifikator für den den Alarmtyp

Alarmtext Alarmmeldung (dem Alarmtyp zugeordnet)

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off Zeitpunkt an dem der Alarm inaktiv wurde. ('---' bedeutet, dass der
Alarm noch aktiv ist)

ACK Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt (NCK) ist

Load Alarms
List

Lädt die Alarmliste von der Steuerung

Save To File Speichert geladenen Alarmdaten in einer CSV-Datei

Loaded / Total
Entries

Anzahl aufgetretener Alarme

Speichern Sie die Alarmdaten auf einem lokalen Datenträger

Es ist möglich, die aufgezeichneten Daten lokal auf dem Rechner des Browser-Clients
zu speichern. Die Trendkurven werden in Form von CSV-Dateien abgelegt.
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Bei Microsoft Virtual Machine und Sun VM, müssen Sie Sicherheitseinstellungen
anpassen, damit das Applet Daten lokal speichern kann.

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (Sun VM PlugIn)

20.4.4 Online Alarm History

Benutzung Online Alarm History im Betrieb

Übersicht

Das 'Online Alarm History' Makro zeigt eine nach Zeit sortierte Liste aller
aufgetretenen Alarme an. Die neuste Alarmmeldung erscheint auf der ersten Zeile. 

Das Java-Applet lädt nur die Alarme, welche auf der Seite angezeigt werden. Der
Benutzer kann Alarme bestätigen oder löschen.

 
Tabellenspalte

TID Eindeutiger Identifikator für den den Alarmtyp

Alarmtext Alarmmeldung (dem Alarmtyp zugeordnet)

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off Zeitpunkt an dem der Alarm inaktiv wurde. ('---' bedeutet,
dass der Alarm noch aktiv ist)

ACK Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt (NCK)
ist

Ack Selected
Alarms

Bestätigt den gewählten Alarm

Delete Selected Löscht alle aufgetretenen Alarme
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Alarms

Ack Alarms Type Bestätigt alle Alarme eines bestimmten Typs

Delete Alarms
types

Löscht alle Alarme eines bestimmten Typs

Ack Alarm List Bestätigt die gesamte Alarmliste

Delete Alarm List Löscht die gesamte Alarmliste

Total Entries Anzahl aufgetretener Alarme

20.5 Alarming Macros(2)

20.5.1 Alarming Übersicht (2)

Einleitung

Dieses Kapitel gibt einen Überblick über die Alarming 2 Makros. Einzelheiten zu den
verschiedenen Alarm-Varianten sind in separaten Kapiteln beschrieben.

1. Online Alarm List (2)
2. Online Alarm Histroy (2)
3. Offline Alarm History (2)

Alarm Painterobjekte sind Makroobjekte und können über Library->Get object from
library geladen werden. Diese Makros können historisch aufgezeichnete Alarm Daten
einer Saia®PCD Steuerung anzeigen und in Form einer Alarmliste darstellen. Die
Alarm Funktionen sind in der Firmware der PCD Steuerung enthalten. Eine Fupla
FBox Bibliothek für PCD Classic ist verfügbar. Die Alarme sind in Alarmlisten im nicht
flüchtigen internen Speicher der PCD Steuerung gespeichert.

Alarming 2 Eigenschaften

Erweiterungen
Gruppen und Prioritäten
Alarmtexte in separater Text-Datei
Kurze und lange Alarmtexte
Texte auf 2 Zeilen
Zusätzlicher Hilfe-Text
Neue Macro Konfigurationsdialoge
Verwendet die neue FBox „Alarm2 SWeb“

Anforderungen
S-Web-Editor Version 5.15.
Nur mit Saia PCD-NT Steuerungen

Verwendung der Alarming 2 Makros im Editor
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Alarm Makros bestehen aus einzelnen Paintern, die zu einem Makroobjekt gruppiert
sind. Alle Alarming 2 Makros können mittels eines komfortablen Dialogs konfiguriert
werden. 
Der Benutzer kann die Gruppierung aufheben und einzeln auf die Painterobjekte
zugreifen, um diese zu verschieben oder die Grösse zu ändern. Beim Löschen von
Objekten ist Vorsicht angebracht, da einzelne interne Event-Painterobjekte benutzen
werden, welche für die allgemeine Funktion der Alarm-Makros erforderlich sind.

Einfügen eines Alarm Makros in eine neue TEQ-View
1. Erstellen Sie eine neue TEQ-Datei: Projekt->Zum Projekt hinzufügen->Neu

(Das Erstellen eines neuen Projekts ist im Kapitel Getting Started beschrieben)

2. Um das Alarm Makro in die TEQ-Datei einzufügen, wählen Sie Library -> Get object
from library

3. Wechseln Sie in das 'MacroLib' -Verzeichnis. Wählen Sie den Dateinamen des
gewünschten Alarming Makros:

Online Alarm List: "MacroAlarmingDefOnline_5.15_01.esm"
Online Alarm History: "MacroAlarmingHisOnline_5.15.02.esm"
Offline Alarm History: "MacroAlarmingHisOffline_5.15.02.esm"

Eingefügte "Online Alarm List (2)":
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"Online Alarm History (2)":

"Offline Alarm History (2)": 
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Konfigurieren des Makros
Der folgende Abschnitt erklärt wie die Alarm Makros zu konfigurieren sind (das
Vorgehen ist bei allen Makros gleich):

1. Doppelklick auf das eingefügte Makro um den Konfigurationsdialog zu öffnen
2. Konfiguration der Einstellungen wie in den folgenden Abschnitten erklärt

Basiskonfiguration der Alarmliste (Bereich "Alarm List")
1. Klick auf den PPO-Selektor Taste um den Alarmlistennamen aus den PG5

Symbolen auszuwählen

2. Alarmlistenname aus der PG5 Symboltabelle auswählen:
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(Nach der Konfiguration des PPO, ist  der "alarm list macro" mit der
korrespondierenden Objektinstanz im PG5 verknüpft).

3. Das Alarmlisten-Makro zeigt die verschiedenen Beschreibungstexte (kurze, lange,
Hilfetexte) zu den anstehenden Alarme. Diese Texte sind in den ASV-Dateien
definiert. 
Im Konfigurationsdialog wird der Name (ohne Sprachindex) der Datei definiert. Im
Browser wird der Dateinamen automatisch abhängig von der gewählten Sprache
mit dem Sprachindex ergänzt (Wird in den folgenden Schritte ausführlicher erklärt).

Bestimmung des Dateinamens '*.asv'

Bitte ‚AL’ nicht ändern da diese am Anfang jeder ASV-Datei definiert ist. Der Name
in diesem Beispiel ‚_alarmTexts’ kann beliebig gewählt werden (trotzdem,
vermeiden sie Sonderzeichen oder lange Namen).
Diese ASV-Dateien werden später definiert. Zuerst wird die Konfiguration der
Makros ausgeführt.

Spaltenwahl und Anpassung ihrer Grösse (Bereich "Setup Alarm List Items .."

1. Optional: Entmarkieren Sie die Kontrollboxen der Spalte die während der Laufzeit
nicht angezeigt werden sollen.
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2. Optional: Passen sie die Breite jedes Spaltes an indem sie auf den entsprechenden
Pfeil klicken.

Filter und Text Optionen (Bereich "Setup Alarm List Filters ..")

1. Einstellung des Standards Filter-modus (Filter Default Value):

No Filter: Zeigt alle Alarmtypen an
Active Filter: Zeigt nur die Alarmtypen an die im Moment aktiv sind
Alarms count: Zeigt nur die Alarmtypen an die mindestens einmal aktiv
waren
Active or NAK Alarms: Zeigt nur die Alarmtypen an die entweder aktiv oder
unbestätigt sind

2. Jede Linie verfärbt sich während der Laufzeit des Programms. Verschiedene Modi
sind möglich. Das zugeordnete Auswahlmenu ermöglicht die Wahl welcher Mode
als Standard gelten soll.

State Color Mode: Die Farbe hängt vom Eventstatus ab
Group Color Mode: Die Farbe hängt von der Gruppen Zugehörigkeit
ab
Prio Color Mode: Die Farbe hängt von der Priorität des Events ab

3. Wenn benötigt werden nur Alarme angezeigt mit einer bestimmter Priorität
(Standard : alle).

4. Wählen Sie den Vergleichsoperator in der  zweiten Spalte und die Priorität in der
dritten Spalte mit der zu vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Priorität haben wie PrioN
> Zeigt nur die Alarme an die eine höhere Priorität haben als PrioN
< Zeigt nur die Alarme an die eine tiefere Priorität haben als PrioN

Wo PrioN: Prio0, Prio1…Prio7 entspricht

5. Wenn benötigt werden nur Alarme angezeigt die zu einer bestimmten Gruppe
gehören (Standard : alle).

6. Wählen Sie den Vergleichsoperator in der  zweiten Spalte und die Gruppen ID in
der dritten Spalte mit der zu vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Gruppen ID haben wie GroupN
> Zeigt nur die Alarme an die eine höhere Gruppen ID haben als GroupN
< Zeigt nur die Alarme an die eine tiefere Gruppen ID haben als GroupN

Wo GroupN: Group0, Group1 … Group31 entspricht

7. ‚Display Long Alarms Texts’ ist zu setzen, wenn lange Alarm-Meldungen während
der Laufzeit anzuzeigen sind.
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8. ‚Display Alarm's Text On 2 Lines’ ermöglicht das Umbrechen des Textes auf zwei
oder mehr Zeilen, so dass der Text in die festgelegte Breite der Spalte passt.

Konfiguration der Farbeinstellungen (Bereich "Setup Alarm State Colors")
1. In Diesem Abschnitt des Konfigurationsfensters wird die Bedeutung der Farben für

jeden Modus bestimmt. Konfigurieren Sie für jeden Modus die Farben ihren
Bedürfnissen entsprechend.

ON Farbe für Alarm ist aktiv
ON ACKED Farbe für Alarm ist aktiv und bestätigt
OFF Farbe für Alarm ist inaktiv
OFF ACKED Farbe für Alarm ist inaktiv und bestätigt

2. Um eine beliebige Farbe zu bestimmen, ist für jede Grundfarbe, also rot, grün und
blau, der Wert 0..255 durch Komma getrennt im Eingabefeld einzugeben.

3. Die Eingabe wird durch 'OK' bestätigt. 

Alarm Texte definieren
Wie in den vorherigen Schritten erwähnt, können die Alarm-Texte in der
sprachabhängigen ASV-Datei definiert werden. In diesem Beispiel beginnt jede Datei
mit ‚AL_alarmTexts’. Während der Laufzeit ergänzt der Browser den Dateinamen mit
einem sprachabhängigen Suffix.

Folgend die vollständige ASV Dateinamensyntax:

AL_Name_LanguageDependantSuffix.ASV

Die kursiv geschriebenen Teil des Namens hängt von Ihrer Konfiguration ab.
Der blaue und fettgedruckte hervorgehobene Teil des Dateinamens ist vordefiniert.
LanguageDependantSuffix referenziert mit dem Wert des HTML-Tags
'LANG_SYMB'.

Das sprachabhängige Suffix ("LanguageDependantSuffix") hat seinen Ursprung in der
entsprechenden CSV-Sprachdatei. Für "LANG_SYMB" benützen Sie bitte kleine
Bezeichnungen mit zwei Buchstaben wie DE, FR oder EN (Die Sprachcodes können
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in der ISO 639-1 Norm nachgeschlagen werden). Nach der Definition Ihrer CSV-
Sprachdatei, ist dem HTML-TAG "LANG_SYMB" die entsprechende Sprache
zuzuordnen.

Im Kapitel "Mehrsprachige HMIs", wird beschrieben wie sprachbezogene Dateien wie
z.B "en.csv" erstellt werden.
Die folgenden Zeilen zeigen den Aufbau einer ASV-Datei:

#!Version;1
#!BB1
#!
DEFSTATUS;DefStat1;DefStat2;DefStat3;DefStat4;DefStat5;DefStat6;
DEFSTATUS;m y state 1 string;m y state 2 string;
#!EB1
#!BB2
#!
ID;ShortText;DetailedText;Help;Status1;Status2;Status3;Status4;Status5;Status6;
Status N
1;M otor1;Ventilation Kino 1 Cooler pum p m otor1 protection tripped; M otor1 Power;
Norm al;Fault
2;M otor2;Ventilation Kino 2 Cooler pum p m otor2 protection tripped; M otor2 Power;
Norm al;Fault
3;M otor3;Ventilation Kino 3 Cooler pum p m otor3 protection tripped; M otor3 Power;
Norm al;Fault
4;M otor4;Ventilation Kino 4 Cooler pum p m otor4 protection tripped; M otor4 Power;
Norm al;Fault
5;M otor5;Ventilation Kino 5 Cooler pum p m otor5 protection tripped; M otor5 Power;
Norm al;Fault
6;M otor6;Ventilation Kino 6 Cooler pum p m otor6 protection tripped; M otor6 Power;
Norm al;Fault
#!EB2

#!Version, #!DEFSTATUS, #!BB1, #!EB1, #!BB2, #!EB2, sind reservierte
Bezeichnungen (Die dürfen nicht verändert werden). Andere Linien die mit #!
Anfangen werden ignoriert (können für Kommentare benützt werden)

Wichtige Hinweise
Falls LANG_SYMB nicht definiert ist, kann der Browser keine Alarme oder
Eventmeldungen laden

Stellen sie sicher dass während der Laufzeit des Projektes eine gültige Sprache in der
CSV-Datei definiert und geladen wird. Dazu ist es auch wichtig dass der HTML TAG
‚LANG_SYMB’ immer dem sprachabhängige Suffix der ASV-Datei entspricht.
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AL_Name_SprachabhängigerSuffix.ASV
Der SprachabhängigerSuffix entrspricht dem Wert des HTML TAG 'LANG_SYMB’.

Wenn noch keine sprachabhängige CSV-Datei definiert wurde, klicken Sie auf die
entsprechenden ‚CSV’ Taste in der Symbolleiste um eine zu definieren.
Nach dem generieren der Datei, kontrollieren Sie ob 'LANG_SYMB’ den
entsprechenden Wert hat (in diesem Beispiel ‚EN’).

Benützen Sie das Menü Project->Project configurations und dann im Tab 'Project-Applet
Advanced’. Aktivieren Sie die Option ‚HTML Parameters in CSV file’ und wählen Sie die
Sprache der CSV-Datei aus.

Vorbereitung eines Projektes
1. Wenn Sie eine neue TEQ erstellt haben, müssen sie eine neue HTML-Datei mit 

Project->Generate HTML generieren ...
2. Wählen Sie File -> Save All
3. Kompilieren und laden Sie ihr Project mit PG5 in die SPS.

20.5.2 Online Alarm Liste (2)

Verwendung der Online Alarm List (2) während der Laufzeit

Überblick

Die Online Alarmliste enthält einen Überblick über alle Alarm-Typen. Aktionen, die in
dieser Liste durchgeführt werden, werden auf alle auftretenden Alarme des
ausgewählten Alarmtyps angewendet.
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Tabellenspalte

ID, Prio, Group, Alarm Text, Active und Counter verweisen auf den Alarmtyp. 
Time On, Time Off und ACK verweisen auf den letzten Alarm dieses ID definierten
Typs.

ID Eindeutiger Identifikator für den Alarmtyp

Prio Priorität des Alarmtyps

Group Gruppen Zugehörigkeit des Alarmtyps

Alarm Text Alarmmeldung (dem Alarmtyp zugeordnet)

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off
Zeitpunkt an dem der Alarm inaktiv wurde.
('---' bedeutet, dass der Alarm noch aktiv ist)

ACK
Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt
(NCK) ist

Active
Wird in der Regel auf 1 gesetzt, dies bedeutet der Alarmtyp
ist aktiviert. Für Servicearbeiten kann er deaktiviert werden
(0 setzen).

Counter
Gibt an, wie viele Alarme vom jeweiligen Alarmtyps
auftraten

Tasten

Ack Selected
Alarms

Bestätigt alle Alarme des gewählten Typs

Delete Selected
Alarms

Löscht alle Alarme des gewählten Typs
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Single/Multiple
Select

Schaltet zwischen diesen zwei Selektionsmodi um 
(einzel- und mehrfach Selektionsmodus)

Ack Alarm List Bestätigt die gesamte Alarmliste

Delete Alarm List Löscht die gesamte Alarmliste

Enable Selected
Alarms

Aktiviert die ausgewählten Alarmtypen

Disable Selected
Alarms

Deaktiviert die ausgewählten Alarmtypen. Unterdrückt das
Auftreten von neuen Alarmen (dieses Typs). z.B. während
Servicearbeiten.

Advanced Off/On Schaltet von der Makro Ansicht in den ‘Standard’ Modus

Enable Alarm List Aktiviert alle Alarmtypen dieser Liste

Disable Alarm List Deaktiviert alle Alarmtypen dieser Liste. Unterdrückt das
Auftreten von neuen Alarmen. z.B. während Servicearbeiten

Filter Filteroptionen (siehe nächsten Abschnitt "Filter")

Help Text On/Off Aktiviert im 'Default' Modus die Hilfetexte im gelbe Rechteck

Short/Long Schaltet zwischen langen und kurzen Alarm Meldungen um

Anzeigefelder

Total Entries Anzahl aufgetretener Alarme

Filter

Filter Mode No Filter:
Zeigt alle Alarmtypen an

Active Alarms:
Zeigt nur die Alarmtypen an die im Moment aktiv sind

Alarms count > 0:
Zeigt nur die Alarmtypen an die mindestens einmal aktiv waren

Active or NAK Alarms:
Zeigt nur die Alarmtypen an die entweder aktiv oder unbestätigt
sind

Non Ack Alarms:
Zeigt nur die Alarmtypen an die unbestätigt sind

Disabled Alarms:
Zeigt nur inaktive Alarme an
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Enabled Alarms:
Zeigt nur aktive Alarme an

Sort Mode Not Sorted
Nicht geordnet

Active Time Sorted:
Zeigt in erster Zeile den neusten Alarm an

Group Wahl des Vergleichsoperators und die Gruppen ID die zu
vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Gruppen ID haben wie
GroupN
> Zeigt nur die Alarme an die eine höhere Gruppen ID haben als
GroupN
< Zeigt nur die Alarme an die eine tiefere Gruppen ID haben als
GroupN

GroupN entspricht:  Group0, Group1 … Group31

Prio Wählen Sie den Vergleichsoperator und die Priorität die zu
vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Priorität haben
wie PrioN
> Zeigt nur die Alarme an die eine höhere Priorität haben
als PrioN
< Zeigt nur die Alarme an die eine tiefere Priorität haben
als PrioN

PrioN entspricht:  Prio0, Prio1…Prio7 

20.5.3 Offline Alarm History (2)

Verwendung des historischen Offline Alarm während der Laufzeit

Überblick

Der historische 'Offline Alarm' listet alle aufgezeichneten Alarme zeitgeordnet auf. Der
jüngste Alarm erscheint auf der ersten Zeile. Zu Begin ist diese Liste leer. 

‚Load Alarm List’ ladet die Alarme. 

'Total Entries’ zeigt die Anzahl vorhanden Alarme. 

‚Loaded Alarms’ zeigt die zur Zeit geladenen Alarme. 

Wenn auf ‚Save To File’ geklickt wird, wird automatisch eine CSV-Datei generiert.
Diese Datei kann mit jedem beliebigen Tabellenprogramm verarbeitet werden.

Die Liste kann durch klicken auf den Spaltennamen sortiert werden. Entsprechen gilt
dies auch für 'Time On’, welche die Alarme zeitsortiert auflistet.
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Advanced Mode View (Ansicht Erweiterter Modus)

Tabellenspalte

TID Eindeutiger Identifikator für den Alarmtyp

Prio Priorität des Alarms

Group Gruppen Zugehörigkeit des Alarms

Alarm Text Alarmmeldung 

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off
Zeitpunkt an dem der Alarm inaktiv wurde. ('---' bedeutet, dass
der Alarm noch aktiv ist)

ACK
Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt (NAK)
ist

Tasten
Hinweis: Alle Aktionen werden erst wirksam, wenn erneut auf die Taste ‚Load Alarm
List’ gedrückt wird.

Load Alarms List Lädt die Alarme

Save To File Generiert eine CSV-Datei die alle Alarme behält

Advanced on/off Umschaltung Standart / Erweitert

Filter Ein/Aus

Alarm Text Type
Long / Short:  Schaltet zwischen langen und kurzen
Alarmtext um

Auswahlfeld

Color Mode  Farben sind abhängig von :
- Status (State Color Mode)
- Gruppen (Group Color Mode)
- Prioritäten (Prio Color Mode)

Anzeigefeld
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Loaded / Total
Entries

Anzahl aufgetretene Alarme

Alarm Liste auf lokaler Festplatte speichern

Mit ‚Save To File’ wird eine Alarmliste in einer CSV-Datei auf dem PC gespeichert.

Wird eine Microsoft VM oder eine Sun VM benutzt, funktioniert das herunterladen der
Datei unterschiedlich. Die Sicherheitseinstellungen müssen entsprechend angepasst
werden.

Microsoft VM: Java Security Settings
Sun VM: Signed Applets (For Sun VM PlugIn)

20.5.4 Online Alarm History (2)

Verwendung des historischen online Alarm Macros während der
Laufzeit

Überblick

Der "Online Alarm History Macro" (Alarmaufzeichnung online)  listet alle
aufgezeichneten Alarme zeitgeordnet auf. Der jüngste Alarm erscheint auf der ersten
Zeile. Der Browser lädt nur die Alarme die auf der gegenwärtigen Seite angezeigt
werden sollen. Hier lassen sich Aktionen ausführen, wie z.B. Alarme bestätigen oder
löschen.

Advanced Mode View „Anzeige im erweiterten Modus“
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Tabellenspalte

ID Eindeutiger Identifikator für den Alarmtyp

Prio Priorität des Alarmtyps

Group Gruppen Zugehörigkeit des Alarmtyps

Alarm Text Alarmmeldung (dem Alarmtyp zugeordnet)

Time On Zu diesem Zeitpunkt wurde der Alarm aktiv

Time Off Zeitpunkt an dem der Alarm inaktiv wurde.
('---' bedeutet, dass der Alarm noch aktiv ist)

ACK Gibt an, ob der Alarm bestätigt (ACK) oder unbestätigt
(NCK) ist

Tasten

Ack Selected
Alarms

Bestätigt alle Alarme des gewählten Typs

Delete Selected
Alarms

Löscht alle Alarme des gewählten Typs

Select Mode Single/Multiple:  Schaltet zwischen diesen zwei
Selektionsmodi um 
(einzel- und mehrfach Selektionsmodus)

Ack Alarm Types Bestätigt alle nach Alarmtyp selektierte Alarme

Delete Alarm Types Löscht alle nach Alarmtyp selektierte Alarme

Ack Alarm List Bestätigt die gesamte Alarmliste

Delete Alarm List Deletes all alarms of the selected alarm types

Advanced Off/On Schaltet zwischen Erweiterter- oder Standart-Ansicht um



177

Saia-Burgess Controls AG Erweiterte Funktionen

Alarming Macros(2)

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

Filter Filteroptionen ein / aus

Alarm Text Type Short/Long: Schaltet zwischen langen und kurzen Alarm
Meldungen um

Help Text On/Off Aktiviert im 'Default' Modus die Hilfetexte im gelbe Rechteck

Auswahlfeld

Color Mode   Farben sind abhängig von :
- Status (State Color Mode)
- Gruppen (Group Color Mode)
- Prioritäten (Prio Color Mode)

Anzeigefeld

Total Entries Anzahl aufgetretene Alarme

Filter Ansicht

Auswahlfelder

Group Wahl des Vergleichsoperators und die Gruppen ID die zu vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Gruppen ID haben wie GroupN
> Zeigt nur die Alarme an die eine höhere Gruppen ID haben als GroupN
< Zeigt nur die Alarme an die eine tiefere Gruppen ID haben als GroupN

GroupN entspricht:  Group0, Group1 … Group31

Prio Wahl des Vergleichsoperator und die Priorität die zu vergleichen ist:

= Zeigt nur die Alarme an die die gleiche Priorität haben wie PrioN
> Zeigt nur die Alarme an die eine höhere Priorität haben als PrioN
< Zeigt nur die Alarme an die eine tiefere Priorität haben als PrioN

PrioN entspricht:  Prio0, Prio1…Prio7

20.6 Ereignislisten Übersicht

Einführung
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Der 'Event list' (Ereignisliste) Makro kann verwendet werden, um historische Daten
aus einer Saia® PCD zu lesen und die Daten in individuell konfigurierten Listen
darzustellen. Zusätzlich lassen sich die jüngsten Ereignisse am Anfang der Liste
anzeigen.

Ein Printscreen Beispiel aus einem Web-Browser für eine Event-Liste  (siehe weiter
unten für weitere Details):

Fakten
Die jüngsten Ereignisse werden im PCD RAM-Speicher abgelegt und die Dateien im
PCD-Flash-Speicher gespeichert.
Jede 'Event list' Datei kann entweder auf tägliche, wöchentliche oder monatliche
Daten basieren.
Der 'Event list' Makro kann aus dem Unterverzeichnis 'SaiaEventList' über das
Menü Library->Get object from library-> Datei "EventsList_ [Version].Esm" importiert
werden.

'Event List' Macro verwenden

Der 'Event list' Makros besteht aus mehreren Painter-Objekten, die in einem Makro-
Objekt gruppiert sind. Die Gruppierung kann mit 'ungroup' aufgehoben werden.
Dadurch lässt sich jedes Painter-Objekt einzeln ehandeln. Es empfiehlt sich nicht, die
Verweise zu ändern. Die Objekte können jedoch problemlos verschoben oder in der
Größe verändert werden.

Durch einen Doppelklick auf das eingefügte Makro öffnet sich der
Konfigurationsdialog.Die folgende Anleitung in den nächsten Abschnitten zeigt Schritt-
für-Schritt die Vorgehensweise.

Beispiel für den 'Event list' Konfigurationsdialog:
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"Event List Macro" einfügen

1. Erstellen Sie eine neue TEQ View, um den 'Event list' Makros einzufügen. Zu 
finden unter Projekt-> Add to Projekt-> New . (Wie man ein neues Projekt erstellt,
wird im Kapitel Erste Schritte beschrieben)

2. Als nächstes Auswahl von menu Library->Get object from library im Menu oder

alternativ auf den Knopf in der Toolbar:

3. Wechseln Sie zu Ihrem "MacroLib" Verzeichnis und wählen den Dateinamen
'EventsList_[Version].esm' 
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Der eingefügte 'Event-List' Macro könnte in etwa wie folgt aussehen:

Macro konfigurieren

1. Auf das eingefügte Objekt Doppelklicken um den Konfigurations-Dialog zu öffnen.
 

2. Richten Sie Ihr Makro wie in den folgenden Abschnitten gezeigt ein:

Bereich 'Events List :'

1. 'Event-List PPO Name' holen mit '...' am Ende des Eingabefeldes:
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2. Wählen Sie die gewünschte Variable im Dialogfenster:

(Nach der Konfiguration dieser PPO ist der 'Event-List' Makro mit der
entsprechenden Objekt-Instanz in Ihrem PG5 Programm verbunden.)

3. Der 'Event-List' Makro kann während der Laufzeit mehrere Texte (kurze, lange und
Hilfetexte) bei auftretenden Ereignissen zeigen. Diese Texte sind in der ASV-
Dateien definiert.
Im Konfigurations-Dialog ist nur der Namensanfang der ASV-Datei definiert. Der
Dateiname wird dann automatisch mit dem Suffix der aktuellen Sprache (weitere
Details in den nächsten Schritten) abgeschlossen.

Startdateinamen '*.asv' eingeben. 

Die ersten drei Buchstaben 'AL_' dürfen nicht geändert werden, da diese eine ASV-
Datei kennzeichnen. Der Name "_eventTexts" kann beliebig gewählt werden (keine
Sonderzeichen oder zu lange Namen).
Den ASV-Dateinamen definieren wir ein paar Schritte später. Als erstes wird die
Konfiguration des Makro's durchzuführen.

4. Der "Timeout"-Parameter definiert das erneute laden der 'Event-List' von Zeit zu
Zeit bei Inaktivität des Benutzers. Beim Wert '-1' (Standard), wird die Liste nur
geladen, wenn der Benutzer eine bestimmte Aktion ausführt (z. B. wenn die erste
Seite abgerufen wird).

Bereich 'Setup Events List Items And Column Sizes'
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1. Optional: Sollen Spalten während der Laufzeit nicht sichtbar sein, sind die
entsprechenden Kontrollkästchen zu deaktivieren.

2. Optional: Breitenänderung der Spalten geschieht jeweils durch anklicken der
zugeordneten Pfeiltasten. 

Bereich 'Setup Events List Filters And Display Default'

Ereignisse abhängig von der Priorität anzeigen (Standard: Alle):

'Prio Default Value':  Vergleichsoperator (mittlere Spalte) zu PrioN (Spalte 3).

=  Zeige nur Ereignisse, die die gleiche PrioN haben
>  Zeige Ereignisse die grösser sind als PrioN
<  Zeige Ereignisse die kleiner sind als PrioN

Für PrioN steht: Prio0, Prio1...Prio7

Ereignisse abhängig von der Gruppenzugehörigkeit anzeigen (Standard: Alle):

'Group Default Value':   Nur festlegen wenn Ereignisse einer bestimmten
Gruppenzugehörigkeit angezeigt werden sollen (Standart : Alle):

Ereignisse abhängig von der Alarm-ID anzeigen (Standard: Alle):

'Alr ID Standart Value':  Vergleichsoperator (mittlere Spalte) zu GroupN (Spalte 3)
wählen:

=  Zeige nur ID-Gruppen Ereignisse an, welche gleich sind. 
>  Zeige nur ID-Gruppen Ereignisse an, welche grösser als GroupN sind.
<  Zeige nur ID-Gruppen Ereignisse an,welche kleiner als GroupN sind.

Für GroupN steht: Group0, Group1...Group31

Definierung des Alarm-ID Standardwertes
'Gleich' bedeutet hier, dass man ein Ereignis einer bestimmten Alarm ID auswählen
und dann nur die Ereignisse filtern kann, die die gleiche (oder gleichwertige) Alarm-ID
hat.  Diese Einstellung kann zur Laufzeit geändert werden.
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Ereignisse abhängig vom Status anzeigen (Standard: Alle):

'State Default Value':  Vergleichsoperator (mittlere Spalte) zu StateN (Spalte 3)
wählen:

=  Zeige nur Ereignisse an, bei denen der ID-Zustand gleich ist wie der StateN in
der dritten Spalte.

>  Zeige nur Ereignisse an, bei denen der ID-Zustand grösser ist als der StateN in
der dritten Spalte

<  Zeige nur Ereignisse an, bei denen der ID-Zustand kleiner ist als der StateN in
der dritten Spalte

Für StateN steht: State0, State1...State7

'Color Mode Default': Jede Zeile wird während der Laufzeit eingefärbt. Welche Farbe
das sein soll, wird mit dem Modus bestimmt.

State Color Mode Farbe abhängig von der Ereigniszustand
Group Color Mode Farbe abhängig von der Gruppe
Prio Color Mode Farbe abhängig von der Ereignispriorität

'Display Long Event Texts' markiert bedeutet, lange Texte während der Laufzeit
anzuzeigen.

'Display Event Texts On 2 Lines'  markiert bedeutet, der Text wird in der Spalte auf
zwei Zeilen aufgeteilt. Überlange Texte werden abgeschnitten.

Bereich 'Setup Events Colors' 

1. Farbzuordnung für jeden Modus.

2. Um eine beliebige Farbe zu bestimmen, ist für jede Grundfarbe, also rot, grün und
blau, der Wert 0..255 durch Komma getrennt im Eingabefeld einzugeben.
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3. Die Eingabe wird durch 'OK' bestätigt. 

Ereignis-Texte definieren 

Wie in den vorherigen Schritten erwähnt, können die Ereignis-Texte in der
sprachabhängigen ASV-Datei definiert werden. In diesem Beispiel beginnt jede Datei
mit ‚AL_eventTexts’ an. Während der Laufzeit ergänzt der Browser den Dateinamen
mit einem sprachabhängigen Suffix.

Folgend die vollständige ASV Dateinamensyntax:

AL_Name_LanguageDependantSuffix.ASV

Die kursiv geschriebenen Teil des Namens hängt von Ihrer Konfiguration ab.
Der blaue und fettgedruckte hervorgehobene Teil des Dateinamens ist vordefiniert.
LanguageDependantSuffix referenziert mit dem Wert des HTML-Tags
'LANG_SYMB'.

Das sprachabhängige Suffix ("LanguageDependantSuffix") hat seinen Ursprung in der
entsprechenden CSV-Sprachdatei. Für "LANG_SYMB" benützen Sie bitte kleine
Bezeichnungen mit zwei Buchstaben wie DE, FR oder EN (Die Sprachcodes können
in der ISO 639-1 Norm nachgeschlagen werden). Nach der Definition Ihrer CSV-
Sprachdatei, ist dem HTML-TAG "LANG_SYMB" die entsprechende Sprache
zuzuordnen.

Im Kapitel "Mehrsprachige HMIs", wird beschrieben wie sprachebezogene Dateien wie
z.B "en.csv" erstellt werden.
Die folgenden Zeilen zeigen den Aufbau einer ASV-Datei:

#!Version;1
#!BB1
#!DEFSTATUS;DefStat1;DefStat2;DefStat3;DefStat4;DefStat5;DefStat6;
DEFSTATUS;m y state 1 string;m y state 2 string;
#!EB1
#!BB2
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#!ID;ShortText;DetailedText;Help;Status1;Status2;Status3;Status4;Status5;Status6;
Status N
1;M otor1;Ventilation Kino 1 Cooler pum p m otor1 protection tripped; M otor1 Power;
Norm al;Fault
2;M otor2;Ventilation Kino 2 Cooler pum p m otor2 protection tripped; M otor2 Power;
Norm al;Fault
3;M otor3;Ventilation Kino 3 Cooler pum p m otor3 protection tripped; M otor3 Power;
Norm al;Fault
4;M otor4;Ventilation Kino 4 Cooler pum p m otor4 protection tripped; M otor4 Power;
Norm al;Fault
5;M otor5;Ventilation Kino 5 Cooler pum p m otor5 protection tripped; M otor5 Power;
Norm al;Fault
6;M otor6;Ventilation Kino 6 Cooler pum p m otor6 protection tripped; M otor6 Power;
Norm al;Fault
#!EB2

#!Version, #!DEFSTATUS, #!BB1, #!EB1, #!BB2, #!EB2, are reserved tokens (do not
change these tokens). Other lines beginning with #! will be ignored (can be used for
comments).

Benutzerdefinierte Macro's

Um das Makro auf die eigenen Bedürfnisse anzupassen, entfernen und/oder
verändern Sie die Größe der Schaltflächen / Painter-Objekte. 
Vorsicht: Einige der Objekte 'Event-Painter', werden für den internen Gebrauch
benötigt.

Wenn Sie 'ungroup' (Gruppierung aufheben) und/oder Änderungen vornehmen, wird
das Makro-Setupdialog-Fenster  wahrscheinlich nicht mehr zur Verfügung stehen.
Gruppieren Sie alle Makro-Objekte, um den Dialog wieder herzustellen, oder
verwenden Sie stattdessen den Cross Reference Dialog.

Wichtiger Hinweis:
Der Browser-Client kann keine Alarme-oder Ereignismeldungen laden, wenn
"LANG_SYMB" nicht definiert ist:

Stellen Sie sicher, dass eine gültige CSV-Sprachdatei in Ihrem Projekt definiert und
zur Laufzeit geladen werden kann. Dazu ist es auch wichtig dass der HTML TAG
‚LANG_SYMB’ immer dem sprachabhängige Suffix der ASV-Datei entspricht.
AL_Name_SprachabhängigerSuffix.ASV
Der SprachabhängigerSuffix entrspricht dem Wert des HTML TAG ‚LANG_SYMB’.

Falls keine sprachabhängige CSV-Datei existiert, einfach auf die entsprechende 'CSV'
in der Symbolleiste klicken, um eine zu definieren.
Nachdem die Datei erstellt worden ist, überprüfen, ob die "LANG_SYMB" den
erwarteten Wert hat (im Beispiel 'EN'):
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Verwenden Sie das Menü Project-> Project configurations... und anschliessend
Registerkarte "Applet Advanced Project". Aktivieren Sie die Option "HTML-Parameter
in CSV-Datei" und wählen Sie die CSV-Sprachdatei:

Projekt vorbereiten
1. Wurde eine neue TEQ erstellt, muss eine neue HTML-Datei mit Project-> Generate

HTML.. generiert werden.
2. Wählen Sie File-> Save All ...
3. Kompilieren und laden Sie Ihr Projekt nun mit PG5 in die SPS.

Nutzung des "Event List Macro" während der Runtime

Standartmodus Ansicht
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Tabellenspalten

EventID Ereignis-Kennung

Prio Ereignis-Priorität

Group Ereignis Gruppenzugehörigkeit

Alarm Alarmtyp ID des Ereignisses

Event Text Ereignisbeschreibung

Time On Urzeit des Ereignisses

State Ereignisstatus

Tasten

Advanced Schaltet die Makro-Ansicht auf den "Erweitert"-Modus um

Filter Filteroptionen

Go To Event
Date

Sprung zu angegebenem Datum

Stop Loading
Next

Laden der Daten abbrechen

Reload Event
List

Springt zur ersten Seite und lädt die jüngsten Ereignisse

Erweiterter Modus Ansicht
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Tasten

Advanced Off Schaltet die Makro-Ansicht auf den 'Standard' Modus um

Help Text On Enables the help texts in the yellow rectangle for the 'Default'
mode view

Message Text
On

Ermöglicht das anzeigen des Hilfetextes im gelben Rechteck für
den 'Default'  (Standart) Modus

Short/Long Schaltet zwischen langen und kurzen Ereignisbeschreibungen
um

Save Speichert die Ereignisse im angegebenen Zeitraum (die beiden
Eingabefelder neben der "Save From/To-->" Taste) in eine Datei

Delete Event List Löscht alle angezeigten Ereignisse

State Color
Mode

Wechselt den Farbmodus

Filter Modus Ansicht
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Tabellenspalte

Alarm ID Filter Filtert nach Alarm ID
Im obigen Beispiel sehen wir Ereignise aller Alarm-IDs, da der
Wert -1 im Eingabefeld  'Show events of all alarm IDs' steht.

Set Alr ID Wählen Sie eine der angezeigten Alarmereignisse in der Liste 
und klicken Sie dann auf 'Set Alr ID', um nur die Ereignisse des
gleichen Alarm ID's zu sehen.

Clear Alr ID Zeigt alle Alarm-ID's

Priority Filter Anzeige nach Ereignis-Priorität

Comparison
operator

=   Zeige nur Ereignisse an, welche gleiche PrioN haben.
>   Zeige Ereignisse die eine grösser als PrioN sind.
<   Zeige Ereignisse die eine kleiner als PrioN sind.

Priority to
compare

Vergleiche PrioN mit: Prio0, Prio1...Prio7

Group Filter Filter by Group ID

Comparison
operator

=   Zeige nur Ereignisse, welche die gleiche Gruppen-ID haben
wie GroupN.
>   Zeige nur Ereignisse, welche grössere Gruppen-ID haben, als
GroupN
<   Zeige nur Ereignisse, welche kleinere Gruppen-ID haben, als
GroupN

Group ID to
compare

Vergleiche GroupN mit: Group0, Group1...Group31

State Filter Filter nach ID-Status

Comparison
operator

=   Zeige nur Ereignisse, welche die gleiche State-ID haben wie
StateN
>   Zeige nur Ereignisse, welche eine grössere State-ID haben,
als StateN
<   Zeige nur Ereignisse, welche eine kleinere State-ID haben,
als StateN

State ID to
compare

Vergleiche StateN mit: State0, State1...State7
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21 Werkzeugpalette (Painter)

Sämtliche verfügbaren Painterobjekte können über die Painterobjekte-Symbolleiste
ausgwählt werden.

Painterobjekte haben unterschiedliche Eigenschaften, die über den Eigenschaftsdialog
konfiguriert werden können. Dieser Eigenschaftsdialog lässt sich mit Hilfe eines
Doppelklicks auf das entsprechende Painterobjekt öffnen.

Static Painter Objects
Dynamic Painter Objects

 

21.1 Statische Painterobjekte

Die folgenden Painterobjekte (grafische Objekte) können nicht mit einer externen
Datenquelle verbunden werden. Für allgemeine und spezifische Eigenhschaften siehe
Kapitel 'Property Window'.

Rechteck, Ellipse, Polygon

Diese Painterobjekte sind statisch weil die Werte von Prozessdatenpunkten (PPOs)
oder Container-Variablen nicht direkt angezeigt werden. Dennoch können diese
Painterobjekte mit einer PPO oder einer Container-Variable verknüpft werden, damit
sich deren farbliche Darstellung unter bestimmten Bedingungen anpasst. Diese
Bedingungen können Sie im Eigenschaftsdialog Register Rahmen erweitert festlegen
(Doppelklick auf Painterobjekt).

Linie

Im Eigenschaftsdialog Register Linie erweitert lässt sich der Linienstil festlegen. Eine
Linie hat ansonsten die selben Eigenschaften wie Rechteck, Ellipse oder Polygon.

Bild (Image)
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Über dieses Painterobjekt kann eine Grafik dargestellt werden (GIF oder XBM). Im
Eigenschaftsdialog Register Repaints (Doppelklick auf Painterobjekt) kann eine
Bedingung festgelegt werden, durch die die Grafik automatisch durch ein zweite
ausgetauscht wird. Die Bilder müssen ins Zielsystem kopiert werden. Das Bild wird auf
die Grösse des Painters skaliert. Falls das Bild einen transparenten Hintergrund hat,
wird die Hintergrundfarbe des Painters sichtbar.

Multi Line Label

Painterobjekt zum Anzeigen von Texten über mehrere Zeilen. Die Quelle ist ein
statischer Text oder ein sprachabhängiger HTML Tag. Siehe Kapitel Property Window
für Details.

21.2 Dynamische Painterobjekte

Dynamische Painterobjekte lassen sich mit einem Prozessdatenpunkt (PPO) oder mit
einer Container-Variable verknüpfen. Dadurch lassen sich die PPOs bzw. Container
Werte anzeigen und ändern. Wie bei den statischen Paintern lässt sich auch hier die
Farbdarstellung in Abhängigkeit einer PPO oder eines Containers konfigurieren.

Statischer Text (Static Text)

Das Painterobjekt 'Statischer Text' dient zur Ausgabe eines beliebigen statischen
Textes. Es ist jedoch auch möglich einen dynamischen Wert einer PPO oder einer
Container-Variable anzuzeigen, diese können allerdings nicht editiert werden. Dies
lässt sich im Feld Typ ändern, welches Sie im Eigenschaftsdialog Register Repaints
finden (Doppelklick auf Painterobjekt). Die Farbdarstellung sowie die Textausrichtung
lassen sich ebenfalls mit dem Eigenschaftsdialog konfigurieren.
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Edit Box (Eingabefeld)

Mit dem Painterobjekt 'Edit Box' lässt sich ein Prozessdatenpunkt (PPO) oder eine
Container-Variable verändern und anzeigen. Wenn Sie das Eingabefeld mit einem
Prozessdatenpunkt (PPO) verknüpfen möchten, wird ein symbolischer Name
verwendet, der später über den Menubefehl Projekt->Init PPOs... mit dem richtigen
Prozessdatenpunkt des Zielsystems verknüpft wird. Wählen Sie zwischen einer PPO
oder einer Containter-Variable im Feld Typ, welches Sie im Eigenschaftsdialog
Register Repaints finden (Doppelklick auf Painterobjekt). Geben Sie nun den
Variablennamen im Feld Name ein.

Button (Schaltfläche)

Mit einer Schaltfläche (Button) lassen sich Prozessdatenpunkte (PPOs) setzen, Views
bzw. Webseiten aufrufen oder Variablen inkrementieren. Nehmen Sie diese
Einstellungen im Eigenschaftsdialog Register Actions vor (Doppelklick auf
Painterobjekt). Die Beschriftung der Schaltfläche legen Sie im Eigenschaftsdialog
Register Repaints fest. Hierfür können Sie die Typen CONTAINER, PPO, FILE,
STRING oder HTML-TAG verwenden.

Bargraph (Balkendiagramm)

Mit einem Balkendiagramm (Bargraph) lässt sich der Wert eines
Prozessdatenpunktes oder einer Container-Variable grafisch darstellen. Hierzu
definieren Sie einen Minimal- und Maximalwert im Eigenschaftsdialog Register
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Bargraph erweitert. Die Skala und Orientierung des Balkendiagramms lässt sich
ebenfalls hier definieren.
Weitere Informationen finden Sie im Kapitel Eigenschaftsfenster.
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22 Editor Übersicht

Dieses Kapitel beschreibt sämtliche Funktionen und Menus welche für den S-Web
Editor zur Verfügung stehen.

Hauptmenu
Eigenschaften Dialog
Funktionen für Gruppen
Funktionen zur Makrobibliothek

 

22.1 Menuleiste

Datei Menü

New Project Erzeugt ein neues S-Web Projekt

Open Project Öffnet ein S-Web Projekt

Close Project Schliesst das aktive S-Web Projekt

Save All Speichert alle Dateien des geöffneten S-Web Projekts

New file... Fügt einem geöffneten Projekt eine neue Datei hinzu

Open Öffnet eine S-Web Editor Datei

Close Schliesst das aktive Dokument

Save Speichert das aktive Dokument

Save As... Speichert das aktive Dokument unter neuem Namen

Close All Schliesst alle geöffneten Dateien

Print setup … Druckeinstellungen ändern...

Print preview Druckvorschau des aktiven Dokumentes anzeigen

Print Aktives Dokument Drucken

Exit Beendet den S-Web Editor.

Editieren Menu

Undo Letzte Aktion rückgängig machen

Redo Rückgängig gemachte Aktion wiederholen

Cut Markiertes ausschneiden und in Zwischenablage speichern

Copy Markierung in Zwischenablage kopieren

Paste Aus Zwischenablage einfügen

Delete Objekt löschen

Select All Alles auswählen
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View Menu

Toolbar Toolbar sichtbar/unsichtbar

Status Bar Statusleiste sichtbar/unsichtbar

Painters Library
Toolbar

Painterobjekt-Bibliothek Toolbar sichtbar/unsichtbar

Layout Toolbar Layout Toolbar sichtbar/unsichtbar

Project Files
Toolbar

Projektdateien sichtbar/unsichtbar

Painter Library
Toolbar

Painterobjekt Werkzeugpalette sichtbar/unsichtbar

Zoom Ansicht verkleinern/vergrössern

Projekt Menü

Add to project  

New Erzeugt ein neue TEQ-Datei (Bildschirmseite)

File Fügt dem Projekt eine Datei hinzu

Remove from
Project...

Datei vom Projekt entfernen

Remove/Delete
from Project...

Datei vom Projekt entfernen und auf Datenträger löschen

Import PPOs file
(tcr)...

Importiert PPO-Datei 
(Dateien mit Erweiterung ".tcr")

Import Containers
file (itq)...

Importiere Datei für Container-Initialisierung  
(Dateien mit Erweiterung ".itq")

Reload HDLog
Files...

Konfiguriert die Projekt Grundeinstellungen. 
Änderungen an den Einstellungen werden nur von neuen
TEQ-Dateien (Bildschirmseiten) übernommen.

Project Configuration -> TEQ Configurations
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Width:
Standardbreite beim neuerstellten von TEQ-Seiten in Pixel.
Während der Laufzeit ist das HMI massgebend.

Height:
Standardhöhe beim neuerstellten von TEQ-Seiten in Pixel.
Während der Laufzeit ist das HMI massgebend.

Background Color: Standard Hintergrundfarbe

Foreground Color: Standard Schrift-/Rahmenfarbe

Font: Standard Schriftart und Grösse für neue Painterobjekte

Outline Width: Default Aussenlinie Breite für Painterobjekt (in Pixel)

Outline Style:
Default Aussenlinie Typ für Painterobjekt (durchgehend,
gestrichelt oder gepunktet)

background TEQ: Standard Hintergrund-TEQ

foreground TEQ: Standard Vordergrund-TEQ

csv files (update):

Liste der CSV-Dateien die vom Editor aktualisiert werden.
Wenn Sie eine neue 'HTML TAG' Referenz erstellen, wird
der Editor diese automatisch in die Liste zu Ihren bereits
existierenden CSV-Dateien hinzufügen (Project->Generate
HTML TAGS CSV file). Der Editor behält alle Übersetzungen,
welche Sie bereits gemacht haben. Sollten Sie 'HTML TAG'
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Referenzen von Ihrem HMI löschen, wird der Editor einen
Dialog anzeigen. Sie können dann zwischen "behalten" oder
"löschen" Ihrer alten 'HTML TAG' Referenz wählen.

(Siehe Kapitel Mehrsprachige HMI's)

scalable html:

Wählen Sie 'Hinzu' um ein HTML für eine andere
Darstellungsgrösse Ihres HMIs zu erstellen. Der Faktor 2.0
vergrössert auf 200% ohne dass dazu die TEQ-Seiten
angepasst werden müssen. Je nach gewünschter HMI
Grösse, kann der Benutzer zur Laufzeit eine andere HTML-
Datei aufrufen und die TEQ-Seiten werden vom Micro-
Browser und IMaster-Applet auf die eingestellte Grösse
skaliert.

Faktor 2.000000 bedeutet 200% of 640x480,
entspricht1280x960

Bitte Beachten:
"Down-Scaling" (Faktoren < 1.0) ist mit dem IMaster-Applet
möglich. Mit den Micro-Browser funktioniert das "Up-
Scaling" (Faktoren > 1.0) korrekt. "Down-
Scaling"funktioniert nicht korrekt und wird deshalb nicht
empfohlen!

Klicken Sie 'Add' um einen neue Skalierung zu wählen. Sie
haben keine manuellen Eingaben zu machen. Nach dem
nächsten 'Build All' wird der S-Web Editor die neuen HTML
Dateien generieren und hinzufügen.

Saia HDLog Files: Ablage der HDLog Datei

Saia Project type: Saia Standard oder Saia XX7

Project configurations -> Applet Advanced
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Debug Debug-Modus ein-/ausschalten (es werden diverse
Meldungen in der 'Java Console' ausgegeben)
Wenn Sie mit Internet Explorer und Sun Java Plugin
arbeiten öffnen sie die Java Console mit Tools -> Sun Java
Console
Wenn Sie mit Internet Explorer und Microsoft Plugin
arbeiten öffnen sie die Java Console mit Tools -> Java
Console

Order per view Prozesspunktdaten pro TEQ-View abfragen. Es werden nur
PPOs der aktuellen Views aktualisiert.

Trend/Alarm Date/
Time Format

Format Example
dd.mm.yyyy HH:mm:ss 01.12.2009 16:09:03
yyyy.mm.dd hh:mm:ss a 2009.12.01 04:09:03 pm
dd.mm.yy HH:mm:ss* 01.12.09 16:09:03
yy.mm.dd hh:mm:ss a* 09.12.01 04:09:03 pm
dd-mm-yyyy HH:mm:ss* 01-12-2009 16:09:03
yyyy-mm-dd HH:mm:ss* 2009-12-01 16:09:03
dd-mm-yy HH:mm:ss* 01-12-09 16:09:03
yy-mm-dd HH:mm:ss* 09-12-01 16:09:03
* not yet supported by MicroBrowser client
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Encode Special
Chars

Stellt sicher, dass Sonderzeichen in PPO-Namen richtig
aufgelöst werden (andere als 7-Bit ASCII)

Decimal Symbol:
Definiert das dezimale Symbol in Log Dateien für Trend
Macros.

period (ms): Aktualisierungsintervall der Prozessdatenpunkte in
Millisekunden

main TEQ: Startbild beim Laden des HMIs

Meldung Box Aktiviert die Meldungs-Box (MsgBox.teq) im Browser, um
Fehlermeldungen anzeigen zu können. Z.B. bei über bzw.
unterschreiten von Eingabewerten.  
(siehe Kapitel Initialisierung Processdatenpunkte (PPO's)).

Meldung box TEQ

Dateiname der 'Meldung Box TEQ'. Normalerweise sollten
Sie diesen Dateinamen nicht ändern.  Löschen Sie den
Dateinamen wenn Sie während dem Betrieb keine
Warnungen oder Alarme sehen möchten.

Nbr Errors / Warn: Nach Anzahl 'Nbr' CGI-Fehlern wird eine Meldung
angezeigt.
Z.B. nach 3x CGI-Anfragen wird eine Warnmeldung
angezeigt.

Warn display time: Anzeigedauer der Fehler in Sekunden 
(0 bedeutet keine automatische Fehleranzeige)

HTML Parameters in
csv file

Aktiviert die Verwendung von CSV-Dateien

csv file: Bei mehrsprachigen HMIs wird hier die CSV-Datei der
Sprache die zuerst aktiv sein soll gewählt (siehe 
Mehrsprachige HMI's).

static csv file:
Die hier eingetragene CSV-Datei wird beim Applet Start
einmalig geladen und kann nicht ausgetauscht werden.

Action mode: Wie ein Mausklick behandelt wird.

BROADCASTED
ACTION

Bei übereinander liegenden Painterobjekten erhalten alle
Painterobjekte das Event (z.B. Mouse Down).
BROADCASTED ACTION sollten nicht für neue Projekte
verwendet werden. Kann aber aus Kompatibilitätsgründen
verwendet werden.

CONSUMED
ACTION

Nur das oberste Painterobjekt erhält das Event. Falls dieser
das Event nicht verwertet, wird es an das Painterobjekt
darunter gesendet.

Browsing Mode:

DEFAULT Im Standardmodus navigieren die Clients unabhängig
voneinander.

MIRROR Der Name der aktuellen Ansicht wird in einem PPO
gespeichert. So wird jeder  Client die gleiche Ansicht zur
selben Zeit sehen.
MIRROR sollte nicht für neue Projekte verwendet werden.
Kann jedoch aus Kompatibilitätsgründen verwendet werden.

Mirror PPO Name Festlegung des Namens des PPO, der den Namen der
aktuellen Ansicht während der Laufzeit enthält.
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Loading Mode: Diese Optionen steuern die Art und Weise, wie die Java
Virtual Machine  das MMI lädt. Der Upload-Mechanismus
kann vom Anwender für verschiedene Situationen optimiert
werden.

Standard Load

Standarteinstellung
Lädt alle TEQ-Dateien bei der Initialisierung und speichert
während des Betriebs alle Objekte in das RAM. Diese
Einstellung erlaubt die schnellst mögliche Reaktionszeit
während des Betriebs. 

Load When Needed
& Keep Objects

Optimiert für Operationen mit langsamen Modem-
Verbindungen. Der Browser ist ein Standard PC mit
limitiertem RAM Speicher.
Lädt die TEQ-Datei und speichert die Objekte in das RAM
wenn der Anwender das erste Mal die TEQ-Datei aufruft.

Load When Needed
& Keep Teqs

Optimiert für Operationen mit langsamen Modem
Verbindungen. Der Browser hat ein Java VM mit limitiertem
RAM Speicher.
Lädt die TEQ-Datei nur wenn der Anwender das erste Mal
die TEQ-Datei aufruft und behält nur die  TEQ-Datei im
RAM (keine TEQ-Datei Objekte)

Load When Needed
& Keep Nothing

Optimiert für Operationen mit langsamen Modem
Verbindungen. Der Browser hat ein Java VM mit sehr
limitiertem RAM Speicher.
Lädt die TEQ-Datei nur wenn der Anwender die TEQ-Datei
aufruft und nach einem TEQ-Jump werden alle TEQ-View
Dateien und Objekte vom RAM gelöscht.

Project Configuration -> Build Advanced
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Make Memory Foot
Print Check

Prüft den Speicherbedarf des Projektes für die gewählte
Hardware.

Force Teq Files
saving as 5_13
format (in["..\Html"]
folder)

Option für die Verwendung von MicroBrowser Clients die
nicht ein TEQ-Format mit der Version höher als 'g'
unterstützen. Wird ein bestehendes Projekt geändert, wird
es automatisch auf das neue Format konvertiert. Diese
Option ist nur aktiv, solange keine Funktionen verwendet
werden, die ein neues Format erfordern. Wird dies
gemacht, wird der Editor eine Warnung ausgeben.

5.14 Dateiformat wird nicht auf älteren Mikrobrowsern
ausgeführt, ausser ein Firmware-Update wird zuvor
durchgeführt.

Convert project's
GIF to BMP

Erzeugt für jedes GIF ein monochromes Bild im BMP-
Format

Generate Font files
Erstellt die S-Web-Editor '.FNT' Font-Dateien für den
NanoBrowser nach den definierten HTML-Tags und
Schriftarten.

Generate/Update
Scalable html files

Generiert oder updated die scalierbaren HTML-Dateien

Generate/Update
language csv files

Generiert oder updated die CSV Sprach-Dateien

Generate html file Generiert die HTML-Datei

Update containers/
ppo init files (ITQ/
TCR)

Die geänderten Dateien werden gespeichert und die
Container / PPO Initialisierungsdateien (ITQ / TCR) werden
aktualisiert.

Save modified files
(TEQ)

Alle modifizierten Dateien werden durch 'Build All'
gespeichert.

Add Macro files in
project sub folder

Bereitstellen der Makro-Dialoge im Projekt. Ist diese Option
nicht aktiviert und wurden einige Makros nicht verwendet,
zusätzlich das Projekt in einem anderen Editor geöffnet,
werden die entsprechenden Dialoge nicht zur Verfügung
stehen und stattdessen der CrossRef Dialog angezeigt.

Warn User If
Problem On Add
Macro Files in
Project Sub Folder

Wird ein Makro ins Projekt eingefügt, wird ein temporäres
Verzeichnis mit einigen Einstellungen kopiert. Diese
Einstellungen sind für Makros mit Dialogen erforderlich.
Fehlt dieses Verzeichnis, wird das Makro während der
Laufzeit trotzdem ausgeführt. Diese Einstellung erlaubt die
Warnung im Falle eines fehlenden Verzeichnises zu
unterdrücken, .

Check For Unused
HTMLTAG

Falls nicht genutzte HTML TAGs durch "Build all" gelöscht
werden sollen, ist diese Checkbox zu deaktivieren (z.B.
sinnvoll, wenn spezielle HTML-TAG Offset-Syntax genutzt
werden).

Check For
Forbidden Char In
Project's File Names

Einige Web-Server vertragen spezielle Sonderzeichen in
Dateinamen nicht. Falls dazu eine Warnung erwünscht ist,
einfach die Checkbox aktivieren.
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Project configurations -> Advanced

2 Bits colors paint Stellt das ganze HMI in Graustufen dar, um zum Beispiel
die Ansicht mit dem eDisplay zu simulieren

Hardware profile Pfadangabe zu den Hardware-Profilen. Der S-Web Editor
benutzt dieses Profil um den 'Memory Foot Print Check'
auszuführen.

Macro Lib Path Pfadangabe zur Macro-Bibliothek ( Arbeiten mit Macros )

Rastereinstellungen (Grid configuration)

Konfiguriert das Hilfsraster. Ist die Option "Ausrichtung am Raster" aktiv, werden nur
markierte oder neu eingefügte Painterobjekte am Raster ausgerichtet.
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Grid visible Raster Ein/Aus

Grid snap Symbole an Raster ausrichten

X: Horizontaler Rasterabstand

Y: Vertikaler Rasterabstand

Rasterfarbe: Rasterfarbe

Init Containers...

Siehe Kapitel Initialisierung der Container

Init PPOs...

Siehe Kapitel Initialisierung Processdatenpunkte (PPO's)

Generate HTML...

Aktualisiert/erstellt das HTML, in welchem das Java-Applet und andere Komponenten
enthalten sind.

Build All

Aktualisiert/erstellt verschiedene für das HMI benötigte Dateien(Siehe
Projekteinstellungen)

Download Project

FTP-Download Dialog
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Generate HTML Tag CSV File

Siehe Kapitel Mehrsprachige HMI's

Generate Cross Ref file...

Erstellt eine Cross Ref Datei zum geöffneten Projekt. Verschiedenste Referenzen aus
allen zum Projekt gehörenden Dateien werden in einer Datei aufgelistet.
('projectnameCrossRef.txt')

Generate Scalable HTML files

Erstellt projektspezifisch, skalierbare HTMLs

Generate Font files

Erstellt Schriftdateien welche alle benötigten Charakter für die HTML-Tags enthalten

Convert project's Gif to Bmp

Erstellt für jedes GIF ein monochromes Bild im BMP-Format

TEQ view configurations...
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Width: Breite der TEQ-View in Pixel

Height: Höhe der TEQ-View in Pixel

Background Color: Hintergrundfarbe der TEQ-View und Painterobjekts

Foreground Color: Schrift-/Rahmenfarbe des Painterobjekts

Font: Schriftart des Painterobjekts

Outline Width: Liniendicke des Painterobjekts

Outline Style: Linienart des Painterobjekts

background TEQ Hintergrund TEQ-View

foreground TEQ Vordergrund TEQ-View

Project info
replace

Unbedingt ein HMI Backup erstellen, bevor 'Project info replace'
benutzt wird. Änderungen können nicht mehr rückgängig gemacht
werden!

Konfiguriert die Grundeinstellungen des aktiven Grafikbildes (TEQ-
View) sowie von Grafiksymbolen (Painterobjekten). Änderungen
werden nur von neuen Grafiksymbolen übernommen.
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Referenzen des gesamten Projektes können gezielt ersetzt werden.
Erstellen Sie zuvor eine Sicherungskopie ihres Projektes. Die
Änderungen wirken sich jeweils direkt auf ihr gesamtes Projekt aus.
Eine Info kann eine Referenz zu einer der folgenden Typen sein: PPO,
HTML TAG, STRING, FILE, CONTAINER, TEQ INDEX, URL,
PASSWORD PPO, PASSWORD CONTAINER, CGI, FKEY.
Im Beispiel wird PPO mit dem Namen 'PDP,,R1003,d' ersetzt, und mit
'PDP,,R1005,d' im ganzen S-Web Editor Projekt.

Hilfe Menü

About...
Öffnet einen Dialog und zeigt Versions- und weitere
Produktinformationen an

Layout Menu

Align  

Left Ausrichten an der linken Kante.

Right Ausrichten an der rechten Kante aus.

Top Ausrichten an der oberen Kante aus.

Bottom Ausrichten an der unteren Kante aus.

Center  

Horizontally Zentriert Grafiksymbole horizontal

Vertically Zentriert Grafiksymbole vertikal

Make same size  

Width setzt die Breite der Grafiksymbole gleich

Height setzt die Höhe der Grafiksymbole gleich

Both setzt Höhe und Breite gleich

Order  

To Back Versetzt das Grafiksymbol eine Ebene nach hinten
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Align  

To Front Versetzt das Grafiksymbol eine Ebene nach vorne

Group  

Group Gruppiere die selektierten Grafiksymbole

UnGroup Gruppierung der Objekte aufheben

Edit Polygon points Einzelne Punkte eines Polygons ändern

Cross Ref... Öffnet den Cross Ref Dialog (siehe Gruppenfunktion)

Rotate Polygon Das Polygon um einen bestimmten Winkel drehen

Tools Menü

Tool
Configurations

In Vorbereitung

22.2 Eigenschaftsfenster

Mit einem Doppelklick auf ein Painterobjekt öffnet sich der Eigenschaftsdialog. Die
Eigenschaften sind in mehrere Registern gruppiert. Jedes Painterobjekt
(Grafiksymbol) hat seine eigenen Eigenschaften so dass nicht immer alle Register des
Eigenschaftsdialog verfügbar sind.

Dialog Tabs (Tabs=Registerreiter)

General (Allgemein)

Diese allgemeinen Format-Eigenschaften besitzen alle Painterobjekte
(Grafiksymbole). Hier lassen sich Position, Grösse, Rahmen- und Füllfarbe sowie die
Schriftart einstellen.

Die X-Achse verläuft von links nach rechts, die Y-Achse von oben nach unten, sodass
der Nullpunkt sich in der linken oberen Ecke befindet. Die Schriftarten stammen von
der Java Virtual Machine. Es ist nicht möglich PC-Fonts zu benützen. Von System zu
System (Browser) kann es zu kleineren Unterschieden in der Schriftdarstellung
kommen.

Mit 'Hide and Disable for Groups' können Sie eine Grupppe ein-oder ausschalten. Sie
können ebenfalls eine Kondition definieren, welche wahr sein mus wenn die Gruppe
ein- oder ausgeschaltet sein soll.

Mit Painterobjekt X Offset und Painterobjekt Y Offset ist es möglich, ein Offset (in
Pixel) zu definieren. Während Laufzeit berechnet der Browser die neue Painterobjekt
Position bei jedem "repaint" neu.
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Repaints Tab (Darstellung)

Diese Eigenschaften bestimmen die Darstellung der Painterobjekte (Grafiksymbole).
Für sämtliche Painterobjekte (Grafiksymbole), die in der Lage sind, eine Datenquelle
(Source) darzustellen - wie Statischer Text, Edit Box, Bild, Bargraph oder Button - sind
die Eigenschaften Source bearbeiten und Source2 bearbeiten verfügbar. Damit lassen
sich bis zu zwei Datenquellen (Source) einbinden und mit einer Bedingung
verknüpfen.

CONTAINER Damit lässt sich ein Painterobjekt mit einer internen Variablen
verknüpfen. Diese Variablen sind nur innerhalb des HMI
sichtbar und können mit dem Menübefehl Projekt-
>InitContainers initialisiert werden.

FILE Damit lässt sich beispielsweise eine *.png auf einem Button
oder Bild Painterobjekt darstellen.

PPO Damit lässt sich ein Painterobjekt mit einem
Prozessdatenpunkt (PPO) verknüpfen. Der
Prozessdatenpunkt kann im Feld Namen als symbolisch
angegeben werden. Mit dem Menübefehl Projekt->InitPPOs
lassen sich alle diese symbolischen Namen mit den richtigen
SPS-spezifischen Prozessdatenpunkte verbinden.

HTML_TAG Damit lässt sich ein Text als HTML-TAG konfigurieren. Um
den Namen "Eingeschaltet" später zu übersetzen müssen Sie
den Typ "HTML Tag" wählen. Momentan würde in der
entsprechenden View der Name "Eingeschaltet" angezeigt.
Sie können nun aber in der HTML-Startseite
<ihr_projektname>.html manuell Zeilen der Form <PARAM
NAME="<Eingeschaltet>" VALUE="On"> einfügen. Je nach
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Value wird nun der Text „On“ in Ihrem HMI dargestellt. Mit
verschiedenen Versionen der Startseite für jede Sprache
lassen sich so mehrsprachige HMIs realisieren.

STRING Damit lässt sich ein beliebiger Text anzeigen

Um diese Möglichkeiten zu Nutzen muss das Kontrollkästchen Source bearbeiten
bzw. Source2 bearbeiten aktiviert werden. Danach können Typ, Name der Datenquelle
(Source) sowie Bedingung definiert werden.

Um ein Bild einzüfügen müssen Sie ein Image Painterobjekt kreieren. Doppelklicken
Sie anschliessend auf das Painterobjekt, wählen Sie den Ritter 'Repaints'. Setzen Sie
'Edit a Source', wählen Sie 'Container' im Drop Down Verzeichnis, klicken Sie auf
'Browse' and wählen Sie das gewünschte Bild. Mit 'On Condition' können Sie das Bild
an eine bestimmte Kondition binden. Wählen Sie 'Hide Painter On Condition' wenn
das Bild verborgen sein soll.

Es bietet sich die Möglichkeit, für jedes Painterobjekt zwei Repaint Bedingungen zu
verknüpfen. Mit 'On Condition' aktivieren Sie die jeweilige Bedingung.

On Conditions (Bedingungen)

Ermöglicht  in Abhängigkeit von Bedingungen das Anzeigen / Verbergen bzw.
deaktivieren / aktivieren von Painterobjekten.
Funktionsbeschreibung: Die beiden Datenquellen werden in doppelt präzise
Fliesspunktwerte umgewandelt. Ist dies nicht möglich, wie z.B. bei Variablen mit einem
String, versucht es zu überprüfen ob beide Strings gleich sind. Wenn sie nicht gleich
sind, wird die Länge des Strings verglichen werden.

Aktion Set Variables Tab (Aktionen bei linken Mausklick)

Dieses Register ist nur für Button-Painterobjekt verfügbar.
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Variablen können entweder bei "Mouse DOWN" (Maustaste gedrückt) oder "Mouse
UP" (Maustaste losgelassen) gesetzt werden.

Actions Toggle Increment Variables Tab (Elementstatus umschalten)

Dieses Register ist nur für Button-Painterobjekt verfügbar.

Inkrementieren bzw. Togglen einer Variable.

Actions Jump Tab (Sprungaktion)

Dieses Register ist nur für Button-Painterobjekt verfügbar.
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Mit "View Jump" kann über den Dateinamen auf eine spezifische TEQ-View
gewechselt werden.
Mit "Back Button" kann immer auf die vorherige TEQ-View gewechselt werden. Mit
"URL Jump" kann auf eine HTML-Seite gewechselt werden.

Hide and Disable Painter Tab (Painterobjekt sichtbar / unsichtbar)

Hide Painter Painterobjekt ein-/ausblenden, wahlweise abhängig von
einer Bedingung.
Disable Painter's Actions Painterobjekt  aktivieren/deaktivieren, wahlweise
abhängig von einer Bedingung.

Border Advanced Tab (erweiterte Farbeinstellungen)

Mit diesen Eigenschaften lassen sich die Farben in Abhängigkeit von einer Variablen
(PPO oder Container) steuern. Sie sind für alle Painterobjekt (Grafiksymbole)
verfügbar. Mit der Option Zwei Farben lässt sich einstellen ob man - in Abhängigkeit
einer Variablen - zwei oder drei Farben steuern will.Mit zwei Farben lässt sich eine
Variable auf 0 oder 1 testen und jedem Fall eine eigene Farbe zuordnen. Dies sowohl
für die Füllfarbe als auch für die Rahmenfarbe. Mit drei Farben lässt sich eine Variable
gegenüber einem Minimum und Maximum testen. Daraus ergeben sich drei Fälle,
denen man je eine eigene Farbe zuordnen kann. Dies sowohl für die Füllfarbe als
auch für die Rahmenfarbe.

Sowohl Füllfarbe als auch Rahmenfarbe lassen sich in Abhängigkeit einer Variablen
sichtbar oder unsichtbar schalten.
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Text Positions Advanced Tab (Textausrichtung)

In diesem Eigenschaftsdialog Register lässt sich die Textausrichtung in Abhängigkeit
einer Variablen steuern. Dies ist nur für die Painterobjekte (Grafiksymbole), Statischer
Text und Button (Schaltfläche) möglich.

Bargraph erweitert Tab (Balkendiagramm)

Hiermit lässt sich ein Bargraph (Balkendiagramm) konfigurieren. Neben der Angabe
von Minimum und Maximum, lassen sich die Orientierung sowie die Skala einstellen.
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Source Ranges: Konfiguriert den min. und max. Wert welcher angezeigt
werden soll. Der min. Wert entspricht einem leeren Barograph
(0 %), der max. Wert einem vollen Barograph (100%).

Orientation: Setzt die Orientierung des Barographs

Scale: Konfiguriert den Abstand der Skalierung

Linie Advanced (Linienenden)

Hier kann zwischen vier verschiedenen Linienstilen gewählt werden.

Painterobjekt Konfiguration

Im Hauptfenster unten links ist die Baumansicht für die Painterobjekt-Konfiguration.
Klicken Sie auf ein Painterobjekt um zu bewirken, dass dessen wichtigste Infos in
diesem Fenster angezeigt werden. Informationen zu Repaints und Aktionen werden
dargestellt. Sie können Infos über 'Rename Info' direkt ändern.
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Function Keys (Funktionstastenbelegung)

Das "Function Keys" Register ist nur für Button-Painterobjekt verfügbar. Für jeden
Button kann eine Tastenkombination definiert werden: Die Tasten 'F1' bis 'F12' haben
eine speziellen Syntax. Sie müssen z.B. 'FKEY_1' für 'F1' definieren.
('FKEY_1'...'FKEY_12').
Diese Funktionalität ist nur im MicroBrowser, nicht aber im Java-Applet Webbrowser
Client vorhanden.

Multiline Label (Mehrzeilige Texte)

"Multiline Label" kann Texte über mehrere Zeilen anzeigen.
Die Option "Automatischer Zeilenumbruch" sorgt dafür, dass die Zeile automatisch
umgebrochen wird, wenn die Zeilenlänge überschritten wird.
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Entweder wird ein statischer Text direkt eingegeben oder es wird ein HTML-Tag als
Quelle definiert. In der CSV-Datei müssen Sie mit '\n' (als zwei Charakter) arbeiten,
um eine neue Linie zu erhalten.:

line1\nline2\nline3
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22.3 Gruppenfunktion

Gruppieren / Gruppierung aufheben

In dem Sie verschiedene Painterobjekte gruppieren, können Sie die Eigenschaften
gemeinsam ändern. Des weiteren können solche Gruppen als Makro gespeichert
werden.

Selektieren Sie die Painterobjekte die zur Gruppe gehören sollen. Ziehen
Sie mit der linken Maustaste gedrückt einen Rahmen um die gewünschten
Painterobjekte. Drücken Sie die SHIFT Taste um einzelne Painterobjekte zu
selektieren. Um die gewählten Painterobjekte zu Gruppieren, klicken Sie auf
das entsprechende Symbol (siehe Icon links).

Klicken Sie auf das nebenstehende Symbol um eine Gruppierung
aufzuheben

Um Eigenschaften für Gruppen zu definieren, klicken Sie doppelt auf die gewünschte
Gruppe.

Advanced Select Tab (Erweiterte Auswahl)

Im Reiter 'Erweiterte Selektion' können Sie die Eigenschaften Dialoge der einzelnen
Painterobjekte einzeln aufrufen.Doppelklicken Sie auf eine Painterobjekt-Gruppe
welche Sie konfigurieren wollen.



217

Saia-Burgess Controls AG Editor Übersicht

Gruppenfunktion

Handbuch S-Web Editor | Dokument 26-838 DE06 | 2011-06-22

General Tab (Allgemein)

Hier können Eigenschaften wie Grösse, Position, Farbe, Rahmen oder Schriftart
festgelegt werden. Für alle Eigenschaften können Sie die Checkbox aktivieren, um
anzugeben ob Sie die Eigenschaft für alle Painterobjekte neu setzen wollen.
Painterobjekt-Eigenschaften und Gruppeneigenschaften können nicht gleichzeitig
angepasst werden!

Wählen Sie 'OK' um Ihre Änderungen zu bestätigen.

Aktivieren Sie die Checkbox 'Set Group Properties' wenn Sie eine Gruppe selektiert
haben.

Cross Ref Tab ()

Im Dialog 'Cross Ref' können Sie alle Strings und Referenzen für die Painterobjekte in
der Gruppe mit einem Klick angepasst werden. Diese Funktion ist sehr hilfreich wenn
Sie viele Painters benutzen.
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Wählen Sie den gewünschten Eintrag, ändern ihn im Eingabefeld und klicken danach
'Update'

Taste 'Macro Find/Replace' hilft dabei, schnell alle vorkommenden Gruppennamen in
Makros zu ändern.

Mit Taste 'Find/Replace' kann ein String (Zeichenfolge) oder Teile davon, schnell für
alle ausgewählten Painterobjekte angepasst werden.

Die Farbinformation (R,G,B Werte), welche Sie in 'Cross Ref' sehen, wurde in 'Border
Advanced' Ritter des Bargraph Painterobjekt definiert:
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22.4 Eigene Makrobibliothek

Über die Funktionen der Makrobibliothek können Sie einfach eigene Painterobjekte als
Makros speichern. Die Bibliothek ist das Verzeichnis 'MacroLib' im S-Web Editor
Programmordner.

Eigenes Makro speichern

Nachdem Sie ihr eigens Painterobjekte aus den zur Verfügung stehenden 'Basis' Paintern
erstellt haben, können Sie es in der Makrobibliothek speichern. Wählen Sie Library menu
the command Insert object into Library... . Ein Dialog zum Speichern des Makros im
MacroLib Verzeichnis erscheint. Makros haben eine *.esm Dateiendung. Frühere Editor
Versionen verwendeten eine *.tlb Dateiendung. Der Editor ist zum alten *.tlb Makroformat
kompatibel.

Makro aus Bibliothek einfügen

Über Menu Library->Get object from library...  können Sie ein Makro in die geöffnete TEQ-
View einfügen. Normalerweise müssen nach dem Einfügen zuerst Referenzen im Cross
Ref Dialog angepasst werden. Dies geschieht durch Doppelklick auf Tab 'Cross Ref'.

Makro aus Bibliothek entfernen
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Das entfernen von Makros aus dem MacroLibrary-Verzeichnis geschieht mit Menu Library
-> Remove macro from Library ...  . 
Im anschliessenden Dialog kann das zu löschenden Objekte ausgewählt werden.

Macro aus Bibliothek ändern

Mit der Menüfunktion Library -> Remove object from library.. kann eine bestehende
Bibliothek Objekt geändert werden. Vorhanden Makros sollten nicht überschrieben
werden.

Siehe unter 'Working With Macros'

22.5 Benutzerdefinierte Farben

Sobald Sie eine Farbe im S-Web Editor definieren erscheint der 'Custom Color
Dialog'.
Dieser Dialog ermöglicht es, entweder eine Basisfarbe oder eine selbst definierte
Farbe auszuwählen.
Um eine eigene Farbe zu definieren bedienen Sie sich mit einer Farbe aus der Matrix
oder wählen Sie einen spezifischen RGB Wert und klicken Sie auf 'Add to Custom
Colors'.

Wenn sie den S-Web Editor schliessen sind die Beutzer-Farben verloren!
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23 Störungsbehebung

23.1 WYSIWYG für Schriften

Das Prinzip von WYSYWYG (what you see is what you get) ist im S-Web Editor
bezüglich Schriftart und Schriftgrösse ist beschränkt. Ein absolut identisches
Verfahren auf allen verschiedenen Plattformen (Editor, Java Clients auf verschiedenen
OS's, MicroBrowser XP, CE und Embedded) kann aufgrund unterschiedlichen
Schriftbibliotheken nicht garantiert werden. 

Die Schrift wird im Betrieb nicht in jedem Fall so dargestellt wie im S-Web Editor
ersichtlich. Dies, weil nicht jedem Client (MicroBrowser, Sun VM oder Microsoft VM)
die selben Schriftressourcen wie dem S-Web Editor zur Verfügung stehen. 

Wenn Sie eine spezifische Schrift im S-Web Editor auswählen, wird ihr Client
automatisch eine ähnliche Schrift wählen. 

Wenn Sie wählen z.B. eine Schriftart welche nur in grosser Schrift verfügbar ist , kann
dies zu Darstellungsproblemen von Textfelder führen, da diese dann möglicherweise
zu klein sein können. Um dieses Problem zu umgehen, verkleinern Sie die Schrift oder
vergrössern Sie das Textfeld. Um die Resultate zu verbessern, ist empfohlen,
Textfelder zu benutzen, welche bis zu 20% grösser sind als jene im S-Web Editor. Die
'Tahoma' Schriftart stellt das beste Resultat dar.

Für Schriften im MicroBrowser siehe Working With MicroBrowser.

23.2 Error Meldungen S-Web Editor

Dateien

Beschreibung
Dateien / Verzeichnis

Fehlermeldungen

ERROR during dir copy process couldn't create the needed folder so exits :

ERROR during dir copy process couldn't find the needed folder so exits :

ERROR during dir copy process for file :

ERROR can't Adds the file to project file should be in project folder :

ERROR While creating project [ xxxx ]!
couldn't copy the tool's runtime library [ yyyy ] into project directory

ERROR While creating project [ xxxx ]!
couldn't copy the msg box TEQ file [ yyyy ] into project directory

ERROR This is not a valid folder.
Please select a valid folder.

ERROR in macro configuration Dialog can't find the macroTemp folder :
So exits function now

ERROR in GetMacroDlgDataServRootFile returned null file for:

ERROR while renaming file process; can't delete org file:

ERROR while removing-deleting file process; can't delete file:

ERROR during insert Macro's extra files into project;
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Can't copy the temp file to insert [xxxx] in actual project folder

ERROR during insert Macro's extra files into project;
The temp file to insert [xxxx] doesn't exist !

ERROR while removing-deleting file process; can't delete file from project's
SAIA_MODIFIED_FILES_FOLDER_NAME " folder: "

ERROR during project file open; unable to change working directory

ERROR during project's file open; unable to change working directory to actual
opening file directory

ERROR during insert file into project; Can't close the file

ERROR during insert file into project; Can't find the file

ERROR during file open; Can not find a frame for document to activate.

ERROR during file open; Can not find a view for document to activate.

ERROR On new file insert; such kind of file can't be new instanciated and opened in
that way for file :

ERROR On new Html file insert; no html template found for file :

ERROR during remove-delete file from project; Can't delete file :

ERROR while creating project; Couldn't generate the init container ITQ file to put in
project directory

ERROR while creating project; Couldn't generate the init ppo TCR file to put in
project directory

ERROR during TEQ file save; file is null so returns

ERROR on make new macro; No macro template found for file :

ERROR during copy file into Saia Converted runtime files folder
([ SAIA_MODIFIED_FILES_FOLDER_NAME" ]).
Couldn't find the file : "

ERROR in rename action got Null Pointer so no new name update made.

Found a file with forbidden char in name; This may cause problem on
Some server so please make sure to use valid name for file :

ERROR in project deployement couldn't create the deploy folder so exits :

ERROR in project deployement couldn't find the deploy folder so exits :

ERROR in project deployement can't find project file :

ERROR in project deployement during usb copy of project file :

ERROR While opening project [ xxxx ]!
couldn't copy the tool's runtime library [ yyyy ] into project directory

ERROR While opening project [ xxxx ]!
couldn't copy the msg box TEQ file [ yyyy ] into project directory

ERROR in project opening : unable to change working directory ! to the given
directory :

Selected folder must be a SubFolder of the application's installation Path
please select a valid Folder !
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so project save process failed.

Macro name can't be equals to the original macro to modify name!
Please enter a valid file name !

ERROR file name length > 24 not allowed (please define a valid file name)

ERROR file name contains spaces or + or . chars not allowed
(please define a valid file name)

That file can't be renamed !

ERROR while generating Old teq format folder files couldn't create folder :

ERROR while generating Old teq format folder files couldn't copy file [ xxxx ] to the
destination file[ xxxx ] seems in readonlymode or locked from an other process
please first make sure to free all the source and destination files!
Do you wish to continue ?

ERROR while generating Old teq format folder files! couldn't find the project file
[ xxxx ]
Do you wish to continue ?

ERROR can't generate the macro lib needed temp FOLDER :

ERROR while generating Macro's Temp folder!

ERROR during ITQ merge; the selected file name is empty!

ERROR during TCR merge; the selected file name is empty!

Please enter a valid project NAME

Please select a valid project Path Loaction

Please select a valid HW Specific project

ERROR occured in HW Specific project's profile file path

ERROR: no document templates registered with CWinApp -
STRINGTABLESTR_MAINFRAME

ERROR On File Open no template found for file

ERROR On File Open such kind of file can't be opened in that way for file

ERROR: On File Open Can not find a frame for document to activate.

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq couldn't generate the init
container teq file to put in project directory

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq project name contains
non valid char for tcr file name for :

ERROR in CProjectConfigsDoc::UpdateWritesPPOInitDoc() While generating Saia
Converted runtime files folder ([ SAIA_MODIFIED_FILES_FOLDER_NAME" ])
folder !!"

ERROR in CProjectConfigsDoc::OnMergeTcr() , the selected file name is empty!

ERROR in CProjectConfigsDoc::OnMergeTcr() , the selected file name is the actual
project init ppo file so nothing to do!

ERROR in CProjectConfigsDoc::OnMergeITQFile() , the selected file name is the
actual project init containers file so nothing to do!

ERROR in CProjectConfigsDoc::OnMergeITQFile() , the selected file name is
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empty!

ERROR in CProjectConfigsDoc::UpdateInitPPOFile project name contains non valid
char for tcr file name for :

ERROR in CProjectConfigsDoc::UpdateInitPPOFile() couldn't generate the init ppo
teq file to put in project directory

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq project name contains
non valid char for tcr file name for :

ERROR during project's files check/update.
For Project file :
not found Do you want to erase it from the project files list and go on opening project
or cancel the project opening ?

Mögliche Ursachen
- Datei/Verzeichnis existiert nicht
- Datei wird von einem Programm verwendet
- Datei nicht erreichbar
- Datei ist schreibgeschützt
- Kein gültiger Dateitype
- Nicht erlaubter Dateiname

Lösungen
- Datei oder Verzeichnis ertsellen
- Anderes Programm schliessen
- Dateizugriffsberechtigung fehlt
- Dateinamen wechseln

Resourcen

Beschreibung
Nicht genügend Ressourcen um Programm ordnungsgemäß ausführen zu können.

Fehlermeldungen

ERROR in CGraphicDriver::FillRect can't create pen

ERROR in CGraphicDriver::SetPixel can't create pen

ERROR in CGraphicDriver::DrawLine can't create pen

ERROR in CGraphicDriver::DrawLine2 can't create pen

ERROR in CGraphicDriver::FillPolygon can't create brush

ERROR in CGraphicDriver::FillPolygon can't create pen

PPO Selector Dlg can't display more then xxxx variables …

ERROR during Container init; couldn't create the container Init Dialog

ERROR during PPO init; couldn't create the PPO Init Dialog

ERROR in TEQ View drawing; Can't create Graphic pen Object

ERROR in TEQ View drawing; Can't create Graphic font Object

ERROR on TEQ View drawing; LButton Up Resizing can't find painter in list for r =
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ERROR on TEQ View drawing; Update selected zone can't find painter in list for r =

ERROR in TEQ View Print; Can't create Graphic pen Object

ERROR in Editor create; Failed to Initialize Sockets

ERROR couldn't create the FTPDownloadDlg !

ERROR On Help Finder waiting for a *.chm help file name extension but found :

Failed to create menubar

Failed to create Properties window

Failed to create Project Files view

Failed to create Project View_Explore view

Failed to create status bar

Failed to create toolbar

Failed to create painters toolbar

Failed to create view layout toolbar

Failed to create docking windows

Failed to create Project View_Explore window

Failed to create Project Files view

Failed to create Output window

ERROR: On File Open Can not find a view for document to activate.

Failed to create output tab window

Failed to create output windows

ERROR couldn't create the Var selector Dialog !

Failed to create Properties Edit

Failed to create Properties Grid

ERROR: can't update inserted files tree dialog

Mögliche Ursachen
- Zu viele PPOs oder Painters definiert
- Nicht genug RAM
- Programmdatei beschädigt

Lösungen
- PPOs oder Painters löschen
- RAM-Speicher erweitern
- S-Web Editor neu installieren

Schrift Generator

Beschreibung
Probleme beim Ausführen des Schriftgenerators.
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Fehlermeldungen

Exception in CProjectConfigsDoc::GenerateSpiderFontsFiles The
SpiderFontGenerator Process could not be started...

ERROR1 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR2 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR3 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR4 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR5 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR6 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR7 in FontGenerator while parsing fonts list file so exits Font Generator now

ERROR8 in FontGenerator while parsing fonts list file so exits Font Generator now

Mögliche Ursachen
- Problem während parsing
- FontGenerator.exe zu alt
- FontGenerator.exe beschädigt

Lösungen
- Ausführen von „build all“
- Neuinstallation von S-Web Editor

FTP Download

Beschreibung
Probleme mit FTP oder Internetverbindung

Fehlermeldungen

FTP Download failed

Cannot open an Internet Session. Please check your internet configuration.

An exception occurred when attempting to create an FTP connection.
Please check your internet configuration and make sure your environment
Is set up with WININET.DLL in the path.

Please enter a valid FTP URL

An FTP connection has not been established.

FTP download not possible because no valid ftp connection available! for project file
:

ERROR no actual valid ftp connection !

ERROR in FTP download for file :

Mögliche Ursachen
- Keine Internetverbindung möhlich
- Falsche FTP URL
- Nicht verbunden mit FTP

Lösungen
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- Mit FTP-Server verbinden
- Internetverbindung sicherstellen
- FTP URL prüfen

HDLog

Beschreibung
Probleme mit Dateien welche im Projekt "teq-Konfiguration" definiert sind.

Fehlermeldungen

ERROR in HDLog File parsing ; can't find HDLog file :

ERROR in HDLog File parsing ; can't find HDLog file's starting string :
so exits parsing now for file :

ERROR in HDLog File parsing ; can't find HDLog file's parameter :

ERROR in HDLog File parsing file's parameter :

found wrong value in parsed line :

ERROR in HDLog File parsing for curve definition Number :
So exits parsing for that curve now for file :

Mögliche Ursachen
- Die Datei hatnicht das richtige Format

Lösungen
- HDLog Dateien überprüfen

Memory Foot Print

Beschreibung
Projekt ist nicht für ausgewählten Hardware-Einstellungen geeignet.

Fehlermeldungen

ERROR in Memory foot print check ; can't find HW profile file :

Project's memory foot print check for project :

] Project's val =

Project's Memory foot print check

TEQ Views Memory foot print check

check Memory foot print FILE GENERATED FROM S-Web Editor on :

TEQ View Memory foot print check for TEQ :

] TEQ view's val =

According to default HW profile defines

According to Spider HW profile file :
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WAS OK

FOUND INCOMPATIBILITIES FOR SOME HW SETTINGS

For more informations read the memory foot print check log file :

And please adjust the project to HW settings limits then rebuilt the project.

Memory foot print check OK for [

Memory foot print check NOT OK for [

<=

Mögliche Ursachen
- Projekt überschreitet Grenzen der ausgewählter HW
- HW Profil unbekannt

Lösungen
- Projekt dem ausgewählten HW-Profil anpassen und Projekt rebuilden.
- Gültige HW-Profil-Datei wählen

Lizenz

Beschreibung
Fehler bei der Lizenzprüfung

Fehlermeldungen

ERROR Can't find the Saia license check dll

ERROR in loading the Saia license check dll

ERROR while getting the Saia license check dll's needed function's address

ERROR with Saia license check dll, so the WebEditor exits now!

Editor found no valid Spider license file to run.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file;
you will then have to select the path for the editor's license key file (PLCEditorKey.
spl) you got with your installation setup.
use the IGNORE button if you just wish to run the editor in Demo mode

New Ininet License File install Failed!

Editor found incompatible Spider license file since Editor type [ xxxx ]
is different from editor you are running.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor found incompatible Spider license file since Editor Release [ xxxx ]
is different from editor you are running.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor found incompatible Spider license file since Editor Release UNKNOWN .
Use the ABORT button if you wish to exit Editor.
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Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor Spider license check failed.
Use the ABORT button if you wish to exit Editor.
Use the RETRY button if you wish to install a valid spider license file.
use the IGNORE button if you just wish to run the editor in Demo mode

Editor Spider license check failed so exits

Mögliche Ursachen
- DLL defekt
- ungültige Lizenz

Lösungen
- Neuinstallation des Editors
- Neu Lizenz erwerben

Demo Einschränkungen

Beschreibung
Demo-Beschränkung (nur in NanoBrowser Projekten)

Fehlermeldungen

The editor exceeds the number of allowed PPO variables so the application will exit
without saving the project's files !

The editor exceeds the number of allowed TEQ views so the application will exit
without saving the project's files !

The editor exceeds the number of allowed PPO variables so the application won't
save any project's file !

The editor exceeds the number of allowed TEQ views so the application won't save
any project's file !

The editor exceeds the number of allowed PPO variables so the application will
generate a corrupted html file !

The editor exceeds the number of allowed TEQ views so the application will
generate a corrupted html file !

The editor exceeds the number of allowed PPO variables so the application won't
save any changes since last save until the variables number is ok for the editor !

The editor exceeds the number of allowed TEQ views so the application won't add
any new view to the project until the views number is ok for the editor !

The editor exceeds the number of allowed PPO variables so the application won't
save the TEQ view file !

The editor exceeds the number of allowed TEQ views so the application won't save
the TEQ view file !

ERROR the demo editor can only open default demo project names :

ERROR while opening project : The demo editor can only open default demo project
names :
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ERROR the actual demo editor can only open default demo project with project
version number greater as the one you try to open so stops !!

ERROR while opening project :
The project opening index exceeds the MAX opening index for the demo editor.

Mögliche Ursachen
- Eingefügtes Makro mit zu vielen PPO's
- Überschreiten der maximalen Anzahl von teq-Ansichten oder PPO's.
- Öffnen eines mit einer Vollversion des S-Web Editor erstellten Projekts.

Lösungen
-

GIF zu BMP

Beschreibung
Bildkonvertierungsfehler von GIF- zu Bitmap-Format.

Fehlermeldungen

ERROR in during convert GIF to BMP file; can't find project file :

ERROR in during convert GIF to BMP file; can't find image in Graphic driver for file :

ERROR in during convert GIF to BMP file while generating BMP file :

ERROR in during convert GIF to BMP file; can't get image's HBITMAP in Graphic
driver for file :

ERROR in during convert GIF to BMP file :

Mögliche Ursachen
- Unkompatibles GIF Format
- Datei defekt

Lösungen
- Ins richtigem GIF format umwandeln
- GIF korrigieren

Basic Interpreter

Beschreibung
Makro nicht geeignet für Basic-Interpreter

Fehlermeldungen

Basic Script Command Do Sleep is not supported!

Basic Script Command Do Input is not supported!

Mögliche Ursachen
- Unkompatibler Macro

Lösungen
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- Macro kann nicht genutzt werden

CspiderTextDoc

Beschreibung
Programmdateien defekt

Fehlermeldungen

ERROR in CSpiderTextDoc::GenerateHTMLTAGStemplateCSVFile() prjConfigs is
NULL!

ERROR in CSpiderTextDoc::GenerateFTPDownloadLog() prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateHTML() prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateSpiderFontsList() prjConfigs is NULL!

ERROR in CSpiderTextDoc::GenerateSAIAPPOInit() prjConfigs is NULL!

Mögliche Ursachen
-

Lösungen
- Neustallation PLC-Editor
- Information an den Support senden

PCL Remote API Log File Meldung

Beschreibung
Nachrichten in log-Datei bei der Verwendung von PCL-Remote API (keine Meldung-
Boxen ...) ablegen.

Fehlermeldungen

ESM insert macro function found yet existing files in project
PLC Remote API automatic returned : OVERWRITE for ALL

ITQ merge function found yet defined containers in project
PLC Remote API automatic returned : OVERWRITE for ALL

TCR merge function found yet defined PPOs in project
PLC Remote API automatic returned : OVERWRITE for ALL

Mögliche Ursachen
-

Lösungen
-

Teq File Format

Beschreibung
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Ungültige teq-Dateien

Fehlermeldungen

ERROR while opening background TEQ file [ xxxx ], first char errorso stops
reading file !

ERROR during TEQ file open; first char Error for file :

ERROR in CProjectConfigsDoc::Serialize while reading
m_newDiagramOutline styles

ERROR while opening TEQ file [ xxxx ], first char error so stops reading
file !

Mögliche Ursachen
- Ungültiges Format

Lösungen
- Teq-Datei neu erstellen

Background / Foreground Teq

Beschreibung
Als Hintergrund oder Vordergrund definierte Teq-Datei hat denselben Namen wie die
bearbeitete.

Fehlermeldungen

ERROR while adding background TEQ name to actual doc , won't add the TEQ
name background TEQ list because same name for file :

ERROR during background TEQ define; The background TEQ defined is the same
as the teq in which it should be defined as background so won't be done for :

ERROR during background TEQ define; The TEQ file yet contains more then 2
defined back/forground TEQ so no new one added

ERROR : The TEQ configuration : back/foreground TEQ name is the same as the
TEQ itself so that setting is skipped !
Please check the back/foreground TEQ's configurations .

Mögliche Ursachen
- Die derzeit bearbeitete oder geöffnete Teq-Datei enthält bereits eine Hintergrund-
bzw. Vordergrunddatei mit demselben Namen.

Lösungen
- Änderung von Hintergrund- bzw. Vordergrund-Teq-Dateinamen
- Änderung der teq-Dateinamen während der Bearbeitung

Recursive Teq-Dateien

Beschreibung
Mögliche Rekursion in teq-Datei erkannt
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Fehlermeldungen

ERROR while opening TEQ file [ xxxx ], a back/ForegroundTeq defined with a
second inner Back/Foreground defined in was detected , since that may cause
looping problem the background isn't loaded please check the defined back/
foreground teqs .

Mögliche Ursachen
- Teq Datei contains a background or foreground teq Datei which itself contains a
background or foreground teq Datei. This can lead to problems And is therefore not
allowed
- Die Teq-Datei enthält eine Hintergrund- bzw. Vordergrund teq-Datei, die sich
wiederum selbst aufruft. Dies kann zu Problemen führen und ist daher nicht erlaubt

Lösungen
- Eine Hintergrund- bzw. Vordergrund teq-Datei darf keine Hintergrund- bzw.
Vordergrund-teq-Dateien enthalten.

Project: Editor Version

Beschreibung
Probleme mit Dateien welche mit einer anderen Version des PLC-Editors erzeugt
wurden.

Fehlermeldungen

ERROR in CProjectConfigsDoc::UpdateInitPPOFile found a init ppo tcr file with old
naming notation so tries to rename it and use this one. !

ERROR in CProjectConfigsDoc::UpdateInitContainersTeq found a init container itq
file with old naming notation so tries to rename it and use this one. !

ERROR in project file while reading version nr greater as actual editor version
number so stops !!

Mögliche Ursachen
- Die Dateien wurden entweder mit einer älteren oder eine neueren Version des PLC-
Editor erstellt.

Lösungen
- Versuchen die Dateien zu konvertieren oder einen älteren Editor verwenden.
- Wenn eine neuere Version erforderlich ist, muss der Editor aktualisiert werden

Macedit Process

Beschreibung
Probleme beim Starten einen Makro-Dialog

Fehlermeldungen

ERROR in MacroDlg The Macedit Process could not be started !

ERROR in MacroDlg The Macedit Process could not be started (last MacroDlg
process still running) !
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ERROR in MacroDlg The Macedit Process could not be started
(MacroDlgWebServerThread is null) !

ERROR in MacroDlg The Macedit Process could not be started (no free tcp port
found) !

Mögliche Ursachen
- Ein anderer Macro wird gerade ausgeführt.s already running
- Der Makro-Dialog des Webservers läuft nicht oder kann den Port nicht öffnen.

Lösungen
- Ausführender Macro schliessen/anhalten
- Neuladen des  Macro-Dialog
- Neustart des SWeb-Editors

Macro Dialog Dataserv

Beschreibung
Probleme beim Makro-Dialog Datenserver

Fehlermeldungen

ERROR macro configuration Dialog dataserv unknown return so kill dialog!

ERROR macro configuration Dialog PLC Dataserv side error during add modbust
struct to project's modbus struct imported files List

ERROR macro configuration Dialog PLC Dataserv side error during remove
modbust struct from project's modbus struct imported files List

ERROR macro configuration Dialog PLC Dataserv side error during modify modbust
struct in project's modbus struct imported files List

ERROR macro configuration Dialog dataserv timeout return so kill dialog!

ERROR macro configuration Dialog timeout so kill dialog!

ERROR macro info to configure's index does not exist in that macro for macroInfo
to configure :

ERROR macro configuration Dialog PLC Dataserv side basic script error during
proceed arguments :

ERROR macro configuration Dialog PLC Dataserv side basic script error during
proceed no basic file name found in arguments !

ERROR macro configuration Dialog PLC Dataserv side basic script error during
proceed for basic file name :

ERROR macro configuration Dialog PLC Dataserv side basic script error during
generates project's needed hdlog file

ERROR macro configuration Dialog PLC Dataserv side error during generates
project's needed modimpList file

Mögliche Ursachen
- MicroBrowser kann den Makro-Dialog nicht nutzen
- Nicht genügend Ressourcen um den Makro-Dialog zu laden (siehe "Resource")

Lösungen
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- Neuladen des  Macro-Dialog
- Neustart des SWeb-Editors

Macro Dialog Values

Beschreibung
Fehler in der Wertzuweisung im Macro-Dialog

Fehlermeldungen

ERROR during macro configuration with MacroDlg; Found [ xxxx ] macro label
Painters so returns.

ERROR during macro configuration with MacroDlg; The name found in macro label
Painter is empty so returns.

ERROR during macro configuration with MacroDlg; First selected painter groupNbr
<=0 so returns.

ERROR during macro configuration with MacroDlg; First selected painter is null so
returns.

ERROR during trend configuration the trends configuration string would become too
long with that new trend configuration so won't add this one

ERROR On Macro Online trend Update button: no valid trend selected to update!
please select one!

ERROR update a trend the trends configuration string would become too long with
that new trend configuration !

ERROR On Macro Online trend Index change: available trends list selected index
greater as list max size!

ERROR On Macro Online trend Remove button: available trends list selected index
greater as list max size!

Mögliche Ursachen
- Ungültiger Wert
- Maximale Anzahl der Werte überschritten
- Feld leer
- Erstellen eines Makros mit einem teq-Datei enthält mehrere Makros (Problem mit
mehreren Makro-Namen)

Lösungen
- Eingabewerte prüfen
- Anzahl der Werte reduzieren

Program Error

Beschreibung
Fehlerhafter Programmstatus

Fehlermeldungen

ERROR in CConditionExpression destructor , expression member not ok with
expression type defined!
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ERROR during CrossRef generation; no Cross Ref file template found for file :

ERROR during CrossRef generation;() can't generate a cross ref file no project
opened

ERROR While creating project [ xxxx ]!
couldn't find the tool's runtime library [ yyyy ] to put in project directory

ERROR While creating project [ xxxx ]!
couldn't find the msg box TEQ file [ yyyy ] to put in project directory

ERROR while creating project; Couldn't find the runtime library IMasterExternJar to
put in project directory

ERROR during loading the Saia PG5_PPO_Selector dll

ERROR during getting the Saia PG5_PPO_Selector dll's function address
PcdBrowseForSymbolDlg2

ERROR the Saia PG5_PPO_Selector dll has thrown an exception.

ERROR While opening project [ xxxx ]!
couldn't find the tool's runtime library [ yyyy ] to put in project directory

ERROR While opening project [ xxxx ]!
couldn't find the msg box TEQ file [ yyyy ] to put in project directory

ERROR Can't init PPO vars, no project opened !

ERROR in CSpiderTextDoc::WriteSpiderPPOListCSV() prjConfigs is NULL!

ERROR during TCR generate; project Config is NULL!

The generation of html file needs the applet main take name.
So please first configure a main TEQ for that project.
(Menu : Project -> Project Configurations...Main TEQ)

ERROR OnHtmlNewInsert() can't generate a html file no project opened

ERROR while update csv.lst file name can't find file :

ERROR during ITQ merge; no project opened

ERROR during TCR merge; no project opened

Can't generate new project since no profile file (*.shp) found in editor installation
directory

ERROR in Release Selector application, couldn't generate the h file

ERROR OnProjectGeneratehtmltagscsv() can't generate a csv file no project
opened

Mögliche Ursachen
- Kein Projekt geöffnet
- Programminstallation fehlerhaft

Lösungen
- Projekt öffnen
- Support benachrichtigen
- Neuinstallation des SWeb-Editors
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23.3 Error Meldungen IMaster Applet

Webserver

Beschreibung
URL des PLC-Webservers nicht gefunden

Fehlermeldungen

cgiOrderValues failed ! ( xxx ) WEB SERVER problem !!

cgi_call failed ! [ xxxx ] ( yyyy ) WEB SERVER problem !!

WEB SERVER problem !!

Mögliche Ursachen
- Keine Verbindung zum Webserver
- Falscher Pfad

Lösungen
- Physicalische Verbindung zur PLC prüfen (z.B. mit MS-DOS-Befehl "ping")
- Pfad prüfen
- Webserver-Version auf der PLC prüfen

HTML-Parameter nicht gefunden

Beschreibung
Benötigte Parameter für das Applet in der HTML-Datei wurde nicht gefunden

Fehlermeldungen

HTML Parameter not found! [ AppletName ]

HTML Parameter not found! [ ProjectName]

HTML Parameter not found! [ Main ] or not correct, xxxx

HTML Parameter not found! [ Main ] or not correct, xxxx

Mögliche Ursachen
- Falsche HTML-Datei
- Ungültige HTML-Datei

Lösungen
- Richtigen URL aufrufen
- Erstellen einer neuen HTML-Datei mit PLC-Editor und Download-Projekt in die SPS

File not found

Beschreibung
Die angeforderte Datei vom Webserver wurde nicht gefunden

Fehlermeldungen
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Loading file failed! : xxxx

Loading file failed! : xxxx

Loading file failed! : xxxx

Loading file failed! : xxxx

Mögliche Ursachen
- Webserver Problem
- Datei wurde auf der Ziel-PLC nicht gefunden

Lösungen
- Webserverproblem prüfen
- Erneuter Download des ganzen Projekts in die SPS

Value out of bounds

Beschreibung
Eingegebene Wert überschreitet den für diesen PPO definierten Wert.

Mögliche Ursachen

value out of bounds ! [ xxxx ... yyyy ]

value out of default valid ranges !

Mögliche Ursachen
- Eingegebene Wert überschreitet die für diesen PPO definierten Grenzen TCR-
Projekt-Datei
- Die definierten Grenzwerte für diesen PPO im SPS-Projekt sind falsch

Lösungen
- Der Wert muss innerhalb der festgelegten Grenzen liegen.
- Änderung der Grenzen in PPO-Editor (init PPO)

23.4 Warnungen S-Web Editor

File

Beschreibung
Dateien / Verzeichnis

Warnhinweise

WARNING : [ VPIAPPLETHTMLNAME " ] not found or invalid ! "

WARNING while updating project's MacroLibTemp for :

WARNING while updating Tool's MacroLibTemp can't generate tool's temp
folder for :

WARNING while updating Tool's MacroLibTemp can't find tool's
MacroLibTemp subfolder for :
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WARNING while updating Tool's MacroLibTemp for :

WARNING didn't found any corresponding fnt file
In project directory and coulnd't create it
So makes nothing for file name :

Details
Die Datei oder der Verzeichnis wurde nicht gefunden / erstellt / geöffnet. Weitere
Informationen unter "Fehlermeldungen".

FTP Download

Beschreibung
Warnhinweise in Bezug auf die FTP- oder Internet-Verbindung

Warnhinweise

WARNING couldn't open the project defined remote Folder [xxxx]
So uses the root directory on target
Use the CANCEL button now if you don't want to modify the project defined
FTP remote folder.
Make sure the remote folder exists on download target.

Details
Wenn ein angegebenes Verzeichnis nicht auf dem Ziel existiert, wählt der Editor
als Ziel- das "Root"-Verzeichnis. Falls ein anderes Verzeichnis gewählt werden
soll, einfach auf "Abbrechen" drücken.

HDLog

Beschreibung
Probleme mit Dateien in teq-Konfigurationen des Projekts

Warnhinweise

WARNING after parsing the number of parsed curves definition is not equal to
defined record number for file :

Details
The HDLog file has either been imported wrong or is not present. The program
will proceed, nevertheless.

Recursive Teq Files

Beschreibung
Mögliche Rekursion in der teq-Datei festgestellt.

Warnhinweise
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WARNING : editor found a recursive background TEQ on itself so will erase it
for TEQ :

WARNING : editor found more then 2 background teqs defined for a TEQ view
as this won't work it will save only the two first one! for TEQ :

Details
- Zwei angebene teq-Dateien verwenden einander als Hintergrund, was zu einer
Rekursion führt. Dies wird Probleme im MicroBrowser verursachen und wird
daher vom Editor verhindert.
- Eine teq-Datei kann nur eine Hintergrund- und eine Vordergrund-teq-Datei
enthalten.

Project: Editor Version

Beschreibung
Datei-Probleme verursacht durch andere Versionen des SWeb-Editors

Warnhinweise

In project [ xxxx ]
project laoded runtime library [ yyyy ]
different from tool's one [ zzzz ]
If you want to modify the project with that tool you need to replace the runtime
library with the tool's one
Do you want to replace the runtime library with the tool's one?
Elsewhere you will just be able to open the files in read only mode , no
modification will be saved in files

In project [ xxxx ]
project laoded runtime library [ yyyy ]
may be older OR different from tool's one [ zzzz ]
If you want to modify the project with that tool you need to replace the runtime
library with the tool's one
Do you want to replace the runtime library with the tool's one?
Elsewhere you will just be able to open the files in read only mode , no
modification will be saved in files

WARNING you are opening a project made with an older version of the editor
do you really want to open that project :

Details
Projekte welche mit einer älteren Version generiert wurden, werden vom S-Web
Editor mit neuerer Version ins neue Format konvertiert und geöffnet. Dieses
Projekt kann nicht mehr mit einem Editor einer ältere Version geöffnet werden.
Es besteht die Möglichkeit beim neueren Editor das Projekt nicht zu konvertieren,
sondern das Projekt sofort zu öffnen. Anschliessend wird gefragt ob die Laufzeit-
Bibliothek (IMaster Applet) ersetzt weren soll: 
"Ja" bedeutet, dass das Projekt auf die neue Version des Editors gewandelt wird.
"Nein" öffnet das Projekt ohne Anpassung.
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PPO

Beschreibung
PPO-Variable Warnhinweise über Name, Format oder Einheit.

Warnhinweise

WARNING : editor found an empty variable name in TEQ :
Since an empty var name will only cause trouble it is now replaced by :
Please take time to have a look on those variables and give them a valid name
!

Details
- Leerer PPO-Name erhält vom Editor einen Namen, um Probleme im
MicroBrowser zu verhindern

Painterobjekt Position

Beschreibung
Die Painterobjektposition übersteigt die Grösse teq-view

Warnhinweise

WARNING in TEQ View Painter's size and position check; Found
Polyline\Polygon painter with false size
So it will not be automatically resized please make the correction manually.

WARNING found painters with bad positions or size
In painters list to paste do you really want to paste them ?

WARNING found painters with bad positions or size in TEQ view :
do you want the PLCEditor to Resize and reposition them automatically ?

Details
Das eingefügt Painterobjekt hat die Position und / oder die Größe, die die
Grenzen des Ziel-teqs überschreiten. Mit Ausnahme der Polylinie- und Polygon-
Painterobjekte deren Eigenschaften angepasst werden.

String Restrictions

Beschreibung
Der String ist zu lang oder er enthält unerlaubte Zeichen.

Warnhinweise

WARNING : editor found a too long user defined string to copy so will trunc it
before copy :

WARNING the trends configuration string would become too long (buffer max
size = 2KB) with that new trend configuration !
[trends config string length = 90*nbrtrends+eachTrend'sNamelength]
So makes no update!
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WARNING in csv generating the HTML TAG [ xxxx ] contains the csv token
separator special char[;]
so that HTMLTAG won't be put in the generated csv file until user modified it !
Press CANCEL if you don't want to continue the csv file generation

WARNING Saia File name length > 24 not allowed so won't add that file to
project :

WARNING File name contains spaces or + or . chars not allowed so won't add
that file to project :

WARNING Saia File name length > 24 not allowed on Saia Server please
check that file :

Details
Der String überschreitet die maximale Länge oder enthält ungültige Zeichen.
Einige Strings werden automatisch erstellt. Für ungültige Zeichen siehe
"Warnmeldung".

MicroBrowser Version

Beschreibung
Das Problem erfordert die Speicherung mit der Editorversion 5.13.

Warnhinweise

during BuildAll project [ xxxx ] Editor found some views that needed to be
saved in a teq format newer as the 5.13 release.
Please check if you need to use the Force teq saving as 5_13 option if you
need older microbrowser clients!

Details
Einige Makros oder Painterobjekte sind nicht voll kompatibel mit dem 5_13 teq-
Format. Sie können nach dem Speichern unter 5_13 nicht mehr vollständig
bearbeitet werden.

Teq View Print

Beschreibung
Probleme mit dem teq-view ausdrucken.

Warnhinweise

WARNING in TEQ View Print; The printer configured dpi value isn't height
enought for the printing job please reconfigure it (>= 300 dpi)

WARNING in TEQ View Print; Bit blit function not supported from printer this
may cause problem for images print

Details
- Der ausgewählte Drucker ist nicht richtig konfiguriert: Auflösung des Druckers
muss mindestens auf 300dpi eingestellt sein
- Der ausgewählte Drucker unterstützt "bit blitting" (schnelles kopieren und
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verschieben von Speicherinhalten) nicht: Bilder werden möglicherweise nicht
korrekt gedruckt.

Copy Macro

Beschreibung
Kopieren von Makros mit indexierten Makro-Containern

Warnhinweise

WARNING found indexed macro containers in copied painters,
so you may make copy of same macro instance,
if you need different instances of macros please use the get object from library
function
Instead of the copy\\paste function please !

Details
When you copy a macro the copy behaves exactly as the original: Editing the
original changes the copy as well. To make shure this does not happen, create a
new macro instance ('Library/get object from library')

Beim Kopieren eines Makros die Kopie verhält sich genau wie das Original: Die
Bearbeitung der ursprünglichen Veränderungen als auch die Kopie. To make
shure dies nicht der Fall, erstellen Sie ein neues Makro-Instanz ( "Library /-
Objekts aus der Bibliothek ')

CSV File

Beschreibung
CSV-Datei nicht definiert oder nicht gefunden.

Warnhinweise

WARNING didn't found any corresponding csv file
in project directory and coulnd't create it
So makes nothing for file name :

WARNING the project's CSV Files to update list is empty
please first configure that list in project settings !
Would you now to add one csv file to that list ?

Details
- Bevor der Inhalt der CSV-Dateien automatisch aufgefrischt werden kann, muss
die Datei in den Einstellungen des Projekts definiert werden.

Unused HTML-Tags

Beschreibung
Die HTML-Tags sind in der CSV-Datei definiert aber nicht im Projekt benutzt.
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Warnhinweise

WARNING found HTML tags in csv files that are no more used in actual
project
Do you want editor to delete those HTML Tags?

Details
Der Editor überprüft während dem aufrischen der CSV-Datei alle HTML-Tags in
allen teq-Dateien. Wenn ein Tag der csv-Datei nicht in den teq-Dateien des
Projekts verwendet wird, fragt der Editor ob dieser Tag gelöscht werden soll.
Durch Klicken auf "Ja" werden alle ungenutzten Tags in der CSV-Datei gelöscht.
Ansonsten bleiben sie erhalten. Dies ist notwendig wenn selbst definierte
dynamische HTML-Tags genutzt werden. Z.B. ein HTML-Tag
"text@PPO_textID@" in einem Painterobjekte wird zur Laufzeit im Browser mit
dem Index wie folgt ergänzt "text1", "text2", ...

23.5 Dialog S-Web Editor

Meldung:

Select Your Project's Deployement Location

Beschreibung:
Der Speicherort kann ein lokales- oder ein Netzwerkpfad sein.

Meldung:

Import Extended Macros Needed Files Confirm Actual project yet contains a
file named :

Beschreibung:
Das Makro-Objekt enthält eine Datei mit dem selben Namen wie die Projekt-
Datei.

Meldung:

Import PPO File Confirm
Actual project PPO settings yet found for PPO :
Do you want to keep actual settings for that ppo or use the ToImport TCR file's
one ? [project settings = xxxx] [Import TCR settings = yyyy];

Beschreibung:
Keep: Projekt-PPO-Einstellungen
Keep for All: Projekt-PPO-Einstellungen (für alle PPO Variablen)
Overwrite: Importierte Einstellungen nutzen
Overwrite for All: Importierte Einstellungen nutzen (für alle PPO Variablen)

Meldung:

Import Editable Container confirm
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Actual project Container settings yet found for editable Container :
Do you want to keep actual settings for that container or use the ToImport ITQ
file's one ?
[project settings = xxxx] [Import ITQ settings = yyyy]

Beschreibung:
Keep: Startwert der Projekt-Containervariable
Keep for All: Startwert der Projekt-Containervariable (für alle
Container-Variablen)
Overwrite: Importierte Einstellungen nutzen
Overwrite for All: Importierte Einstellungen nutzen (für alle Container
Variablen)

Meldung:

Import Non Editable Container confirm
Actual project Container settings yet found for NonEditable Container :
Do you want to keep actual settings for that container or use the ToImport ITQ
file's one ?

Beschreibung:
Keep: Startwert der Projekt-Containervariable
Keep for All: Startwert der Projekt-Containervariable (für alle
Container-Variablen)
Overwrite: Importierte Einstellungen nutzen
Overwrite for All: Importierte Einstellungen nutzen (für alle Container
Variablen)

Meldung:

Display the FTPDownload log file ?

Beschreibung:
Die Log-Datei enthält eine Liste mit allen Dateien und zeigt ob deren Aufruf
erfolgreichen war oder nicht.

Meldung:

Project's Files saved on target Succeed

failed for some files:

For more informations read the ftpDowlnload log file :
FTP download on target IP Address :
FTP download in target Folder :
FTP download for project files :
FTP connect WEBS dir NOT FOUND so creates it and jumps in

Beschreibung:
FTP-Download Statusmeldungen
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Meldung:

Do you now wish editor to use the spiderFontsList.txt file and generate the
project's needed font files?

Beschreibung:
SpiderFontsList.txt enthält eine Liste der verwendeten Schrift-Typen um Font-
Dateien zu erstellen.
Die Font-Dateien werden z. B. für den NanoBrowser verwendet (Grundlage:
spiderFontsList.txt).

Meldung:

Select Your New MacroLib's Location

Beschreibung:
Der Speicherort kann ein lokales- oder ein Netzwerkpfad sein.

Meldung:

Please modify now the macro in MACROMODIFY_TEMPTEQNAME " view.
Then group the modified macro and save it with a new macro name.
Please note that the editor is now in a special mode with limited function for
modification in " MACROMODIFY_TEMPTEQNAME ".
Editor will go back in default mode when you 'll save the modified macro."

Beschreibung:
Der Editor schaltet während der Bearbeitung der Makros in einen Modus mit
eingeschränkter Funktionalität um.
Mehr darüber unter Kapitel "Arbeiten mit Makros" für Details.

Meldung:

Actual project ppo settings yet found for PPO :
Do you want to keep actaul setting for that ppo or use the to merge file's one ?

Beschreibung:
Definiert das Verhalten beim importieren von TCR-Dateien, welche die gleichen
PPO-Variablen des Projekts enthalten, jedoch mit anderen Einstellungen.

Meldung:

This object can not open a standard dialog.
Use CrossRef to modify

Beschreibung:
Dieses Painterobjekte wurde nicht mit den Painterobjekt-Standard-Dialog
"Eigenschaften" konfiguriert.
Zum Beispiel im Falle von Ereignis-Painterobjekten oder andere, komplexere
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Painterobjekte.

Meldung:

This object can not open a standard dialog.
Do you want to use CrossRef to modify it ?

Beschreibung:
Dieses Painterobjekt wurde nicht mit den Painterobjekt-Standard-Dialog
"Eigenschaften" konfiguriert.
Zum Beispiel im Falle von Ereignis-Painterobjekte oder andere, komplexere
Painterobjekte.

Meldung:

Save actual project's changes in ... before closing actual one ?

Beschreibung:
Projekt speichern bevor das Projekt geschlossen wird.

Meldung:

Save actual project's changes in ... before Build All ?

Beschreibung:
Projekt speichern bevor "Prozess Build All ' ausgeführt wird.

Meldung:

Save actual project's changes in ... before FTP Download ?

Beschreibung:
Projekt speichern bevor der FTP-Download ausgeführt wird.

Meldung:

Save actual project's changes in ... before opening new one ?

Beschreibung:
Projekt speichern bevor ein neues Projekt geöffnet begonnen wird.

Meldung:

Save actual project's changes in ... before Init PPos ?

Beschreibung:
Projekt speichern bevor der PPO Initialisierungsdialog angezeigt werden soll.
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Meldung:

Select A New HW Specific Sub Folder

Beschreibung:
Zielverzeichnis für bestimmte Dateien (z.B. Hardware-Profil).
Das Hardware-Profil enthält standardmäßig Projekt-Einstellungen für ein
bestimmtes Gerät.

Meldung:

Select Your New Project's Location

Beschreibung:
Der Speicherort kann ein lokales- oder ein Netzwerkpfad sein.

Meldung:

Project's PPOs Compatibility Check for project : According to Target's PPO
settings file : FOUND INCOMPATIBILITIES FOR SOME PPOS

For more informations read the PPOs check log file :

Beschreibung:
Unkompatibel PPO-Einstellungen SAIA xx7.

Meldung:

ERROR in Build all , the generation of html file needs the applet main TEQ
name
so please first configure a main TEQ for that project
(Menu : Project -> Project Configurations...main TEQ)

Beschreibung:
Jedes HMI-Projekt braucht ein Haupt-TEQ zum starten.

23.6 Kritische Punkte bei grösseren S-Web Editor Projekten

Maximale Grösse des Web Editor Projekts

Um die maximale Grösse des Web Editor Projekts festzustellen, müssen die
maximale Anzahl der PCD Daten Punkte (PPO's) und die maximale Anzahl von TEQ-
Views beachtet werden. Diese Grenzen sind hauptsächlich durch die Grösse des RAM
Speichers im PCD Web Server gegeben. Das Verhalten des RAM Speichers wir im
zweiten Abschnitt erklärt. Abhängig der Projektgrösse und der Kommunikationsweise
(z.B. Modem, Gateway), ist es nötig, andere Zeitparameter zu modifizieren. Dies ist in
Abschnitt 3 beschrieben.
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RAM disk

Die maximale RAM disk Grösse ist abhängig des PCD Typs:

PCD Typ FW Version max. RAM Disk [kB]

PCD3.Mxxxx 1.10.xx 48

PCD2.M480 1.10.xx 48

PCD2.M170 017 32

PCD2.M150 $C6 32

PCD1.M1x5 0A1 32

PCS1.Cxxx 01A 5

Die RAM Disk sollte immer auf das Maximum gesetzt werden. In den oben
aufgelisteten FW Versionen entspricht die Standard Einstellung dem maximal
möglichen Wert.

Für was wird RAM Disk benötigt?

Liest ein Browser (oder Java Applet) die PCD Variablen (R/T/C/I/O etc.) mit den CGI
Funktionen "OrderVal.exe" und "ReadFile.exe", so werden die Dateien in der RAM
Disk gespeichert. Web Projekte mit dem S-Web Editor arbeiten mit diesem Prozess.

Die Grösse der Dateien in der RAM Disk ist abhängig von der Anazhl der PCD Daten
Punkte (PPOs).

The following values apply:
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PCD Typ Ab FW
Version*

max. RAM
Disk

max. Nr. PPO's
mit FW Version*

max. Nr. PPO's
mit älterer FW

PCD3.Mxxxx 1.10.xx 48 2500 600

PCD2.M480 1.10.xx 48 2500 600

PCD2.M170 020 32 1500 600

PCD2.M150 $C6 32 1500 -

PCD1.M1x5 0A1 32 1500 600

PCS1.Cxxx BA5 5 250 100

Die folgende Berechnung wurde angewandt, um die maximale Anzahl der PPO's zu
berechnen:

(Max RAM Disk Grösse)/20 Bytes = Anzahl PPO's

20 Bytes sind ein Mittelwert für die PCD (e.g. PDP,,R8000,d).

Der Maximalwert oberhalb setzt voraus, dass die RAM Disk nur eine Datei enthält.
Dies ist der Fall wenn die "order per view" Option im S-Web Editor nicht gesetzt
wurde, z.B. wenn die PCD Variablen aller TEQ-Views einer einzigen Projekt-Datei
aktualisiert werden.

Wenn die maximale Anzahl der PCD Variablen in einem Projekt überschritten werden,
können PCD's mit älteren FW's abstürzen.   In Systemen mit neuen Versionen werden
alle PCD Variablen nicht mehr aktualisiert. Es erscheint jedoch ein "No Meldung"
Fehler im Browser und zusätzlich wird ein Eintrag "WEB RAM TOO SMALL" in der
PCD History geschrieben.

Enthält die RAM Disk mehrere Dateien, verringert sich die Anzahl der Werte pro Datei
entsprechend.

Wann enthält eine RAM Disk mehrere Dateien?

Wenn im S-Web Editor die "Order per view" Option eingeschaltet ist, wird für jede
TEQ-View eine eigene Datei in das RAM gespeichert. In diesem Fall werden nur die
PCD Variablen mit "OrderVal.exe" und "ReadFile.exe" in den Browser gelesen. Somit
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können kürzere Refresh-Zeiten erreicht werden. Der Nachteil dieser Option ist, dass
für jede TEQ-View eine separate Datei ins RAM gespeichert wird. Wird eine TEQ-
View aufgerufen, befinden sich die Dateien im RAM.

Die maximale Anzahl der TEQ-View Seiten mit der "order per view" Option ist
abhängig des PCD Typs und der Firmware Version:

PCD Typ ab FW
Version*

max. RAM
Disk

mit FW
Version*

mit älterer
FW
Version

PCD3.Mxxxx 1.10.xx 48 48 12

PCD2.M480 1.10.xx 48 48 12

PCD2.M170 020 32 32 12
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PCD2.M150 $C6 32 32 -

PCD1.M1x5 0A1 32 32 12

PCS1.Cxxx BA5 5 0 0

Die "order per view" Option sollte nicht bei den PCS1 Systemen angewandt werden
(RAM Disk zu klein).

In neuen PCD-Systemen (PCD2.M5xxx, PCD3.Mxxx) wird die RAM-Disk automatisch
verwaltet. Ist die RAM-Disk voll wird entweder die älteste Datei gelöscht oder die
gesamte RAM-Disk neu initialisiert.

Einstellung der Zeitparameter

Der Timing-Vorgang für den Zugriff auf die Webseiten müssen/können in vier
unterschiedlichen Berichen eingestellt werden.

a)
Priorität Web Server "task" in der
PCD

(kann in Web Builder eingestellt werden)

b) Antwort Timeout für S-Bus (kann in WebConnect eingestellt werden)

c)
Kommunikation (Abfrage) Timeout
für S-Bus

(kann in Web Builder eingestellt werden)

d) Refresh Zeit für Java Applet
(kann in Web Editor Projekt eingestellt
werden)

a) Priorität des Web Server "task" in der PCD

Diese Einstellung definiert die
Aufteilung der Kapazität der CPU
zwischen Web Server und PLC. Je
höher die Priorität, umso mehr CPU
Zeit wird für den Web Server
verbraucht.
Das Beispiel zeigt folgendes:
für 21 ms, der CPU durchläuft das
"normale" Beutzerprogramm; für 4 ms,
den Web Server Task.

b) Antwort Timeout für den S-Bus in der WebConnect Software

Für jedes Telegram welches von Web
Connect zur PCD gesendet wird, wartet
die Software um diese Zeit auf eine
Antwort von der PCD.
Dieses "Response timeout" wird nur im
Falle einer Anwendung mit Modem
oder Web Server Zugriff via einem
Gateway benötigt.
Mit Modem Kommunikation muss eine
minimale Timeout Periode von 4
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Sekunden definiert werden.

c) Kommunikation Timeout (Request timeout) für den S-Bus im Web-
Builder

Mit der Kombination "CTRL + Saia" können versteckte erweiterte Einstellungen im
Web-Builder hervorgerufen werden. .

Die Kommunikation muss auf einem Timeout PCD Web-Server-Station angepasst
werden, wenn über ein Modem oder ein PKD-Gateway zugegriffen wird. Dieser
Timeout muss auf einen höheren Wert eingestellt werden als die "Response timeout".
Als Faustregel gilt der doppelt Wert vom Standard bei der entsprechenden
Übertragungsdaten (Geschw. etc.).

Für was wird dieses Timeout benötigt?

Mit S-Bus muss WebConnect einige S-Bus Anfragen herausgeben bevor eine Web
Seite vollständig geladen ist. Das 'Communication timeout' entspricht der maximalen
Zeit zwischen den Abfrgen. Wenn diese Zeit überschritten wird, führt der Web Server
ein Reset aus und die Seite wird nicht komplett angezeigt.

d) Refresh Zeit der PCD Variablen mit dem Java Applet im Web Editor

Dieser Parameter definiert die Refresh-Zeit für die PCD Variablen im Web Browser.
Der Parameter wird im Web Editor unter Project - TEQ Configurations->applet params
eingestellt. Sollte die Zeit zu kurz sein, sendet das Applet eine neue Abfrage zur PCD,
sobald diese auf die vorhergehende Abfrage reagiert hat.

Um eine nicht notwendige Kommunikationslast zu vermeiden, sollte die Refresh-Zeit
so hoch eingestellt werden wie möglich.
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24 Abkürzungen/Begriffe

HMI Human-Machine-Interface (Mensch-Maschinen-Schnittstelle), z. B.
Bedienungsansicht (erstellt mit S-Web-Editor) auf einem
Touchpanel oder in einem Internet-Browser.

SIP Software Input Panel (Virtuelle Tastatur)

Cache Zwischenspeicher für schnelleren Zugriff

PLC Programmable logic controller =  programmierbare Steuerung

Painterobjekt Ein Painterobjekt ist ein grafisches Objekt auf einer
Bildschirmseite, wie z.B. ein Strich, ein Text, eine Wertanzeige
(PPO) etc. Diese Objekte sind in Java programmiert. Teq-Dateien
enthalten solche Objekte für eine ganze Bildschimansicht.

View Eine S-Web Editor-View (Bildschirmseite) ist aus mehreren
Painterobjekten (Grafikelemente) aufgebaut.

String Zeichenfolge z.B. Anzeigetext

URL Uniform Resource Locator, identifiziert eine Ressource über das
verwendete Netzwerkprotokoll und den Ort der Ressource in
Computernetzen

R/W Read/Write = lesen/schreiben

Polling Bezeichnet in der Informatik die Methode, den Status eines Geräts
aus Hard-  oder Software  oder andere Wertänderungen mittels
zyklischem Abfragen zu ermitteln.

Container Ein Container ist eine lokale Variable innerhalb des S-Web Editor.
Container werden benutzt um Daten zwischen Paintern
(Grafikymbolen) einer oder mehrerer Views (Grafikbilder),
auszutauschen.

PPO PPO steht für Prozessdatenpunkt. Ein PPO ist jede Variable der
Anwendungssoftware, die auf einer S-Web Editor View sichtbar
und/oder bedienbar gemacht werden soll.

Applet Ein Applet ist ein Java Programm, welches durch einen Browser
vom Zielsystem geladen wird und im Rechner des Browsers
abläuft.

Microsoft-
oder Java VM

... VM = Virtual Machine = vituelle Maschine

IMaster.jar Enthält die Java Klassen und Dienste für das Applet.

*.html / *.htm Wird vom S-Web Editor erstellt. Enthält folgende Informationen: 
- Informationen aus der Projekt Konfiguration
- Auflösung der Web Seiten
- Anzahl Seiten, 
- Links auf die *.teq Dateien
- Aufdatierungszeit 
  etc.
Standartname „start.htm“.
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*.prj Erweiterung der Datei/Projekt welche durch den S-Web Editor
generiert wurde. 
Dieses Projekt beinhaltet alle Dateien welche vom S-Web Editor
zur Realisation einer lauffähigen Web-Applikation benötigt werden.
*.teq, *.htm, *.html, *.gif, *.jar, *.tcr, *.itq

*.teq Dateierweiterung der einzelnen S-Web Editor Seiten. Jede Seite
hat ihr eigenes *.teq. Diese werden durch den S-Web Editor
erzeugt.

*.tcr Erweiterung der Datei welche die Initialisierung der  PCD Variablen
enthält „PPO“.
In dieser Datei sind die Variablen - Definitionen (Format, Max- Min.
Wert, etc) definiert. 

*.itq Erweiterung der Datei welche die Initialisierung der  „Container“
Variablen enthält. 
Enthält aIle „Container“ Variablen des Projekts und deren
Initialwert. Dies ist die Sammlung der internen Variablen des Web
Editors.

*.esm Dateierweiterung für Dateien des S-Web Editors für die «painter
library» Makro-Objekte.

*.tlb Nicht mehr verwendet für neue Macros. Seit Version 5.12 erstellt
der Editor Makros im *.esm Format. Der aktulle Editor ist
abwärtskompatibel.
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